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DOCUMENT REVISION HISTORY 
REV. NO. CHANGES DATE 

015 Software Version Update: Version 5.8.1 

- Addition of Preferences option Show font substitution 
notifications (Section 3.1.4) 

- Addition of Spelling Profile option Ignore UPPER CASE words 
(Section 12.5) 

- Addition of Spelling Profile option Ignore words that contain 
numbers (Section 12.5)  

12 Jun 2020 

014 Software Version Update: Version 5.8.0 

- Update to screenshots. 
- Various updates with regard to the availability of different modules 

based on revised licensing policies. 
- Update to Introduction (file-type support) 
- Update to log-in process (Section 2.2) 
- Addition of video tutorials (Section 2.4) 
- Replacement of User Maintenance with User Manager 

administration menu item (Sections 2.6 and 3.1) 
- Addition of Show/Hide to Page Selection toolbar (Sections 2.6 and 

3.5.6) 
- Update to options in File Drop-Down/ Menu (Section 3.1) 
- Addition of Czech, Russian, and Slovenian as UI Language 

options (Section 3.1.4) 
- Addition of Optical Character Recognition (OCR) to Text 

Inspection (Sections 3.3.5 and 3.4.5; Chapter 8) 
- Addition of note that PDFs cannot be attached to Measurement 

Tools reports (Sections 3.3.7 and 3.4.6) 
- Replacement of Shape by default with Add to shape library 

(Section 3.6.1.4) 
- Addition of Barcode Scan Grid (Chapter 6) 
- Addition of Human-Readable-Value OCR of barcodes (Chapter 6) 
- Addition of note that high-gloss samples require proper finish, to 

Braille Inspection chapter (Chapter 7) 
- Addition of Grade output format and ISO/IEC 2016 Standard 

Barcode Inspection profile parameters (Chapter 6 and Appendices 
12.1.6 and 12.1.7) 

- Addition of Color Inspection calibration process (Section 10.1) 
 

20 Jan 2020 

013 Software Version Update: Version 5.7.1 

- Update to screenshots 
- Replacement of references to Color Picker with Color Inspector 
- Addition of Barcode Inspection compatibility to Raster documents 

after zoom feature (Section 3.1.4) 
- Update to Color Inspection profiles (Chapter 10) 
- Replacement of Book drop-down with Color Book (Chapter 10) 
- Addition of Threshold Braille Inspection action parameter  

instead of Acceptable Height (Section 7.6.3 and Appendix 
12.2) 

- Addition of Support Mirrored Barcodes as Barcode Inspection 
profile parameter (Appendices 12.1.6 and 12.1.7) 

- Addition of note to toggle off Enable red light simulation to 
detect colored Pharmacode barcodes (Appendix 12.6) 

15 Oct. 2019 

012 Software Version Update: Version 5.7.0 

- Update to screenshots 
- Update to Graphics and Color Inspection Difference lists 

15 Aug. 2019 
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- Addition of Calibrate Scanner option 
- Update to Help section (Section 2.4) 
- Update to Icons and Menus section (Section 2.6) 
- Update to Menu (Section 3.1) 
- Addition of OCR (Sections 3.3.5 and 3.4.5) 
- Addition of Reset option to Lasso Selection (Section 3.3.6) 
- Addition of Measurement Tools (Sections 3.3.7 and 3.4.6) 
- Update to Cross-Out Text (Section 3.5.3) 
- Update to Underline Text (Section 3.5.4) 
- Update to Multiple Inspections (Section 4.2.2) 
- Addition of PDF Attachment to Report Options window (Section 

4.5) 
- Addition of references to Digimarc (Chapter 6 and Appendix 12.1) 
- Addition of reference to composite barcodes in list of 1D 

parameters (Section 6.3.3 and Appendix 12.6) 
- Addition of Braille Height to Braille Inspection (Chapter 7) 
- Addition of frontside Braille support to Braille Inspection (Chapter 

7) 
- Addition of Braille dot legend (Section 7.1) 
- Addition of scanning as option in Spelling Inspection (Section 9.1) 
- Update to Color Inspection, move of Color Library to Preferences 

window (Chapter 10) 
- Update to Braille Inspection actions in default workflow 

parameters (Appendix 12.2) 
- Update to Shortcut Keys (Appendix 12.6) 

011 Software Version Update: Version 5.6.0 

- Update to Help section (Section 2.4) 
- Addition of Lasso Selection icon (Section 2.6) 
- Addition of Lasso Selection section (Section 3.3.5) 
- Addition of Library drop-down to Color Inspection (Chapter 10) 
- Update to Frequently Asked Questions (Chapter 11) 

03 May. 2019 

010 

 

 

 

010 

 

Software Version Update: Version 5.5.0 

- Addition of Raster documents after zoom feature (Section 3.1) 
- Addition of Preload files for Text inspection feature (Section 3.1) 
- Update to screenshots 
- Update to Text Inspection Difference List (Sections 8.1 and 8.4.2) 
- Update to Spelling Inspection Difference List (Sections 9.1 and 

9.3.2) 
- Update to default Text Inspection profile parameters (Section 

12.1) 

08 Apr. 2019 

 

 

 

 

009 Software Version Update: Version 5.4.0 

- Addition of references to SMTP settings for email notification 
purposes 

- Addition of Difference Highlight Color (Section 3.1) 
- Addition of Polish as language (Section 3.1.4) 
- Addition of Change to Circle for marquee selections (Section 

3.3.6) 
- Update to Layouts sections, with regard to where displaced 

panels can be moved 
- Addition of GS1 output data format as Barcode Inspection profile 

parameter 
- Addition of shortcut to show/ hide difference boxes (ALT + H) 

18 Feb. 2019 

008 Software Version Update: Version 5.3.0 

- Update to screenshots 
- Replacement of Perform Inspection button with Inspect button 

and Perform Multiple Inspections with Inspect Multiple. 
- Replacement of File Menu with Menu where applicable 

15 Oct. 2018 
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- Update to Help Menu (Section 2.4) 
- Update to icons and menus (Section 2.6) 
- Update to Preferences window via Menu (Section 3.1) 
- Addition of alternative language options in Preferences window 

(Section 3.1.4) 
- Addition of new color profiles in Preferences window (Section 

3.1.4) 
- Addition of Zoning sub-panel (Section 3.5.5) 
- Addition of Resync panel (Section 8.3.1) 
- Addition of Point to Point action to Color Inspection chapter 

(Chapter 10) 
- Addition of Forgot Password FAQ (Section 11.1) 
- Update to list of supported barcodes (Appendix 12.5.1) 
- Update to list of shortcut keys (Appendix 12.6) 

007 Software Version Update: Version 5.2.0 
- Addition of Color Inspection chapter (Section 10) 
- Update to Introduction to reflect new Color Inspection Mode 

(Section 1) 
- Addition of Resync Text icon to Icons and Menus (Section 2.6) 
- Addition of note to all Color Picker sub-sections referring readers 

to Color Inspection chapter for more information  
- 

Inspection profile parameter (-125 from 0) (Section 12.1 Profiles) 

27 Jun. 2018 

006 

 

 

 

 

 

 

 

 

006 

 

 

Software Version Update: Version 5.1.0 
- Update to screenshots 
- Addition of instructions pertaining to Lot and Product Name fields 

in Job Wizard (Section 3.1.1) 
- Update to Color Picker sections, with Color Information window 

screenshot replaced with Color Inspector window screenshot 
- Addition of note that Levels to include field does not appear in 

Report Options window when Force inclusion of all differences 
setting has been selected (Section 4.5) 

- Addition of references to Enable Electronic Signatures setting 
when generating a report (Section 4.5) 

- Removal of quick-select buttons in Difference Details panel to 
assign levels to individual differences 

- Removal of color-coded boxes around differences based on their 
assigned levels 

- Removal of ability to add color differences in Graphics Inspection 
via Color Picker (Section 5.3.7) 

- Addition of shortcut keys (Appendix 11.6) 

28 May 2018 
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- Addition of Text Inspection and Spelling Inspection chapters 
- Update to Introduction to reflect new inspection modes 
- Renaming of Differences panel to Difference List 
- Addition of option to Automatically zoom to each difference in 

Preferences window  
- Updated icons (Section 2.6) 
- Addition of Image Details option (text inspection) in File Menu 

Layouts (Section 3.1) 
- Additions of Live Text (Section 3.5.2), Cross-out Text (Section 

3.5.3), Underline Text (Section 3.5.4), Create Zones (Section 
3.5.5), and Clear All (Section 3.5.6) 

- Addition of screenshot showing Exclude Page icon in Show Pages 
panel (Section 3.5.8) 

- Addition of note that Braille Compare and Braille Compare (Glue 
Dots) are not supported by Perform Multiple Inspections (Section 
4.2.2) 

15 Mar. 2018 
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- Addition of Include Thumbnails as option in Report Options 
window (Section 4.5) 

- Addition of qualification that clicking View in Report Options 
window will also save the report (Section 4.5) 

- Differences are outlined in red in Overview panel (Section 5.1)  
- Addition of Color Picker to Graphics Inspection Master Toolbar 

section (Section 5.2.2) 
- Update to Wide Bar grading system in 1D Barcode Parameters 

table (Section 6.3.3) 
- Replacement of BWR with BWR Horizontal and BWR Vertical in 

2D Barcode Parameters table (Section 6.3.3) 
- Addition of Color Picker to Braille Compare Master Toolbar 

section (Section 7.3.2) 
- Addition of FAQ regarding Text Inspection profiles (Section 10.2) 
- Addition of Inspection Results (Text) section to FAQ (Section 

10.5) 
- Change to the minimum value for Color Sensitivity in Graphics 

Inspection profiles (1 to 0) (Appendix 11.1.1 to Appendix 11.1.5) 
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004 

 

 

Software Version Update: Version 4.1.0 
- File types supported modified (removed C/ CPP/ H) (Introduction) 
- Removal of Quick Start Guide from Help drop-down menu 

(Section 2.4) 
- Addition of Create new Job functionality (Section 3.1.1) 
- PDF Options icon added to Master and Sample toolbars (Sections 

3.3 and 3.4) 
- Addition of Region Mode multi-page options for marquee selection 

(Section 3.3.6) 
- Addition of Alternate Shape Selection to PDF Viewer (Section 

3.5.2)  
- Addition of Report Viewer functionality (Section 4.5) 
- Addition of Image to Display  Master (Section 5.3.3) 
- Addition of ability to see both Master/ Sample panel or Sample 

only after an inspection (Sections 5.4.6, 6.3.6 and 7.5.6) 
- Addition of Rotate to Barcode and Braille Inspection toolbars 

(Sections 6.2.1 and 7.2.1) 
- Update to Color Sensitivity settings for all Graphics Inspection 

profiles (Appendix 9.1) 
- Update to list of Linear parameters in Barcode Inspection profiles 

(Appendix 9.1) 
- Addition of default workflows in table form to Appendix (9.2) 
- Addition of Unified English Braille (UEB) to Supported Braille 

Languages (Appendix 9.3) 
- Addition of Code 32 to Supported Barcodes (Appendix 9.4) 

24 Oct. 2017 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

003 Software Version Update: Version 4.0.0 
- New interface and workflow 

03 March 2017 

002 

 

Software Version Update: Version 3.1.0 
- Addition of Inspection Wizard functionality 
- Ability to inspect LEN files 
- Addition of Color Inspection to Setup Parameters (Digital and 

Proof) 
- Modification of Difference Grouping (pixels) in the Proof Setup. 
- Improved workflow for Braille 
- Deletion of Epson and Nextimage Software scanning steps from 

User Guide, added to individual Scanner Maintenance Guides 

03 Jun. 2016 

 

001 

 

 

Software Version Update: Version 3.0.0 
- Addition of Braille Module  ability to translate Braille regions on 

master/ sample images and compare Braille regions on master/ 
sample images   

10 Jun. 2015 
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- Support for multiple Braille Languages 
- BarProof Module renamed to Barcode Verification 
- 1D Barcodes: RSS/ GS1 combined into one barcode type instead 

of separated; support for EAN (13 digits); EAN (8 digits); UPC-A 
and UPC-E, MSI and GS1-128. 

- 2D Barcodes: support for DataMatrix and GS1 DataMatrix. 
- Option to ignore Pharma code removed 
- Ability to inspect multiple master and/ or sample files 
- Ability to manually adjust the brightness, contrast and gamma of 

the Master and/ or Sample image 
- Ability to clearing the inspection results and the Master/ Sample 

loaded files (Reset Interface) 
- Ability to use the following page for shape extraction 
- Ability to display an edge image to only highlight areas where 

differences are found 
- Ability to include multiple inspections in one report 
- Ability to exclude rename and exclude inspections from the 

inspection report 
- Ability to include the Master image in the Inspection Report 
- User must set the inspection status (Pass/ Fail) prior to generating 

the report 
- PDF Viewer: Addition of close icon 
-  
- Addition of Shortcut keys 
- Help menu: addition of links to the Standard Practice and Remote 

Support 
- Left-Click instead of right-click to pan the image in the Inspection 

View 
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PROPRIETARY INFORMATION 

The information contained in this document is the property of GlobalVision, Inc.  Information contained in this document is intended 
for the internal usage of clients of GlobalVision, Inc. systems only.  Re-production or reprints complete or partial for other purpose is 
illegal.  © 2020, GlobalVision Inc., All Rights Reserved.
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1 Introduction   

GlobalVision -in-one inspection platform used to compare 
a sample image against a master image to generate a detailed difference report. Differences are 
highlighted, with levels and comments able to be added to each for an in-depth proofing and reviewing 
process.   

The system is able to inspect and detect differences. The following is included in the solution:  
 Ability to compare electronic files of the following file types: 1-BIT TIF, AI, BMP, DOC/ DOCX, 

HTML/ HTM, JPEG, LEN, PDF, PNG, RTF, TIF, TXT, XLS/ XLSX, XML. 

 Ability to compare scanned and electronic files (labels, cartons, and inserts). 

 Ability to compare a printed component on cylinders and tubes to an electronic file. 

 Ability to inspect multi-page documents (e.g. booklets). 

 Ability to identify missing, added, or modified content such as text, print defects, and color 
differences. 

 Ability to inspect Braille on scanned samples (frontside and backside). 

 Ability to translate Braille in multiple languages.  

 Ability to decode and grade barcodes. 

 Ability to detect spelling errors. 

 Ability to measure and compare color points.  

 Ability to review differences and add comments and levels. 

 Ability to append inspection results. 

 Ability to generate PDF reports with comments and levels. 
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2 Getting Started  

The following sections describe the log-in process and how user accounts are created. 

 

2.1 Create User Account 

Once your administrator creates your account, an email gets sent out, assuming applicable SMTP 
settings have 
and contains your User Name and a temporary password. Your next step is to log in and create your new 
password. For more information on creating user accounts, please consult the Administration Guide. 

 

2.2 Login  

To log in to the Application: 

 Click the Application shortcut on your desktop. The Login window displays. 

        

 

Login Window 
 

 Click through on each of the End User License Agreement and Privacy Policy links and check 
the box acknowledging you have read and accept them. 

 Enter your User Name and Password and click Login.  

 If this is the first time you are logging in or if an administrator has reset your password, a 
"Temporary password" message displays. Click OK and the Password window displays, allowing 
you to create a new password:   

 

 
Password Window 
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 Enter the temporary password you have received via email or from your administrator in the Old 

Password text box.  
 Enter your new password in the New Password text box.  
 Enter your new password again in the Confirm Password text box.  
 Click Accept and OK once the notification window displays.  

 

 

 
 The Main View displays. You are now ready to start setting up your inspection.   

NOTE: The Application saves your active window upon logout (not exit) and displays it at your 
next log-in. For example, if the Inspection View was active when you logged out, the Application 
displays it at your next log-in.     
 

  

Main View 
 

2.3 Change Password 

To change your password: 

 Click Menu  > Change Password. 
 The Password window displays, letting you create a new password:   

 

Main 
Icons 

Master Panel Sample Panel 

Sample Toolbar Master Toolbar 
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Password Window 

 
 Enter your old password in the Old Password text box.  
 Enter your new password in the New Password text box.  
 Enter your new password again in the Confirm Password text box.  
 Click Accept. Click OK  

 

 

 

2.4 Help 

The following options are available to you upon clicking the Help  icon: 

 Select Give Feedback to request new features or report bugs. 
 Select GlobalVision Support to link to the GlobalVision online knowledge base. 
 Select Video Tutorials to link to a list of watchable how-to videos. 
 Select Shortcuts to display all keyboard shortcuts.  
 Select About to get version details about the Application.  
 Select Licensing to enter and refer to serial-number and company-name information. 

 

2.5 Logout/ Exit   

To log out of the Application: 

 Click Menu  > Logout to save your session and return to the Login window.    
 Click the X on the top right of the window to exit the Application. 

NOTE: On a Mac® operating system, click X on the top left of the window to exit the Application.         
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2.6 Icons and Menus 

LABEL ICON DESCRIPTION 

MAIN 

FILE 

 

 
 

FILE MENU DROP-DOWN OPTIONS: 
 NEW JOB 
 LOAD MASTER 
 LOAD SAMPLE 

LOAD FROM 
SCANNER  

(PRINT 
INSPECTION 

ONLY) 

 

 
 

 
SCANNER MENU DROP-DOWN OPTIONS: 

 SCAN MASTER  
 SCAN SAMPLE 
 CALIBRATE SCANNER (BRAILLE) 
 SELECT SOURCE 

 

RESET 

 

 
 

CLEAR ALL INSPECTION RESULTS AND RETURN TO THE 
MAIN VIEW 

BACK 

 

 
 

RETAIN ALL INSPECTION RESULTS AND RETURN TO THE 
MAIN VIEW 

FORWARD 

 

 
 

RETURN TO THE INSPECTION VIEW 

GRAPHICS 
INSPECTION 

 

 
 

 
GRAPHICS INSPECTION PERFORMED WHEN SELECTED 
 

COLOR 
INSPECTION 

 

 
 
 
COLOR INSPECTION PERFORMED WHEN SELECTED 
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BARCODE 
INSPECTION 

 

 
 

BARCODE INSPECTION PERFORMED WHEN SELECTED 

BRAILLE 
INSPECTION 

 

 
 

BRAILLE INSPECTION PERFORMED WHEN SELECTED 

TEXT INSPECTION 

 

 
 

TEXT INSPECTION PERFORMED WHEN SELECTED 

SPELLING 
INSPECTION 

 

 
 

SPELLING INSPECTION PERFORMED WHEN SELECTED 

 INSPECT 

 

 
 

RUN SELECTED INSPECTION MODE 

PROFILE 
SETTINGS 

 

 
 

 
 
MANAGE PARAMETERS FOR THE SELECTED INSPECTION 
PROFILE (ADMIN/ MANAGER ACCOUNTS ONLY) 
 
 

REPORT 

 

 
 

GENERATE INSPECTION REPORT(S)  
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HELP 

 

 
HELP DROP-DOWN OPTIONS: 

 LICENSING 
 GIVE FEEDBACK 
 GLOBALVISION SUPPORT 
 SHORTCUTS 
 ABOUT 

 

MENU 

 

 
MENU DROP-DOWN OPTIONS: 

 RESOLUTION 
  

 ADMINISTRATION (ADMIN/ MANAGERS ONLY) 
 Settings, Audit Trail, User Manager, Reporting 

Levels, Comments, Workflows, Backup, Force 
review of all differences, Force inclusion of all 
differences 

 CHANGE PASSWORD 
 LAYOUT 
 PREFERENCES 
 LOGOUT 

 

MASTER/ SAMPLE 

PDF OPTIONS 
MASTER/SAMPLE 

 

 
 

TOGGLE PDF OPTIONS FOR PDF/ AI FILES ON OR OFF 

FILE 

INFORMATION 
MASTER/SAMPLE 

 

 
 

IMAGE DETAILS 

IMAGE 

ADJUSTMENTS 

MASTER/SAMPLE 

 

 
 

ADJUST BRIGHTNESS, CONTRAST, AND GAMMA OF MASTER 

OR SAMPLE IMAGES 

OCR (OPTICAL 

CHARACTER 

RECOGNITION) 

 

 
 

 
 
 
 
 
MAKE MARQUEE SELECTIONS OF NON-LIVE TEXT ON 

SCANNED DOCUMENTS COMPATIBLE WITH SPELLING 

INSPECTION 
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LASSO 

SELECTION 

 

 
 

LASSO SELECTION OPTIONS: 
 ADD TO INSPECTION 
 REMOVE FROM INSPECTION 

MEASUREMENT 

TOOLS 

 

 
 

MEASUREMENT TOOLS OPTIONS: 
 RECTANGLE 
 LINE 
 REPORT 

MANUAL 

ALIGNMENT 
MASTER/SAMPLE 

 

 

ALIGN SELECTED POINT ON MASTER IMAGE WITH SELECTED 

POINT ON SAMPLE IMAGE 

REGION MODE 
(MASTER) 

 

 

 
 

 
REGION MODE DROP-DOWN OPTIONS: 

 FULL PAGE 
 MARQUEE 
 TRIM 
 SHAPE 

 

CROP TO 

CONTENTS 
MASTER/SAMPLE 

 

 
 

 
AUTO-ADJUST CROP AREA WITHIN THE BOUNDS OF THE 

IMAGE 
 

RELOAD PAGE 
MASTER/SAMPLE 

 

 
 

RELOAD PAGE 

ROTATE  
MASTER/SAMPLE 

 

 
 
ROTATE DROP-DOWN OPTIONS: 

 ROTATE 90 CW 
 ROTATE 90 CCW 
 ROTATE 180 
 ARBITRARY ROTATE  
 MIRROR HORIZONTALLY  
 MIRROR VERTICALLY 
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COLOR 

INSPECTOR 
MASTER/SAMPLE 

 

 
 

DISPLAY PANTONE, RGB, CMYK, AND LAB VALUES OF 

SELECTED POINT 

MARQUEE ZOOM 
MASTER/SAMPLE 

 

 
 

SELECT ZOOM AREA 

RESET VIEW 
MASTER/SAMPLE 

 

 
 

RESTORE IMAGE TO ORIGINAL SIZE 

SAVE VIEW 

MASTER |SAMPLE 

 

 
 

 
 
SAVE IMAGE DISPLAYED IN WINDOW 
 
 

CROP 
(SAMPLE) 

 

 

 
 

CROP SAMPLE IMAGE 

SUPPORT 

ROTATED 

REPEATS 
(SAMPLE) 

 

 
 

ENABLE DETECTION OF ROTATED OR NESTED SAMPLE 

IMAGES 

MATCH SCALE 
(SAMPLE) 

 

 

 
 

 
 
 
 
 
SCALE SAMPLE IMAGE TO MASTER IMAGE DIMENSIONS 
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INSPECTION 

ROTATE  
MASTER/SAMPLE 

 

 
ROTATE IMAGE DROP-DOWN OPTIONS: 

 ROTATE 90 CW 
 ROTATE 90 CCW 

 

COLOR 

INSPECTOR 
MASTER /SAMPLE 

 

 
 

DISPLAY PANTONE, RGB, CMYK, AND LAB VALUES OF 

SELECTED POINT 

SHOW THE TEXT 

MASK 
(MASTER) 

 

 
 

SHOW WHAT WAS DETECTED AS TEXT DURING INSPECTION 

MARQUEE ZOOM 
MASTER/SAMPLE 

 

 
 

SELECT ZOOM AREA 

RESET VIEW 
MASTER/SAMPLE 

 

 
 

RESTORE VIEW TO ORIGINAL SIZE 

SAVE VIEW 

MASTER |SAMPLE 

 

 
 

 
 
SAVE IMAGE DISPLAYED IN WINDOW 
 
 

FLASH  
(SAMPLE) 

 

 

 
ADJUST FLASH RATE BETWEEN MASTER AND SAMPLE: 
 

  INCREASE FLASH RATE 

  DECREASE FLASH RATE  
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SET REPEAT AS 

MASTER 
(SAMPLE) 

 

 
 

SET SELECTED REPEAT AS MASTER IMAGE 

 
IMAGE TO 

DISPLAY 
(SAMPLE) 

 

 
 

 
DISPLAY THE FOLLOWING IMAGES: 

 FLASH 
 MASTER 
 SAMPLE 
 DIFFERENCE 
 EDGE 

 

SHOW MASK 
(SAMPLE) 

 

 
 

TOGGLE THE FOLLOWING SAMPLE ELEMENTS ON OR OFF: 
 MASK 
 NUMBERS 
 BOXES 

DIFFERENCE 

REVIEW ACTIONS 
(SAMPLE) 

 

 
 

DIFFERENCE REVIEW ACTIONS: 
 GROUP 
 ADD 
 EXCLUDE 

 
RESYNC TOOL 

(SAMPLE) 

 

 

 
 

REMOVE IDENTICAL RESULTS DETECTED AS DIFFERENCES 

FROM DIFFERENCE LIST (TEXT INSPECTION) 
 

PAGE SELECTION 

PAGE SELECTION 

 

 
 

 
SELECT MASTER/ SAMPLE PAGES TO BE INSPECTED: 

 ALL PAGES 
 EVEN PAGES 
 ODD PAGES 
 PAGE RANGE 
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RESET PAGES 

 

 
 

RESET PAGE SELECTION 

SHOW PAGES/ 
HIDE PAGES 

 

 

SHOW OR HIDE ALL PAGES IN MASTER OR SAMPLE FOR 

EASIER NAVIGATION 

TEXT TOOLS 

 

 

SHOW LIVE TEXT 

 
 

CROSS OUT TEXT SO IT IS NOT INSPECTED 

 

 

UNDERLINE TEXT SO IT IS INSPECTED 

CREATE ZONES  

 

 

MATCH AND COMPARE SPECIFIC SELECTIONS OF MASTER 

AND SAMPLE TEXT 

CLEAR ALL 

 

 

CLEAR ALL TEXT/ SPELLING PARTIAL INSPECTION 

SELECTIONS 
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SHOW/HIDE 

 

 

TOGGLE DISPLAY OF MARK-UPS (UNDERLINE/ CROSS-OUTS/ 
ZONES) ON AND OFF 

CREATE NEW JOB 

PREVIOUS 

 

MOVE BACK TO LAST SCREEN 

NEXT 

 

MOVE TO NEXT SCREEN 

CLOSE 

 

CLOSE JOB WIZARD 

INSPECT 

 

PERFORM INSPECTION  

SCAN 

SAMPLE 

 

SCAN IN AND SELECT SAMPLE FILE 

SCAN 

MASTER/SAMPLE 

 

SCAN IN AND SELECT FILE 

LOAD MASTER 

 

SELECT MASTER FILE FROM FILE PATH 
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LOAD 

MASTER/SAMPLE 

 

SELECT MASTER/ SAMPLE FILE FROM FILE PATH 

SCAN FOR 

BARCODES 

 

SCAN SAMPLE FOR BARCODES TO USE AS JOB ID AND TO 

FIND POTENTIAL MATCHES FOR MASTER FILE 

ADD FROM JOB 

PATH 

 

ADD MASTER FILE FROM JOB PATH VIA SCAN FOR 

BARCODES FEATURE 

MARQUEE 

SELECTION 

 

SELECT AREA ON MASTER TO INSPECT AGAINST SAMPLE 
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3 Inspection Setup 

The following sections describe the main icons, options, and tools users encounter as they set up their 
inspection. 

3.1 File Drop-Down/ Menu 

The File  drop-down contains the following options:   

 
 

FILE MENU OPTIONS 

New Job 
Launch the Job Wizard; See Section 3.1.1 Job Wizard for more 
details 

Load Master 
Select and load the Master file; See Section 3.1.2 Loading Files 
for more details 

Load Sample 
Select and load the Sample file; See Section 3.1.2 Loading Files 
for more details 

 

The Menu  contains the following options:   

 
 

MENU OPTIONS 

Resolution  
Select the DPI value or set a custom value; See Section 3.1.3 
Resolution for more details 

Administration 
(Administrators and 
Managers Only) 

Settings  Manage user log-in/ log-out settings 

Audit Trail  Display audit log 

User Manager  Add/ edit user accounts and licenses 

Reporting Levels  Manage pre-defined levels 

Comments  Manage pre-defined comments 

Workflows  Create and manage preset configurations for 
running multiple inspections using the Job Wizard; See Section 
3.1.1 Job Wizard for more details 

Backup  Export or import a database. 

Force review of all differences 

Force inclusion of all differences 

NOTE: Please consult the Administration Guide for more 
information 

Change Password 
Change your password; Please see Section 2.3 Change 
Password for more information 

Layout 

Overview  Displays Overview panel 

Details  Displays Details panel 

Image Details  Displays Image Details panel (Text Inspection) 

Inspections  Displays Inspections panel 

Repeats  Displays Repeats found panel 
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Differences  Displays Difference List (for Graphics, Text, 
Spelling, and Color Inspections) 

Braille  Displays Braille panel 

Barcodes  Displays Barcode panel 

Master Panel  Displays Master panel 

Save Layout  Saves the current layout  

Reset Layout  Resets the default 

NOTE: Layout is disabled on the Main View and enabled on the 
Inspection View; More information on layout options specific to 
each inspection mode is available in subsequent chapters 

Preferences 

Language  nguage is English 

Hi-Contrast Different Image - Show differences in high contrast 

Difference Highlight Color  Toggle on and set the color and 
size of the mask to display on individual differences 

Mask Color  Set the color of the mask, which displays over 
everything excluded from the inspection on the Master or 
everything that is not detected as a difference on the Sample 

Automatically zoom to each difference  Zoom to each 
selected difference in the Inspection View 

Raster documents after zoom  Automatically raster files after 
zooming in, so they appear less pixelated 

Show Scanner interface  Launch the interface of the scanner 
software when scanning 

Color Library  Select the applicable color library, based on the 
connected color-calibrated GlobalVision scanner 

Default unit  Select the default Measurement Tools unit 

RGB Profile  Used to display the color space in the interface 

CMYK Profile  Used to display the color space in the interface 

NextImage Profile  Used in conjunction with Color Inspection 
Mode by the connected Contex scanner 

GlobalVision C8 Profile  Used in conjunction with Color 
Inspection Mode by the connected GlobalVision C8 scanner 

Show Job interface  Launch the Job Wizard upon resetting the 
interface or logging in; See Section 3.1.1 Job Wizard for more 
details 

Job Master Path  Choose the default path to find a master file in 
the Job Wizard 

System Paths  Choose the default paths to save the cache, 
reports, and images 

Logout 
Log out from the Application and display the Login window; See 
Section 2.5 Logout/ Exit for more information 

 

3.1.1 Job Wizard 

This section describes the basic steps to create a new job, using the Job Wizard, following a workflow. 
For more information on workflows, which consist of preset configurations (including actions and profiles) 
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to help run inspections more efficiently, please consult the Administration Guide. A detailed list of the 
default workflows available in the Application can be found in Appendix 12.3 Workflows.  

The Job Wizard helps ensure all conventions within an organization are met from tester to tester and no 
one deviates from set processes. Printers specifically can make use of the Job Wizard and its Scan for 
Barcodes feature, which intuitively matches pre-labeled master files to barcodes on given samples. 

To create a job: 

 Click File  > New Job. The Job Wizard displays with its default workflows. 
NOTE: The Job Wizard can be set to launch automatically when logging in or resetting the 
interface by ensuring the Show Job Interface in the Preferences window is checked. 
 

 

Select a Workflow Screen 
 

 Click on a workflow (either a default or custom workflow created by an administrator) to continue. 
 The Master & Sample Selection screen appears.  

 

 

Master & Sample Selection Screen 
 

 Click either of the Scan Sample buttons,  , to scan in hard-copy sample files as required 

or click the Load Sample  icon to load digital files. 
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 Rotate the Sample file(s) once selected if needed, by clicking the corresponding thumbnail at 
 

 Use the  thumbnail (on non-scanned files) to open the Layers and Separations window.  
 Click the PDF Page Box drop-down list to choose between Media Box, Trim Box, or Crop 

Box selections to automatically crop the file.  
 Choose to enable overprint by ensuring the corresponding box is checked.  

 Click the eye  icon beside the layer(s) and/ or separation(s) to toggle each on or off. 
 Click OK to accept. 

 

 

Sample Layers and Separations Window 
 

 Scan in the Master file(s) as required, by clicking the Scan Master  button, or load a digital 

file by clicking one of the Load Master buttons . 

 Optionally rotate the Master file(s) once it is loaded by clicking the corresponding thumbnail at 
 

 The  thumbnail beside it (on non-scanned files) opens the Layers and Separations window.  
 Click the PDF Page Box drop-down list to choose between Media Box, Trim Box, or Crop 

Box selections to automatically crop the file.  
 Click the Dieline drop-down list to select a layer or separation for extraction. 
 Choose to enable overprint by ensuring the corresponding box is checked.  

 Click the eye  icon beside the layer(s) and/ or separation(s) to toggle each on or off. 
 Click OK to accept. 

 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

32 of 214  12 Jun 2020 

 

Master Layers and Separations Window 
 

 Another method of loading the Master includes first clicking the Scan for Barcodes  button. 
The Barcode Selection window then loads with a drop-down menu of the different barcodes 
contained in the loaded Sample. Select the barcode that was assigned as the Job ID, which can 
alternatively be typed in.  

 

 

 

 Then click the Add from Job Path  button to open the Job Path window for a list of matching 
master files containing the same string in their names or parent folders. Select the applicable 
Master for the current inspection.  

 Fill in the Lot and Product Name fields as required. Whatever text is entered appears in the 
corresponding fields in the Report Options window, as a report is being generated (and then in 
the corresponding fields in the PDF report itself). 
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Job Path Window 
 

 Click Next  to move on to the Prepare Files screen, where the die-line color can be selected 
on the Master for shape extraction.  

 

 

Prepare Files Screen 
 

 Use the Marquee Selection  tool select a different region for inspection. Click it, then on the 
file to select the desired region. Resize the selection by scrolling over/ clicking on its borders and 
adjusting them accordingly. Click the tool again to clear the selection and start over.  

 In the case of a multi-page file, selecting a different page from the drop-down list directly below 
the Marquee Selection tool enables the new one to be displayed (and adjusted). Click the Next 
button again to navigate to the next master file, if more than one had been loaded. 

 Click  to close the Job Wizard and cancel the process (at any stage). 

 Click the  Inspect button to load the files in the Master and Sample panels and run the 
inspection. The process follows the same steps as a normal inspection at this point, with the 
file(s) just loaded in the Inspection View. Consult the Graphics, Barcode, Braille, Text, or Spelling 
Inspection chapters for more information.   
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3.1.2 Loading Files 

To load a file in either the Master or Sample panel and prepare it for inspection: 

 Click File  > Load Master or Load Sample to launch the load-file window,  
 Or double-click in the Master or Sample panel on the appropriate icon, 
  

 Once the load-file window is launched, select the required file and click Open.   
 If it is a PDF or AI file, the PDF Viewer launches instead (see Section 3.6 PDF Viewer). 

NOTE: There is more information on loading files in the respective step-by-step sections of 
each chapter dedicated to the individual inspection processes. 

 

3.1.3 Resolution 

To set the resolution of a master or sample file to be loaded: 

 Click Menu  > Resolution. 
 Choo  
 If the selected DPI of a file you are loading is different than the Desired DPI setting in the profile 

being used, the following message appears: 

 

 

 
 Click Yes to change the DPI to the prescribed amount or No to move ahead with the initial value. 

NOTE: The Master and Sample files must be rasterized at the same DPI value. If they do not 
match, a message to confirm they do not appears when you try to run the inspection. 

To set a custom value in DPI: 

 Click Menu  > Resolution  . 
 Click and enter your own value or press the arrows on either side of the box.  

 

 

 
 Click OK. 
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3.1.4 Preferences 

The following options are available in the Preferences window: 
 

 
Preferences Window 

 
 Language: 

Japanese, Korean, Polish, Portuguese (Brazil), Russian, Slovenian and Spanish also available. 
 Hi-Contrast Difference Image: This option displays differences between the Master and Sample 

images in higher contrast. For more information, see Section 5.3.3.3 Show Difference Image. 
 Difference Highlight Color: When checked, this option highlights Graphics Inspection 

differences in a mask of a customizable color and size. Re-inspect for the change to take effect. 
 Mask Color: This option lets the user set the mask color, with the ability to pick screen or custom colors. 

For more information, see Section 5.3.4.1 Show Mask. 
 Automatically zoom to each difference: When this option is checked, the selected difference, 

barcode, or Braille region is zoomed in on instead of just highlighted in the Inspection View. 
 Raster documents after zoom: When this option is checked, Barcode, Text, or Spelling 

Inspection files raster automatically after being zoomed, for added clarity and less pixelation. 
 Show Scanner interface: When this option is checked, the Application goes through the scanner software 

when scanning. When it is unchecked, the scanner software is not displayed. 
 Color Library: Select the applicable color library from the drop-down list, based on the 

connected color-calibrated GlobalVision scanner. 
 Default unit: Choose the unit in which lines or rectangles drawn using the Measurement Tools 

will appear. 
 RGB Profile: The RGB Profile is used to display the color space in the user interface. The default 

profile is AdobeRBG1998.icc. 
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 CMYK Profile: The CMYK Profile is used to display the color space in the user interface. The default 
profile is USWebCoatedSWOP.icc. 

 NextImage Profile: The color calibration file for the connected Contex scanner (to be used in 
conjunction with Color Inspection Mode). 

 GlobalVision C8 Profile: The color calibration file for the connected GlobalVision C8 scanner (to 
be used in conjunction with Color Inspection Mode). 

 Show Job interface: When checked, this option automatically loads the Job Wizard whenever the 
Application is opened or the interface is reset. 

 Job Master Path: Set the default path loaded when selecting master files on the Master & 
Sample Selection screen of the Job Wizard. 

 Cache Path: Set where data is stored by the Application.   
 Report Path: Set the location of where generated reports are saved.  
 Image Save Path: Set the default path when saving images. 

 Show font substitution notifications: Ability to Show or hide the font substitution popup 
message from the UI. Checked by default. 

 

3.2 Inspection Modes 

Graphics Inspection Mode  requires the user to load the desired Sample and Master files and select 
the proper area for a pixel-by-pixel inspection. For more information, see Chapter 5 Graphics Inspection.  

Barcodes on master or sample images can be inspected in Barcode Inspection Mode . See Chapter 
6 Barcode Inspection for more on individual features as well as detailed instructions and guidelines. 

Braille on master or sample images can be inspected or compared in Braille Inspection Mode . The 
process involves loading the desired file(s) and choosing between six separate actions, with a wide 
variety of Braille languages available. For more information, see Chapter 7 Braille Inspection. 

Text Inspection Mode  compares the text in two like or unlike documents. For example, an internally 
-

out packaging loaded as the Sample. Change settings to switch between inspecting left-to-right, right-to-
left, and Asian languages. For more information, see Chapter 8 Text Inspection. 

Spelling Inspection Mode  inspects the spelling of loaded files and detects errors using 37 language 
dictionaries and one English medical dictionary. For more information, see Chapter 9 Spelling Inspection. 

Color Inspection Mode  is used to either measure the Pantone, LAB, CMYK, and RGB values of a 
selected point or compare a collection of points on a master and sample based on a custom-set Delta-E 
2000 tolerance level. For more information, see Chapter 10 Color Inspection.  
 

3.3 Master Toolbar 

The toolbar at the top of the Master panel contains the following tools:    
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Master Toolbar 
 

3.3.1 File Name 

X on the far side. To clear the 
panel and load another file, simply click the X and start the file-loading process again. 
 

3.3.2 PDF Options 

If a PDF or AI file is loaded in the Master panel, the PDF Options  icon can be clicked, toggling 
access to a separate set of tools on or off. See Section 3.6 PDF Viewer for more details. 
 

3.3.3 Master File Information Panel 

To display information about the Master file:  

 Click File Information . The following information displays:  

 

 

Master File Information Panel 
 

 File Type: The originating file format 
 Rastered DPI: The DPI at which the file was rasterized 
 Image Size: The size of the image (pixels) 
 Memory Size: The amount of physical memory the rasterized image uses (MB) 

 

3.3.4 Master Image Adjustment Panel 

 

 Click Image Adjustments . 

 

 

Image Adjustments Panel 

 
 Click the button in the center of the applicable bar and slide it to the right or left as required.  

- Alternatively click on the arrows on either end of the fields or manually enter values in each. 
 Click Apply to make the changes. The Master image displays in the Master panel with the 

adjusted brightness, contrast, and or gamma value.   
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 Click Cancel to close the Master Image Adjustments panel.  
 

3.3.5 Optical Character Recognition (OCR) 

OCR  stands for Optical Character Recognition. Requiring an internet connection, the tool transforms 
non-live text, like one would find on a scanned document for example, to inspectable text for the purposes 
of inspecting text or spelling. 

NOTE: A live-text file is ideal for accurate quality control. In the absence of a live-text file, OCR can be 
useful, but is unsupported by GlobalVision; False positives and/ or missed differences may result. 

To take advantage of OCR when running a text or spelling inspection on files featuring non-live text, in 
the Master panel: 

 Click the Region Mode  icon and select Marquee. For more information see Section 3.3.8 
Region Mode. 

 Left-click and use the crosshairs that appear to select the desired non-live text. A red box 
surrounds the selected area. Resize/ move it as necessary by clicking and dragging its borders.  

 Click OCR to process the text. 
NOTE: To marquee additional regions, repeat the steps above, avoiding overlap. 

 If applicable, crop the corresponding text in the Sample panel (for Text Inspection). For more 
information, see Section 3.4.5 Optical Character Recognition (OCR) (on the Sample toolbar). 

 Click Inspect to run the inspection. The differences display as they normally would following an 
inspection. For more information, see Chapter 8 Text Inspection or Chapter 9 Spelling Inspection. 
NOTE: If there was live text on the file, it is detected pre-inspection as well, regardless of whether 
it had been cropped. However, during text inspections, only the marqueed text gets checked. In 
contrast, during a spelling inspection, all live text gets verified. 
 

 

OCR Used on a Master File in Conjunction with Spelling Inspection 
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3.3.6 Lasso Selection 

Lasso Selection  allows the user to outline and select specific portions of the Master file to be 
included or excluded in a graphics inspection (shapes), segment by segment. 

To add a portion of the Master to be inspected, using the Lasso Selection tool:   

 Click the Lasso Selection icon to access its drop-down options. 
 Select Add to inspection. 
 Click on a starting point on the Master. A red dot appears. 
 Drag and click again to form the first segment. A yellow dot appears. 

NOTE: To undo the last segment, click on the yellow dot to redrag the segment. 
 Repeat the process until the last segment connects to the very first point and the shape 

containing the portion of the Master to be included in the inspection has been formed. 
 Add additional, separate portions of the Master to be included in the same inspection, if required. 

The inspection, once it is run, only verifies the selected shapes. 

 

  

One Lasso-Selected Shape with Another in the Process of Being Selected 

 
To remove a portion of the Master to be inspected, using the Lasso Selection:   

 Click the Lasso Selection icon to access its drop-down options. 
 Select Remove from inspection. 
 Click on a starting point on the Master. A red dot appears. 
 Drag and click again to form the first segment. A yellow dot appears. 

NOTE: To undo the last segment, click on the yellow dot to redrag the segment. 
 Repeat the process until the last segment connects to the very first point and the shape 

containing the portion of the Master to be removed from the inspection has been formed. 
 Add additional, separate portions of the Master to be removed in the same inspection, if required. 

The inspection, once it is run, only verifies the portions of the Master outside the selected 
shape(s).  

Red Dot to Signify 
Created Point; 
Yellow Dot to 

Signify Created 
Segment that Can 

Be Undone
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NOTE: If a separate shape has been selected (i.e., a die line) via Region Mode or the PDF 
Viewer and the lasso-selected shape(s) appear within, the die line and all of its contents, 
excluding what had been lasso-selected, will be inspected. 

 

  
 

To remove the entire lasso selection and start again: 
 Right-click on the created shape. 
 Select Reset to full page  
 Re-select the die line if necessary.  

 

3.3.7 Measurement Tools 

The Measurement Tools  icon gives users access to both Rectangle and Line options when running 
a graphics inspection. By clicking and dragging the mouse on the file after making a selection, the user 
draws either a rectangle or line, with units displayed in either inches, millimeters, or pixels (see Section 
3.1.4 Preferences). This allows the user to measure the size of graphic elements in the loaded file. 

To measure a line: 

 Click the Measurement Tools icon and select Line. 
 Click and drag the mouse on the file in the Master panel in the desired location. 
 Resize it by clicking on either one of its ends and then dragging. 
 Move the line by clicking on any other portion of the figure and then dragging. 
 Right-click for the option to delete the line. 

To measure a rectangle: 

 Click the Measurement Tools icon and select Rectangle. 
 Click and drag the mouse on the file in the Master panel in the desired location. 

Lasso-Selected 
Shape to Be 

Excluded from 
Inspection 
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 Resize it by clicking on its borders and then dragging. 
 Move the rectangle by clicking in its borders and then dragging 
 Right-click to either delete the rectangle or select Snap to line for a closer crop. 

 

 
Rectangle Created, Around Barcode, Using Measurement Tools 

 
To generate a PDF report of the measurements (without inspecting the files): 

 Click the Measurement Tools icon and select Report. The Report Options window launches. 
 Fill in the fields as required (for more information, see Section 4.5 Generating Reports). 

NOTE: The PDF Attachment option is not available for Measurement Tools reports. 
 Click View or Save to generate the report, which lists each of the measurements made in inches, 

millimeters, and pixels. 

 

3.3.8 Manual Alignment  

Manual Alignment  preps the loaded images for a pixel-by-pixel comparison by using a selected 
reference point on the Master and Sample files.   

NOTE: The loaded images must have the same orientation and be approximately the same size. Click 

Master Information  or Sample Information  to get the image size.    

To use the Manual Alignment tool:   

 Click Marquee Zoom  on the Master toolbar to zoom in on an area on the Master to select 
the reference point. 

 Left-click and move the crosshairs that appear around the desired area. A red box surrounds it.  
 Release the button to magnify the area and select it as the reference point.   
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 Repeat the process in the Sample panel. 

  

Master and Sample Images Before Marquee Zoom 
 

 

Master and Sample Images After Marquee Zoom  
   

 Click Manual Alignment  on each of the toolbars and select the reference points.  

 

  

Manual Alignment with Selected Point of Reference 

Marquee Zoom to ThisArea Marquee Zoom to This Area 
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3.3.9 Region Mode 

Region Mode  lets you select an area in the image to be inspected.  
NOTE: The minimum cropping area is 100 x 100 pixels.  

If you right-click on a layer (e.g. die line) and choose Set as shape region & hide or Use as 
shape region in the integrated PDF Viewer, it automatically gets set as the Shape. Selecting the 
shape is key when inspecting repeats.  

To select an area in the Master image to be used in the inspection: 

 Click Region Mode  and select one of the options: 
 Full Page: The entire page gets selected as the inspection area.  
 Shape: Shape mode is used to detect a shape for repeat detection. Left-click on the shape to 

be used as the inspection area. The selected shape displays in the Master panel.  
NOTE: You can also create a shape for repeat detection with the Marquee tool, by creating 

the shape and clicking Crop to Contents  afterwards. 
 Marquee: Left-click and use the crosshairs that appear to select the area to be used as the 

inspection area. A red box surrounds the selected area. 
 

 

 
 Trim: The largest bounding area of the image is selected. A red box surrounds the area. 

appears by right-
clicking: 

 Choose between applying the selection to all, even, or odd pages in a multi-page file. 
 Click Change to circle to replace the rectangular selection with a circular one. 
 Click Clear all pages to remove the selection. 
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Context Menu 

3.3.10 Crop to Contents 

To tighten the crop selection so that it includes only the object:   

 Click Region Mode  and select Marquee.  
 Select an area using the crosshairs that appear by clicking and dragging. A red box surrounds the 

selected area.  

 Click Crop to Contents . The crop selection adjusts so that it contains only the revised 
selection.   

 

3.3.11 Reload Master 

To reload the Master: 

 Click Reload Page . The image reloads in the Master panel. 

 

3.3.12 Rotate Master 

To rotate the Master 90º clockwise:  

 Click Rotate  > Rotate 90 CW. 

To rotate the Master 90º counter-clockwise:  

 Click Rotate  > Rotate 90 CCW. 

To rotate the Master 180º clockwise:  

 Click Rotate  > Rotate 180. 

To specify the angle to rotate the Master:  

 Click Rotate  > Arbitrary rotate. The Master Rotation window displays. 
 Insert the desired angle by typing in the prompt or clicking the arrows on either side and click OK.  

NOTE: Not recommended for Text and Spelling Inspection modes. 

To mirror-rotate the Master horizontally:   

 Click Rotate  > Mirror Horizontally. 
NOTE: Not recommended for Text and Spelling Inspection modes.  
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To mirror-rotate the Master vertically: 

 Click Rotate  > Mirror Vertically. 
NOTE: Not recommended for Text and Spelling Inspection modes. 
 

3.3.13 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the Master image:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 

 

  

Color Inspector Window 
 

3.3.14 Marquee Zoom 

To magnify the image:   

 Place the cursor in the Master panel. 
 Scroll upward with the track wheel.  

NOTE: On a Mac operating system, scroll downward with the track wheel if the Scroll Direction: 
Natural setting is ON. 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the left button of your mouse 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

46 of 214  12 Jun 2020 

 Or scroll upward with the track wheel. 

NOTE: On a Mac operating system, scroll downward with the track wheel if the Scroll Direction: 
Natural setting is ON. 

To reduce the magnification:    

 Place the cursor in the Master panel. 
 Scroll downward with the track wheel.  

NOTE: On a Mac operating system, scroll upward with the track wheel if the Scroll Direction: 
Natural setting is ON. 

To pan: 

 Left-click in the Master panel. Hold and move the mouse around the panel.   

 

3.3.15 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 

3.3.16 Save View 

To save the Master image view:   

 Click Save View . 
 The Save As window displays. Enter the file name in the desired location and click Save. 

 

3.4 Sample Toolbar 

The toolbar at the top of the Sample panel contains the following tools: 

 

 

Sample Toolbar 
 

3.4.1 PDF Options 

If a PDF or AI file is loaded in the Sample panel, the PDF Options  icon can be clicked, toggling 
access to a separate set of tools on or off. See Section 3.6 PDF Viewer for more details. 

 

3.4.2 File Name 

s name appears in the lower half of the toolbar, with an X on the far side. To clear the 
panel and load another file, simply click the X and start the file-loading process again.  
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3.4.3 Sample File Information Panel 

To display information about the Sample file:  

 Click File Information . The following information displays:  

 

 

Sample File Information Panel 
 

 File Type: The originating file format 
 Rastered DPI: The DPI at which the file was rasterized 
 Image Size: The size of the image (pixels) 
 Memory Size: The amount of physical memory the rasterized image uses (MB) 

 

3.4.4 Sample Image Adjustment Panel 

 

 Click Image Adjustments . 

 

 

Image Adjustments Panel 
 

 Click the button in the center of the applicable bar and slide it to the right or left to adjust the 
settings as required.   

 You can alternatively click on the arrows on either end of the different fields or manually enter 
values in each. 

 Click Apply to make the changes. The Sample image displays in the Sample panel with the 
adjusted brightness, contrast, and/ or gamma value.   

 Click Cancel to close the Sample Image Adjustments panel. 

 

3.4.5 Optical Character Recognition (OCR) 

OCR  stands for Optical Character Recognition. Requiring an internet connection, the tool transforms 
non-live text, like one would find on a scanned document for example, to inspectable text for the purposes 
of inspecting text or spelling. 

NOTE: A live-text file is ideal for accurate quality control. In the absence of a live-text file, OCR can be 
useful, but is unsupported by GlobalVision; False positives and/ or missed differences may result. 
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To take advantage of OCR when running a text spelling inspection on files featuring non-live text, in the 
Sample panel: 

 Click the Crop  icon. For more information see Section 3.4.7 Crop Sample. 
 Left-click and use the crosshairs that appear to select the desired non-live text, that corresponds 

to what had been marqueed in the Master panel if applicable (for Text Inspection; For more 
information, see Section 3.3.5 Optical Character Recognition (OCR) (on the Master toolbar)).  

 A red box surrounds the selected area. Resize/ move it as necessary by clicking and dragging its 
borders.  

 Click OCR to process the text. 
NOTE: To marquee additional regions, repeat the steps above, avoiding overlap. 

 Click Inspect to run the inspection. The differences display as they normally would following an 
inspection. For more information, see Chapter 8 Text Inspection or Chapter 9 Spelling Inspection. 
NOTE: If there was already live text, it is detected pre-inspection as well, regardless of whether it 
had been cropped. However, during text inspections, only the marqueed text gets checked. In 
contrast, during a spelling inspection, all live text gets verified.  
 

 

OCR Used on a Sample File in Conjunction with Spelling Inspection 
 

3.4.6 Measurement Tools 

The Measurement Tools  icon gives users access to both Rectangle and Line options when running 
a graphics inspection. By clicking and dragging the mouse on the file after making a selection, the user 
draws either a rectangle or line, with units displayed in either inches, millimeters, or pixels (see Section 
3.1.4 Preferences). This allows the user to measure the size of graphic elements in the loaded file. 

To measure a line: 

 Click the Measurement Tools icon and select Line. 
 Click and drag the mouse on the file in the Sample panel in the desired location. 
 Resize it by clicking on either one of its ends and then dragging. 
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 Move/ tile the line by clicking on any other portion of the figure and then dragging. 
 When the cursor appears as a hand, you can move the line outright. 
 When the cursor appears as a vertical double-sided arrow, you can shift its angle. 

 Right-click for the option to delete the line. 

To measure a rectangle: 

 Click the Measurement Tools icon and select Rectangle. 
 Click and drag the mouse on the file in the Sample panel in the desired location. 
 Resize it by clicking on its borders and then dragging. 
 Move the rectangle by clicking in its borders and then dragging 
 Right-click to either delete the rectangle or select Snap to line for a closer crop. 

 

 
Rectangle Created, Around Barcode, Using Measurement Tools 

 
To generate a PDF report of the measurements (without inspecting the files): 

 Click the Measurement Tools icon and select Report. The Report Options window launches. 
 Fill in the fields as required (for more information, see Section 4.5 Generating Reports). 

NOTE: The PDF Attachment option is not available for Measurement Tools reports. 
 Click View or Save to generate the report, which lists each of the measurements made in inches, 

millimeters, and pixels. 

 

3.4.7 Manual Alignment 

Follow the process described in Section 3.3.8 Manual Alignment. 

 

3.4.8 Crop Sample 

To select an area of the Sample image to be inspected:  

 Click Crop .  
 Left-click and select an area using the crosshairs that appear. A red dotted line surrounds the selected area.   
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NOTE: The minimum cropping area is 100 X 100 pixels.  

-clicking: 

 Choose between applying the selection to all, even, or odd pages in a multi-page file. 
 Click Change to circle to replace the rectangular selection with a circular one. 
 Click Clear all pages to remove the selection. 

 

 

Context Menu 
 

3.4.9 Crop to Contents  

To tighten the crop selection so that it includes only the object:   

 Click Crop Sample .  
 Left-click and select an area with the crosshairs that appear. A red dotted line surrounds it. 

 Click Crop to Contents . The crop selection adjusts to contain only the revised selection.  

  

3.4.10 Support Rotated Repeats 

To run an inspection using a sample image that contains rotated repeats of the Master: 

 Click Support Rotated Repeats  before running the inspection. During the inspection, the 
images are compared as if there were no rotation.  

 

3.4.11 Match Scale 

Match Scale  
 

NOTE: The minimum cropping area is 100 X 100 pixels. 

To use Match Scale :  

 In the Master panel, click Region Mode   Marquee and select the crop area. Use Crop to 

Contents  to get a tighter crop. 

 In the Sample panel, click Crop  and select the crop area. Use Crop to Contents  to get 
a tighter crop area. 
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 Click Match Scale . When the inspection is run, the Sample cropped area is inspected as if it 
were the same size as the Master cropped area.  
NOTE: Both the Master and Sample images must be cropped before Match Scale is used. 
 

  

Main View with Match Scale Selected 
 

3.4.12 Reload Sample 

To reload the sample: 

 Click Reload . The image reloads in the Sample panel. 

 

3.4.13 Rotate Sample 

To rotate the Sample 90º clockwise:  

 Click Rotate  > Rotate 90 CW. 

To rotate the Sample 90º counter-clockwise:  

 Click Rotate  > Rotate 90 CCW. 

To rotate the Sample 180º clockwise:  

 Click Rotate  > Rotate 180. 

To specify the angle to rotate the Sample:  

 Click Rotate  > Arbitrary rotate. The Sample Rotation window displays. 
 Insert the desired angle by typing in the prompt or clicking the arrows on either side and click OK.  

Cropped Area  

Cropped Area 
(Smaller than 

Master) 
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 NOTE: Not recommended for Text and Spelling Inspection modes. 

To mirror-rotate the Sample horizontally:   

 Click Rotate  > Mirror Horizontally. 
NOTE: Not recommended for Text and Spelling Inspection modes. 

To mirror-rotate the Sample vertically: 

 Click Rotate  > Mirror Vertically. 
NOTE: Not recommended for Text and Spelling Inspection modes. 
 

3.4.14 Color Inspector  

To display the RGB, CMYK, and LAB color-space information for a selected area in the Sample image:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 
 

  

Color Inspector Window 
 

3.4.15 Marquee Zoom 

To magnify the image:   
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 Place the cursor in the Sample panel. 
 Scroll upward with the track wheel.  

NOTE: On a Mac operating system, scroll downward with the track wheel if the Scroll Direction: 
Natural setting is ON. 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the left button of your mouse 

 Or scroll upward with the track wheel. 

NOTE: On a Mac operating system, scroll downward with the track wheel if the Scroll Direction: 
Natural setting is ON. 

To reduce the magnification:    

 Place the cursor in the Sample panel. 
 Scroll downward with the track wheel. 

NOTE: On a Mac operating system, scroll upward with the track wheel if the Scroll 
 Direction: Natural setting is ON. 

To pan: 

 Left-click in the Sample panel. Hold and move the mouse around the panel.   

 

3.4.16 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 

3.4.17 Save View 

To save the Sample image view:   

 Click Save View . 
 The Save As window displays. Enter the file name in the desired location and click Save. 

 

3.5 Page Selection Toolbar 

The Master/ Sample Page Selection toolbar on the bottom of the panel contains the following tools: 

 

 

Page Selection Toolbar 

3.5.1 Page Navigation 

To display a different page in the Master/ Sample panel before or after inspections: 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

54 of 214  12 Jun 2020 

 Click the left or right arrows on either side of the Page Navigation tool. 
 Alternatively click on the arrow in the middle of the tool to access the Page Navigation drop-

down list and go directly to the page of your choice. 
NOTE: When performing single-page inspections on multi-page files, this feature is disabled after 
the inspection is run. 

 

3.5.2 Live Text 

To highlight all inspectable text (in Text or Spelling Inspection modes) in the Master or Sample panel: 

 Click on the corresponding Live Text  icon.  

To remove the highlights: 

 Click the icon again.  
NOTE: Text that is not live (and is part of an image, for example) can still be inspected, but only 
as part of a pixel-to-pixel comparison between two similarly laid-out files in Graphics Inspection. 

 

3.5.3 Cross-out Text 

To exclude text from text and spelling inspections: 

 Click the appropriate Cross-out Text  icon (in either the Master or Sample panel).  
 Click and drag the crosshairs icon that appears as the cursor over the text to be excluded in 

either the Master or Sample panel.  
NOTE: Multiple selections can be made. 

To apply a cross-out to different portions of a multi-page file: 

 Right-click on the crossed-out text.  
 -out to all pages, odd pages, even 

pages, or identical text elsewhere in the file. 
NOTE: Clear removes the currently selected crossed-out text. Clear All removes all cross-outs. 
 

 
Context Menu 

 
To cancel out underlined text (see Section 3.5.4 Underline Text) using Cross-out Text: 

 Click on Cross-out Text. 
 Click and drag the crosshairs icon that appears as the cursor over the underlined text. 
 The underlines are removed. 

NOTE: Cross-out Text and Underline Text cannot otherwise be applied together in the same 
file (unless it is to cancel the other one out). 
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3.5.4 Underline Text 

To specifically include text in text and spelling inspections (and exclude all other text): 

 Click the appropriate Underline Text  icon (in either the Master or Sample panel).  
 Click and drag the crosshairs icon that appears as the cursor over the text to be included in either 

the Master or Sample panel.  
NOTE: Multiple selections can be made. 

To apply an underline to different portions of a multi-page file: 

 Right-click on the underlined text.  
 apply the underline to all pages, odd pages, even 

pages, or identical text elsewhere in the file. 
NOTE: Clear removes the currently selected underlined text. Clear All removes all underlines. 

To cancel out crossed-out text (see Section 3.5.3 Cross-out Text) using Underline Text: 

 Click on Underline Text. 
 Click and drag the crosshairs icon that appears as the cursor over the crossed-out text. 
 The cross-outs are removed. 

NOTE: Cross-out Text and Underline Text cannot otherwise be applied together in the same 
file (unless it is to cancel the other one out). 

 

3.5.5 Create Zones 

Create Zones can be used to specifically include sections of a given document in text inspections 
(excluding all other text) and compare them directly to the corresponding portions in the other panel. This 
comes in handy when inspecting tables, by selecting different columns/ rows individually in each of the 
Master and Sample panels. 

To start creating a zone: 

 Click the Create Zones  icon below the Master or Sample panel. 
 Click and drag the crosshairs icon that appears as the cursor over the text to be included. The 

text is highlighted and an ID is assigned. 
 Highlight the corresponding text in the Sample. A corresponding ID is assigned. 

NOTE: The Zoning sub-panel pops up in the Sample panel, as a guide as to which matches are 
available to be selected. Clicking on a match zooms in to that selection on the Sample, so you 
can highlight it. 

 Create new zones by clicking and dragging separate portions of text in each panel and repeating 
the overall process, one at time. 
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Zone #1 Selected in Master and Zoning (Sample) Panels 

 
To add to a zone: 

 Right-  

 

 
Context Menu 

 
 Select Add. 
 Click and drag the cursor over a new portion of text.  
 The same number designation of the original zone appears at the top of the new selection. 
 Repeat the process in the other panel if necessary. 

To clear a zone: 

 Right-  
 Select Clear to delete a zone and its counterpart in the opposite panel. 

NOTE: Clear also deletes the original zone if you had right-clicked on an added portion. 
 Select Clear All to delete all zones in both panels. 

 

3.5.6 Show/Hide 

To toggle the appearance of all underlines, cross-outs, or zones on or off in a master or sample file, either 
before an inspection or after: 

 Click the Show/Hide  icon. 
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Show/Hide Toggled On in Master Panel, Toggled Off in Sample Panel 
 

3.5.7 Clear All 

To clear all underlines, cross-outs, or zones in a master or sample file: 

 Click the Clear All  icon. A message appears, asking if you want to continue. 
 Click Yes. 

3.5.8 Page Selection 

Click the Page Selection  icon for the option to include or exclude pages from a multi-page document 
when running an inspection. This launches the Select Pages window. When clicking the icon in the 
Master panel, the Select Master Pages window pops up. When clicking the icon in the Sample panel, the 
Select Sample Pages window pops up instead. 

 

 

Select Master Pages Window 
To include/ exclude different pages in a master or sample file before running an inspection: 

 Click Include or Exclude on the left side of the window. 
 Click either All Pages, Even Pages, or Odd Pages, or enter a custom range on the right side. 
 Select Apply to Master/ Apply to Sample, depending on the panel in which the Page Selection 

icon was first clicked, to finalize the page range. 
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 Select Copy to Sample/ Copy to Master to apply the same range to the other panel. 
NOTE: Copy to Sample/ Copy to Master can only be used when the number of pages is the 
same in the Master and Sample. 

To reset the pages and negate your selection: 

 Click the Reset Pages  icon to the left of the Page Selection icon. 

 

3.5.9 Show Pages 

The Show Pages/ Hide Pages icon shows/ hides an extra panel displaying all the pages loaded in the 

Master or Sample panel. When the panel is hidden, an up arrow  appears. Once the icon has been 

clicked and the panel appears, displaying the different pages, a down arrow  appears instead. 
NOTE: The icon is disabled once an inspection is run. 
 

 

Show Pages Panel 
 

To display a different page in the Master or Sample panel: 

 Click on the page of your choice in the Show Pages panel. 

To scroll through the loaded pages in the Show Pages panel: 

 Move the mouse over the scroll bar at the bottom of the panel. 
 Scroll the track wheel up or down or left-click the mouse and move it in the desired direction. 

 Alternatively, right-click on the scroll bar and choose between the following options: 
 Scroll here 
 Left edge or Right edge 
 Page left or Page right 
 Scroll left or Scroll right 

To exclude a page from the inspection: 

 Right-click on a page in the panel to reveal the Exclude Page option.  
 Click it to cross the page out and exclude it from the inspection.  

 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

59 of 214  12 Jun 2020 

 

 

 

To re-include excluded page(s): 

 Right-click a page and unselect the Exclude Page option that appears. 

 Alternatively click the Reset Pages  icon to reset all pages. 

 

3.6 PDF Viewer 

The integrated PDF Viewer launches when you load a PDF or AI file. It consists of various panels and 

can be toggled on/ off and hidden from view when clicking the PDF Options  button on the far left of 
either the Master or Sample toolbar. 

Master Panel 
Displaying 
Excluded Page  

Show Pages Panel 
Displaying All Loaded 
Files Including 
Excluded Page 

Show Pages Panel Scroll Bar 

Hide (Show) 
Pages Icon 
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Integrated PDF Viewer  

3.6.1 PDF Viewer Options Panel 

3.6.1.1 Options  

 

  

Options Panel 
 

To select an option, click the checkbox beside it or select one of its drop-down options: 

 Enable overprint: Provides an on-screen simulation that approximates how blending and 
overprinting appears in color-separated output. The initial default is set to checked, while the 
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 Following page for region: When a file has multiple pages, you have the option to apply the die 
line on the next page. This would be used if the die line is on the next page relative to the artwork 
(as opposed to the same page, as is the case with some files). 

 PDF Page Boxes: Select the appropriate page box for shape selection: 
- Media Box: Defaults to Media Box 
- Trim Box: Defaults to Trim Box (to be used if your file is print-ready) 
- Crop Box: Defaults to Crop Box 

 

3.6.1.2 Layers 

 

  

Layers Panel 
 

The Layers panel displays a list of the layers present in the PDF file.   

To hide a layer:  

 Click the eye icon . The icon grays out and the layer becomes hidden in the image.  

To unhide a hidden layer: 

 Click the eye icon . The icon returns to its default color and the layer re-appears in the 
image.  

 

3.6.1.3 Separations 

 

 

Separations Panel 
 

The Separations panel displays the color separations present in the PDF file.   

To hide a separation:  

 Click the eye icon . The icon grays out and the separation becomes hidden in the image.  

To unhide a separation: 

 Click the eye icon . The icon returns to its default color and the separation re-appears.  
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3.6.1.4 Layers and Separations Sub-Menu  

 

 

 

To select a sub-menu option: 

 Right-click on a layer or separation to display the sub-menu.  
 Click to select an option:  

- Set as shape region & hide: The layer or separation is detected as a shape and hidden 
when the image is loaded into the Master/ Sample panel (with the shape outlined).  
NOTE: Only one layer or separation can be used for shape extraction at a time. The selected 
layer or separation is underlined in its corresponding panel in the integrated PDF Viewer. 

- Use as shape region: The layer or separation is detected as a shape. The image loads in 
the Master/ Sample panel with the shape outlined. The layer or separation is not hidden. 
NOTE: Only one layer or separation can be used for shape extraction at once. The selected 
layer or separation is underlined in its corresponding panel in the integrated PDF Viewer. 

- Add to shape library: The layer or separation by the same name is detected as a shape by 

default. A yellow folder icon  displays to the left of the selected layer to indicate it has 
been added to the Library. Right-click to uncheck the Add to shape library option. 
NOTE: Add to shape library takes effect at the next load. For the shape to be set, reload the 
file. 

- Hide by default: If you select this option, the selected layer/ separation always stays hidden. 

The eye icon grays out and a folder icon  displays. Right-click to uncheck the option. 
NOTE: Hide by default takes effect at the next load, including for the file currently loaded. For 
the layer or separation to be hidden on the file currently loaded, reload the file. 

 

3.6.1.5 Process 
 

 

Process Panel 
 
The Process panel displays the process colors that are present in the PDF image.   

To hide a process color:  

 Click the eye icon . The icon grays out and the process color becomes hidden in the image.  

To unhide a process color: 

 Click the eye icon . The icon returns to its default color and the process color re-appears.  
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4 Inspection Process 

The chapter describes the basic steps involved with running an inspection. 

 

4.1 Inspection View 

Once an inspection is run, the Inspection View loads. 

NOTE: On a Mac, the Repeats found panel (in Graphics Inspection) displays on the left side. 
 

  

Inspection View 
 

4.2 Performing Inspections 

The inspection process lets users review the detected differences when comparing two files, review 
Braille translations and measurements, review barcode grades and parameters, review detected spelling 
mistakes, with both single inspection and multi-inspection options available. Furthermore, the color-space 
information at individual points can be compared between files. The following sections describe the basic 
steps to follow when running an inspection. For more detailed steps describing each specific inspection 
process, see Chapter 5 Graphics Inspection, Chapter 6 Barcode Inspection, Chapter 7 Braille Inspection, 
Chapter 8 Text Inspection, Chapter 9 Spelling Inspection, or Chapter 10 Color Inspection. 

 

4.2.1 Single Inspection 

To perform a single inspection: 

 Load the Master/ Sample files you want to inspect in the Master/ Sample panels respectively. 
 Make sure the area you would like to inspect is selected before proceeding. 
 Select the appropriate mode for the inspection you would like to perform: 

 Graphics Inspection  

Inspection  
View 

Inspection Toolbars 
Repeats 
Found 
Panel 

Difference 
List 

Difference 
Details/ 

Levels and 
Comments 

Panel 

Overview 
Panel 

Inspections 
Panel 

Main  
Icons 
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 Color Inspection  

 Barcode Inspection  

 Braille Inspection  

 Text Inspection  

 Spelling Inspection  
 Select the appropriate action and then profile (if applicable, for a color inspection) from the 

Action and Profile drop-down menus respectively. 

 Click . 
 

4.2.2 Multiple Inspections 

To run multiple inspections in the different inspection modes: 

 Load the files you want to inspect in the Master and/ or Sample panels respectively. 
 Make sure the region you would like to inspect is selected before proceeding. 
 Select the inspection modes you would like to perform one by one, clicking the check boxes in 

their icons as you do: 

 Graphics Inspection  

 Color Inspection  

 Barcode Inspection  

 Braille Inspection  

 Text Inspection  

 Spelling Inspection  
 For each inspection mode, select the appropriate action and then profile from the Action and 

Profile drop-down menus. 
NOTE: The Application performs the graphics, color, barcode, Braille, text, and spelling 
inspections based on the last action and profile selected in each mode. 

 Click the Inspect  icon. 
 

4.3 Canceling/ Changing the Inspection 

4.3.1 Reset 

To clear the Master/ Sample images and inspection results from the Master/ Sample panels: 

 Click Reset .   
 The following message appears, asking if you want to continue:  
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 Click Yes to clear the Master/ Sample images and the inspection results (if applicable) from the 
Master/ Sample panels.  

 Click No to retain the files in the Main View. 

 

4.3.2 Back/ Forward 

To retain inspection results and return to the Main View, so you can run additional inspections:  

 Click Back .  

To return to the Inspection View:  

 Click the same button, which has become Forward .  

 

4.3.3 Cancel Inspection  

To cancel an inspection: 

 Click Cancel Inspection on the pop-up Progress window as the inspection is running. 

 

 

Progress Window 

4.4 Reviewing and Proofing 

4.4.1 Navigating Differences 

 Use the track wheel or Master/ Sample Marquee Zoom  in the Inspection View to zoom in or 
out of the image. 

 Hold the left mouse button and move it around to pan the image. 
 To review multiple pages, navigate through them at the bottom left of the Inspection View. 
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Page Navigation 
 

 Select a specific difference (where applicable) and highlight it in the Inspection View by clicking 
its corresponding number in the Difference List in your layout. The difference gets highlighted in 
the Inspection View. 
NOTE: Ensure Automatically zoom to each difference is checked in the Preferences window 
(under Menu) to zoom in to individual differences once you select them as well. 

 Review differences in repeats (where applicable) by clicking the corresponding repeat in the 
Repeats found Difference 
List. 

 For more information on your layout and the different panels applicable to the inspection being 
-section in the corresponding, subsequent chapter. 

 

4.4.2 Reviewing Differences 

 Select a difference (where applicable) by clicking it in the Difference List in your layout to assign 
levels (i.e., Critical, Major, Minor) and comments to it. For more information on assigning levels 
and comments to differences, see the corresponding section on the Difference List and 
Difference Details panel in the Graphics Inspection, Text Inspection, Spelling Inspection, or 
Color Inspection chapters. 

 Navigate to the next difference by pressing the DOWN ARROW  key, pressing the F11 key, or 
by clicking Include in the Difference Details panel. Pressing the F12 key or clicking Exclude 
also navigates to the next difference but excludes the initial one from the report. 

 Navigate to the previous difference by pressing the UP ARROW  key or clicking it. 

 

4.5 Generating Reports 

The following section describe the steps involved with generating a report, which is the culmination of the 
inspection process.  
NOTE: Multiple inspections can be combined into one report. Whatever inspections have been run and 
have not been specifically excluded appear in the generated PDF. 

To generate a report:  

 Click Report . The Report Options window displays. 
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Report Options Window 
 

 Fill in the Report Options window where applicable.  

NOTE: The Inspected By field is pre-populated with the user name and no modifications are 
allowed. All other fields, except Status, which must be modified from the Select Status default, 
are optional. 
 

REPORT OPTIONS  ACTION 

Product ID Enter the Product ID; The Report File Name below 
automatically reflects the entered value 

Product Name Enter the Product Name 
Inspected By No action required; The field is automatically populated 

with the name of the user who performed the inspection 
Status Select Pass/ Fail (required) 
Lot Enter the Lot Number; The Report File Name below 

automatically reflects the entered value 
Levels to include Only differences with levels matching selection(s) are 

 
Only pages/repeats with 
differences 

Check to include only the pages or the repeats that have 
at least one difference 

Master Check to include the Master image (where applicable)  
Signature field Check to include the signature field (Performed By, 

Reviewed By fields) in the report; Automatically included 
when the licensed option to Enable Electronic 
Signatures in the Settings window has been selected by 
an administrator 

Thumbnails Check to include thumbnails of each difference 
(Graphics, Text, and Spelling Inspection only) 

Report Path Select where the report gets saved 
Report File Name Set the name of the report to be saved 
PDF Attachment Browse for and attach a PDF to the report 
Comments Enter general comments to be included in the report  
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 Click View or Save. If a status has not been selected, the following message displays: 

 

 

 
 Click Pass or Fail to set the inspection status. Click Cancel to return to the Report Options 

window. 
 If the licensed option to Enable Electronic Signatures has been checked by your administrator 

in the Settings window (via the Menu ), the Electronic Signature window displays. 

 

 

Electronic Signature Window 
 

 Fill in the User Name and Password fields (as you would to log in) and click Sign. Click Cancel 
to return to the Report Options window. 

 If Save had been selected in the Report Options window, the report is saved in the selected (or 
default) report path. 

 If View had been selected, the report saves in the selected (or default) report path and displays in 
the default PDF reader. All inspections are included in the report (if applicable). 
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5 Graphics Inspection 

Graphics Inspection Mode lets you compare single or multi-page master and sample files pixel by pixel 
and detect differences in text and artwork. Differences are highlighted and levels and comments on each 
can be added for more of an in-depth proofing and reviewing process. The following sections describe the 
inspection process.  

 

5.1 Step-by-Step 

This section describes the steps to follow when running a graphics inspection. 

1. Load Electronic Files (Skip to No. 2 to Load Scanned Files) 

A. For Single-Page Inspections: 

 Click File Menu  > Load Master or click in the Master panel to launch the load-file window.  
  

 Select the Master file from the load-file window and click Open.     
 If the Master is a BMP, PNG, TIF, TIFF, JPG, or LEN file, the image loads in the Master panel.   
 If the Master is a PDF or AI file: 

 Prepare the Master image, if required, using integrated PDF Viewer tools to hide layers and/ 
or separations, use shapes as regions for repeat detection, etc. See Section 3.6 PDF Viewer 
for more details. 

 Click File Menu  > Load Sample or click in the Sample panel to start repeating the process 
to load the Sample file. 

B. For Multi-Page Inspections: 

 Click File Menu  > Load Master or click in the Master panel to launch the load-file window.  
  

 Select the Master file from the load-file window and click Open.     
 The first page of the Master image loads in the Master panel. The others can be selected from 

the Page Navigation drop-down list at the bottom of the panel. 
 If the Master is a PDF or AI file: 

 Prepare the Master image, if required, using PDF Viewer tools to hide die lines, layers 
and/ or separations, use shapes as regions for repeat detection, etc. See Section 3.6 PDF 
Viewer for more details. 

 Click File Menu  > Load Sample or click in the Sample panel to start repeating the process 
to load the Sample file(s). 

2. Load Scanned Files (Skip Over if Electronic Files Loaded) 

 Click Load from Scanner  > Select Source.   
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 Select the applicable scanner from the Scanner Selection window and click Select.  

 

 

Scanner Selection Window 
 

 Click Load from Scanner  > Scan Master to scan the Master document. Once scanned, the 
image loads in the Master panel.   

 Click Load from Scanner  > Scan Sample to scan the Sample document. Once scanned, 
the image loads in the Sample panel.   

3. Ensure the Proper Inspection Area Is Selected  

 Use master/ sample tools to crop, rotate the image, etc. Make sure the appropriate Region Mode 
is selected. See Section 3.3.9 Region Mode for more information. 

4. Select the Graphics Inspection Mode Icon  

5. Select an Action 

 

 

 
 

Action Drop-Down Menu 
 

To compare a single master page to a single sample page or press sheet: 

 Set Action > Single Page.  

To compare all master pages or files to all sample pages or files: 

 Set Action > All Pages. 
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NOTE: The pages must be in order to allow for comparison. Repeats per page are not supported. 

To compare all master pages or files to all sample pages or files when they are in a different order:  

 Set Action > All Pages Unsorted. 
NOTE: Repeats per page are not supported. 

To compare a single-page master file to a multi-page sample file with repeats: 

 Set Action > Single to Many. 
NOTE: This is useful for comparing a batch of press sheets against the Master or checking 
the number of instances the Master appears on the Sample side. 

To compare unsorted multi-page master files to unsorted multi-page sample files with repeats: 

 Set Action > Many to Many. 
NOTE: This is useful for comparing batches and for ganged sheets. This action requires the 
most memory. 

To compare two individual full pages/ press sheets against one another without looking for repeats to 
speed up the inspection process: 

 Set Action > One to One. 

6. Select Profile 

 Click Profile. 
 Select the profile that best suits your inspection needs to detect the required differences from the 

drop-down menu. Alternative profiles may be created. See the Administration Guide for more 
details. 

 

 
Graphics Inspection Profiles 

 

The following default profiles are installed with the system: 

PROFILE FILE TYPES (MASTER AND SAMPLE) 

Digital to Scan Electronic original artwork and a scanned image 

Digital Electronic original artwork and a revised copy 

Len Run Length Encoding bitmap file and a Run Length Encoding bitmap file 

Proof Electronic original artwork and a digital proof 

Scan to Scan  Scanned image and a scanned image 
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7. Run the Inspection 

 Click . The images are inspected and the differences display in the Inspection View 
Sample panel. 

 

 

Inspection View Sample Panel 
 

  

Repeat #2 Selected in Repeats Found Panel 

Repeats 
Found 
Panel  

Differences 
for Repeat 

#2 
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8. View the Results 

To view the inspected image or file: 

 Use the track wheel to zoom in or out of the Master or Sample panels. 
 Hold the left mouse button and move it around to pan the image. 
 To review multiple pages, navigate through them using the Page Navigation drop-down list at 

the bottom left of either panel. 

 

 
Page Navigation 

 

To view a repeat: 

 Click the desired repeat in the Repeats found panel in your layout. Repeats with differences are 
highlighted in red. Repeats without differences are highlighted in green. For more information on 
layouts and the different panels available, see Section 5.4 Layouts. 

There are several ways to view differences. 

 Click the Image to display  drop-down menu. 

 

 

 

 Click Flash to alternately display the differences between the Master and Sample images. To 
change the rate at which the images alternate:  

 Click Increase Flash Rate  to increase the rate.   

 Click Decrease Flash Rate  to decrease the rate.    
 Click Master to display the Master image. 
 Click Sample to display the Sample image. 
 Click Difference to display the Difference image. 
 Click Edge to display the Edge Difference image. 

9. Review and Proof the Differences 

To select a difference: 

 Click on the difference in the Difference List. It gets highlighted in the Inspection View and 
outlined in red in the Overview panel. A checkmark gets added in the Difference List to indicate 
it has been reviewed. 
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Difference #3 Selected 
 

There are three ways to assign a level to a difference: 

 Select the difference in the Difference List. Click in the Level column beside the difference in the 
same panel and select the level. The color-coded level displays to the right of the difference. 

 Select the difference in the Difference List. Click the Level drop-down list in the Difference 
Details panel and select the level. The color-coded level displays to the right of the difference in 
the Difference List. 
NOTE: Hot keys (F1  F5) may be applied to assign levels. Select the difference and click the 

 
 

KEY FUNCTION 

F1 Reporting level - Critical 

F2 Reporting level - Major 

F3 Reporting level - Minor 

F4 Reporting level - Ignore 

F5 Reporting level  None 

 

Check Mark 
Added in 

Difference 
List 

Difference Highlightedin Inspection View 

Difference in 
Overview Panel 
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Level Assigned Using Difference Details Panel 
 

 Alternatively, double-click the difference in the Inspection View. The Difference window displays. 
Click the Level drop-down list in the Difference window and select the level. Click X to close the 
Difference window. The color-coded level displays to the right of the difference in the Difference 
List.  

 

  

Level Assigned Using Difference Window  

Level 

Assigned 

Level Drop-
Down List 

Difference List 

Difference Window 
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To assign a level to multiple differences: 

 Hold down the CTRL key while selecting the differences. 
 Click the Level column in the Difference List or the Level drop-down list in the Difference 

Details panel, and select the level. 
NOTE: On a Mac operating system, to assign a level to multiple differences, hold down the 
COMMAND and SHIFT keys while selecting the differences. 

To remove a level assignment:  

 Select None Difference List.     

There are two ways to assign a pre-defined comment to a difference: 

 Select the difference in the Difference List. Click the Comments drop-list in the Difference 
Details panel and select the comment. The comment displays in the Comments text box. A 
sticky-note icon displays in the Difference List to the right of the difference.  

 

  

Pre-Defined Comment Assigned to Difference #2 
 

 Alternatively, double-click the difference in the Inspection View. The Difference window displays. 
Click the Comments drop-down list in the Difference window and select the comment. Click X to 
close the window. The comment displays in the Comments text box. A sticky-note icon displays 
in the Difference List to the right of the difference. 

To assign a comment to multiple differences: 

 Hold down the CTRL key while selecting the differences, click the Comments drop-down list, and 
select the comment. 
NOTE: On a Mac operating system, to assign a comment to multiple differences, hold down the 
COMMAND and SHIFT keys while selecting the differences, click the Comments drop-down box, 
and select the comment. 

Comments 
Drop-Down List 

to Difference #1  
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There are two ways to assign a customized comment to a difference: 

 Select the difference in the Difference List, click the Comments drop-down list in the Difference 
Details panel, and type in the comment. A sticky-note icon displays in the Difference List to the 
right of the difference.    

 Alternatively, double-click the difference in the Inspection View. The Difference window displays. 
Click in the Comments text box in the Difference window and type in the comment. Click X to 
close the Difference window. The comment displays in the Comments text box. A sticky-note icon 
displays in the Difference List to the right of the difference. 

To delete a comment from a difference:  

 Click in the Comments drop-down box in the Difference Details panel and select the blank 
entry.  

To include the selected difference in the report:  

 Press F11 
 Or click Include in the Difference Details panel 

To exclude the selected difference in the report: 
 See Section 5.3.6.3 Exclude Differences. 

To add a difference: 

 See Section 5.3.6.2 Add Differences. 

To group differences: 

 See Section 5.3.6.1 Group Differences. 

10. Include Inspections in Report 

The Application lets you rename inspections and/ or exclude them from the report. This option is available 
under the Inspections panel. 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel. 
 Click Rename.  
 Enter the desired name and click OK. 
 The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel. 
 Click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 

 

 
 The inspection is not included in the next generated report. 
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NOTE: For more information on layouts and the panels available to you, see Section 5.4 Layouts. 

11. Generate the Report 

 Click the Report  icon. 
 See Section 4.5 Generating Reports for step-by-step instructions. 

12. Retain Inspection Results and Run a New Inspection  

 Click Back . The Main View displays with the Master and Sample images loaded.   
 To load new files, follow the steps above. 
 If required, prepare the Master/ Sample images for inspection using Master/ Sample tools to crop, 

rotate the image, etc. Make sure the appropriate region is selected. See Section 3.3.9 Region 
Mode. 

 Click . The images are inspected and the differences display in the Inspection View 
Sample panel. Each subsequent retained inspection gets listed in the Inspections panel. 

13. Clear Inspection Results and Run a New Inspection  

 Click Reset . The following message displays: 

 

 

 

 Click Yes to clear the inspection results and documents. The Main View displays with the profile 
on the title bar.   

 

5.2 Master Toolbar 

The Master toolbar appears at the top of the Master panel following an inspection: 

 

 

Master Graphics Inspection Toolbar 

5.2.1 Rotate 

To rotate the Master image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

79 of 214  12 Jun 2020 

5.2.2 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the Master image:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 

 

  

Color Inspector Window 
 

5.2.3 Show the Text Mask 

To see what was detected as text during the inspection:  

 Click Show the text mask . 
NOTE: The masked content represents all that which is affected by the parameters under the 

Text tab. See Appendix 12.1 Profiles for a list of all applicable 
settings. 
 

 

Show the Text Mask 
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5.2.4 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the crosshairs that appear and left button of your mouse 

 Or scroll upward with the track wheel. 

To reduce the magnification:    

 Place the cursor in the Master panel. 
 Scroll downward with the track wheel.  

To pan: 

 Left-click in the Master panel. Hold and move the mouse around the panel.   

 

5.2.5 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 

5.2.6 Save View 

To save an image to a file: 

 Click Save View . The Save As window displays with the file type .tif as the default.   
 Select the desired file type and storage location and click Save. 

 

5.3 Sample Toolbar 

The Sample toolbar appears at the top of the Sample panel following an inspection: 

 

 

Sample Graphics Inspection Toolbar 

 

5.3.1 Set Repeat as Master 

Set Repeat as Master  appears only if repeats are detected in the Sample file(s). This option is used 
to select one of the repeats as the Master (Golden Master) and compare it against the others. 

To set a repeat as the Master:   

 Click the repeat in the Repeats found panel. For more information on the different panels 
available to you in your layout, see Section 5.4 Layouts. 
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 Click Set Repeat as Master . The Profile Selection window displays. 

  

 

Profile Selection Window 
 

 Select the required profile from the Profile Selection window and click OK. A new inspection 
runs and compares the loaded Sample image to the selected repeat as the new Master (Golden 
Master).   

 

5.3.2 Increase Flash Rate 

To change the rate at which the differences between the Master and Sample images alternate:  

 Click Increase Flash Rate  to increase the rate.   

 Click Decrease Flash Rate  to decrease the rate.    

 

5.3.3 Image to Display 

The Image to Display  drop-down list lets the user toggle between different images in the Inspection 
View Sample panel. The default is the Flash image. 

 

 

Image to Display Drop-Down Menu 
 

5.3.3.1 Show Master Image 

To display only the Master image in the Inspection View Sample panel: 

 Click the Image to Display  icon. 
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 Select Master from the drop-down list. 

 

 \  

Show Master Image 
 

5.3.3.2 Show Sample Image 

To display only the Sample image in the Inspection View Sample panel:  

 Click the Image to Display  icon. 
 Select Sample from the drop-down list. 

 

  

Show Sample Image 
 

Show 
Master 
Image 

Show 
Sample 
Image 
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5.3.3.3 Show Difference Image 

To display only the differences in the Inspection View Sample panel:  

 Click the Image to Display  icon. 
 Select Difference from the drop-down list. 

 

  

Show Difference Image 
 

To display the difference image in a higher contrast (i.e., each difference in yellow against a blue 
background), surrounded by a red box:   

 Click File Menu  > Preferences to open the Preferences window.   
 Click the Hi-Contrast Difference Image checkbox under User Interface. 
 Click OK to close the Preferences window.  

NOTE: You need to re-run the inspection for the High-Contrast Difference Image change to 
take effect.  

 

Show 
Difference 

Image 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

84 of 214  12 Jun 2020 

  

High-Contrast Difference Image 

 
 

        

              Difference #3  with High Contrast                    Difference #3  Without High Contrast 
 

5.3.3.4 Show Edge Image 

To display only the edge differences in the Inspection View:  

 Click the Image to Display  icon. 
 Select Edge from the drop-down list. Each difference displays against a gray background, 

surrounded by a red box.     
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Show Edge Image 
 

5.3.4 Show Mask 

The Show Mask  drop-down menu lets the user toggle the mask and difference IDs (numbers and/ or 
boxes) on or off. 

 

 

Show Mask Drop-Down Menu 
 

5.3.4.1 Show Mask 

Show Mask toggles the mask on or off to isolate the differences or show them in context of the image.   

 

Show Edge 
Image 
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                    Show Mask On                                               Show Mask Off 
To toggle the mask on or off: 

 Click the Show Mask  icon. 
 Select Mask from the drop-down list. 

To change the mask color:    

 Click File Menu  > Preferences. The Preferences window displays.   
 Click Select beside Mask Color. The Mask Color window displays. 

 

 

Mask Color Window 
 

 Select the desired color and click OK to close the Mask Color window. 
 Click OK to close the Preferences window. 

NOTE: You need to return to re-run the inspection for the new mask color to take effect.  

 

5.3.4.2 Show Boxes 

Boxes is found under the Show Mask  icon and lets the user toggle between displaying/ not 
displaying boxes around the differences. 
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                                 Show Boxes On                  Show Boxes Off 
   

To toggle the difference boxes on and off: 

 Click the Show Mask  icon. 
 Select Boxes from the drop-down list. 

 

5.3.4.3 Show Numbers 

Numbers is found under the Show Mask  icon and lets the user toggle between displaying/ not 
displaying difference IDs next to the differences.   

 

                                        

   Show Numbers On (w/ Show Boxes Off)             Show Numbers Off 
 

To toggle the difference numbers on and off: 

 Click the Show Mask  list. 
 Select Numbers from the drop-down menu. 

 

5.3.5 Rotate 

To rotate the Sample image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 
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5.3.6 Difference Review Actions 

The Difference Review Actions  drop-down list lets the user manage the differences detected, by 
grouping/ excluding them or adding new ones. 

 

5.3.6.1 Group Differences 

 Click the Difference Review Actions  icon and then Group.  
 Use the crosshairs that appear to select the differences to be grouped by left-clicking and drawing 

a red box around them. A difference ID gets assigned to the group, which is added to the 
Difference List as a change. The difference count also adjusts accordingly. 
NOTE: The new difference is automatically included in the report. To exclude it, click Exclude. 

 
Yes to add the grouping to all repeats. Click No to add the grouping to the 

selected repeat only.  
 

                

         Differences #2 and #3 Before Grouping        After Grouping - Difference #17 Created 
 

5.3.6.2 Add Differences 

To add a difference to the inspection results: 

 Click the Difference Review Actions  icon and then Add.   
 Use the crosshairs that appear to select the area in the Inspection View to be added as a 

difference by left-clicking and drawing a red box around it. The selected area gets added as the 
final difference in the Difference List. 
NOTE: The added difference is automatically included in the report. To exclude it, click Exclude. 

 
Yes to add the difference to all repeats. Click No to add the difference to the 

selected repeat only. 
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                       Before Add Difference                                     After Add Difference 
 

5.3.6.3 Exclude Differences 

To exclude a reviewed and included difference: 

 Click the Difference Review Actions  icon and then Exclude.   
 Use the crosshairs that appear to select the difference in the Inspection View Sample panel to be 

excluded by left-clicking and drawing a red box around it. The difference gets crossed out in the 
Difference List and excluded in the report. 
NOTE: You can alternatively select the difference in the Difference List and click Exclude. 
However, an administrator can configure the Application to force the inclusion of all differences, in 
which case the Exclude and Include options do not display in the Difference Details panel. 

 For repeats, once you select the difference to be excluded as a difference, a message displays: 
Yes to exclude the difference in all repeats. Click No to exclude the 

difference on the selected repeat only. 

 

 

Difference Details Panel - 
Include and Exclude Options Removed 

 

5.3.7 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the Sample image:  

 Click the Color Inspector .  

17Differenc
es 

18 
Differences 

Added 
Difference 

Include and 
Exclude 
Options 

Removed 
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 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 
color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 
 

  

Color Inspector Window 
  

5.3.8 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the crosshairs that appear and the left button of your mouse 

 Or scroll upward with the track wheel. 
 

To reduce the magnification:    

 Place the cursor in the Sample panel. 
 Scroll downward with the track wheel.  

To pan: 

 Left-click in the Sample panel. Hold and move the mouse around the panel.   
 

5.3.9 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

91 of 214  12 Jun 2020 

5.3.10 Save View 

To save an image to a file: 

 Click the Image to Display  icon in the Sample toolbar and then choose either the Master, 
Sample, Difference, or Edge image. To save the view in the Master panel skip this step. 

 Click Save View  in either the Master or Sample toolbar. The Save As window displays with 
the file type .tif as the default.   

 Select the desired file type and storage location and click Save. 
NOTE: The Flash Image cannot be saved.   

 

5.4 Layouts  

5.4.1 Creating a Layout 

The Inspection View contains panels that let you review the graphics inspection results and add levels 
and comments to differences. These panels constitute your layout and can be displayed or hidden as 
required. For example, if your images do not have repeats, you may want to hide the Repeats found 
panel. Layout customization is ideal for multi-monitor configurations, as panels can be placed on separate 

displays. To view the different layout panels that can be loaded, click Menu  > Layout.  

 

 

Layout Drop-Down Menu (Graphics Inspection) 
 

To display/ hide the panels:     

 Uncheck the panel name in the Layout drop-down menu or click the X in the top-right corner of 
the panel once it has been loaded to hide it.  

 Check the name of a hidden panel in the Layout drop-down menu to display it. 

To move a given panel: 

 Click its title bar, hold down, and shift it to one of the empty areas in the margins of your screen.  

To save your layout so that it re-appears as is upon closing and re-opening the Application:  

 Click Save Layout. 

To reset your layout to the default: 

 Click Reset Layout. 
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5.4.2 Overview Panel 

The Overview panel displays the original Sample image. The difference that is selected is located at the 
intersection of the two red lines. 

To zoom in or out of the Sample image in the Overview panel:  

 Slide the button in the middle of the bar accordingly. 

 

 

Overview Panel 

5.4.3 Repeats Found Panel 

The Repeats found panels lists the number of repeats of the Master image that were found in the 
Sample file after the inspection has been run. Repeats with differences display a red icon to the left. 
Repeats without differences display a green check mark to the left instead. 

To navigate between repeats: 
 Click the desired number on the list. 
 The selected repeat appears in the Inspection View Sample panel. 

 

 

Repeats Found Panel 
 

5.4.4 Difference List and Details Panels 

The Difference List displays the differences between the Master and Sample images for easy reviewing 
and proofing. The Difference Details panel lets you assign comments and levels to selected differences 
and include or exclude them from your report. 

To select a difference: 

 Click it in the Difference List. It gets highlighted. The corresponding difference gets highlighted in 
the Inspection View Sample panel. 

To assign a level to the difference:  

 Select a level in the Level drop-down list in the Difference Details panel 
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 Or click in the Level column beside the difference in the Difference List. 
 The level appears beside the difference in the Difference List. 

 

 

Level Column in Difference List 
 

To assign a comment to a difference:  

 Select a comment in the Comments drop-down box or type in a custom comment.  
 A sticky-note icon displays in the Difference List to the right of the difference, signifying the 

presence of a comment.   

 

 

Comments Drop-Down List 
 

To exclude the difference from the report, assuming Force inclusion of all differences (see Section 
5.3.6.3 Exclude Differences) has not been checked: 

 Click Exclude.  
 The difference gets crossed out in the Difference List and the next difference then gets selected. 

To cancel the exclude, select the difference again and click Include (F11).   

To navigate to the next difference: 

 Click Include, 
 Or press the F11 key,  
 Or click on the desired difference in the Difference List, 
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 Or press the DOWN ARROW  key. In each case, the difference gets included in the report. 

To navigate to the previous difference: 

 Press the UP ARROW  key.  

 

5.4.5 Inspections Panel 

The Inspection View contains the Inspections panel, which lists completed inspections. For example, 
you may run multiple inspections prior to generating the report. The Application lets you rename the 
inspections and/ or exclude them from the report. 

 

 

Inspections Panel 
 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel. 
 Click Rename.  
 Enter the desired name and click OK. 
 The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel. 
 Click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 

 

 
 

 The inspection is not included in the next generated report. 
 

5.4.6 Master Panel 

Unchecking Master Panel in the Layout drop-down menu hides it from view. The Sample panel takes up 
the entire Inspection View area as a result. To make the Master re-appear, simply check it again. It is 
checked by default.  
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6 Barcode Inspection 

This chapter describes the process for inspecting files containing barcodes. Barcode Inspection Mode 
detects and grades barcodes, displaying details like decodability, magnification, quiet zones, etc. See 
Section 6.3.3 for information on each individual barcode parameter. Digimarc barcodes, which consist of 
embedded barcode information in enhanced packaging, are supported through a separate licensed 
module. Only administrators can create custom profiles that enable the feature or additional parameters 
like grade output format (letters vs. numbers). For more information, see the Administration Guide. 

 

6.1 Step-by-Step 

This section describes the steps to follow when running a barcode inspection. 

1. Load Electronic Files (Skip to No. 2 to Load Scanned Files) 

To inspect barcodes in a master file: 

 Click File Menu  > Load Master or click in the Master panel to launch the load-file window.  
  

 The Master image loads in the Master panel. 
 If the file is a PDF:  

 The integrated PDF Viewer displays (see Section 3.6 PDF Viewer). 
 Prepare the Master image using the PDF Viewer tools, if required.  

 Click  and the results display in the Inspection View.   
To inspect barcodes in a sample file: 

 Click File Menu  > Load Sample or click in the Sample panel and follow the same steps as 
above. 

2. Load Scanned Files (Skip Over if Electronic Files Loaded) 

 Click Load from Scanner  > Select Source.   

 

 

 
 Select the applicable scanner from the Scanner Selection window and click Select.  
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Scanner Selection Window 
 

 Click Load from Scanner  > Scan Master to scan the Master document. Once scanned, the 
image loads in the Master panel.   

 Click Load from Scanner  > Scan Sample to scan the Sample document. Once scanned, 
the image loads in the Sample panel.   

3. Select the Barcode Inspection Mode Icon  
4. Select an Action 

 

 

Action Drop-Down Menu 
 

To inspect a master file for barcodes: 

 Click Action > Inspect Master (for masters placed in the Master panel). 

To inspect a sample file for barcodes: 

 Click Action > Inspect Sample (for samples placed in the Sample panel). 

To inspect multi-page files or multiple files for barcodes: 

 Click Action > Inspect Master (All Pages) (for masters placed in the Master panel).  
 Click Action > Inspect Sample (All Pages) (for samples placed in the Sample panel). 

5. Select Profile 

 Click Profile. 
 Select the profile that best suits your inspection needs from the drop-down menu. 

 

 
Barcode Inspection Profiles 
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The following default profiles are installed with the system:  

PROFILE DESCRIPTION 

Default 
Inspect master or sample files with barcodes in horizontal or vertical 
orientations 

Rotated 
Inspect master or sample files with rotated barcodes; Detection speed is 
slightly slower 

6. Run the Inspection 

 Click  and the results display in the Inspection View. 

7. Review 

 To navigate to a barcode, click on the barcode in the Barcodes found panel in the Inspection 
View. The Barcode Details panel displays its parameters and grades/ values.  

 

 

Barcodes Panel 
 

 
Barcode Details Panel 
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 An overall (average) grade is determined for the barcode based on the values of the individual 
parameters. These grades appear in the Barcode Details panel. For more details on each of the 
available panels, including individual parameters and grades see Section 6.3 Layouts. 

 
lines (instead of the average). 

NOTE: The Barcode Scan Grid appears only when 1D (linear) barcodes are inspected; The 
grades can be set to appear as numbers or letters. Letters is the default setting, while the Grade 
output format must be set to Numbers in the selected Barcode Inspection profile. Standard 
users cannot create a new profile with the changed setting. Consult the Administration Guide for 
more information. 

 

   

Inspection View 
 

 Use the track wheel to zoom in or out of the image. 
 Hold the left mouse button and move it around to pan the image. 
 To review multiple pages, navigate through them at the bottom left of the Inspection View. 

 

 

Page Navigation 

8. Include Inspections in Report 

The Application lets you rename inspections and/ or exclude them from the report after having conducted 
several. This option is available under the Inspections panel. 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel. 

 

Overview 
Panel 

Inspections 
Panel 

Barcodes 
Found 
Panel 

Barcode 
Details 
Panel 

Barcode 
Scan Grid 
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Inspections Panel 

 

 Click Rename, enter the desired name, and click OK. 
 The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel. 
 Click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 
 The Inspection is not included in the next generated report. 

NOTE: For more information on layouts and the panels available to you, see Section 6.3 Layouts. 

9. Generate the Report 

 Click the Report  icon. 
 See Chapter 4.5 Generating Reports for step-by-step instructions. 

NOTE: If Digimarc support is enabled, all information regarding that aspect of the inspection is 
found appended to the PDF report. No other action is required on the part of the user.  

10. Clear Inspection Results and Run a New Inspection 

To retain inspection results and run a new inspection:  

 Click Back . The Main View displays the Master/ Sample image. 
 To load a new file to be inspected, follow the steps above. 

 To run a new inspection with the same files, click . 
 Once the inspection is completed, both it and the previous inspection get listed in the 

Inspections panel in your Inspection View.  

To clear inspection results and run a new inspection:  

 Click Reset . The following message displays, asking if you want to continue: 

 

 

 

 Click Yes to clear inspection results and documents. The Main View displays. 
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6.2 Inspection Toolbar 

The Barcode Inspection toolbar contains the following tools: 
 

 
Barcode Inspection Toolbar 

6.2.1 Rotate 

To rotate the Master/ Sample image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 

 

6.2.2 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the inspected image:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 
 

  

Color Inspector Window 
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6.2.3 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the crosshairs that appear and the left button of your mouse 

 Or scroll upward with the track wheel.  

To reduce the magnification:    

 Place the cursor in the Inspection View. 
 Scroll downward with the track wheel. 

To pan: 

 Left-click in the Inspection View. Hold and move the mouse around the panel.   

 

6.2.4 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 

6.2.5 Save View 

To save an image to a file: 

 Click Save View  on the toolbar. The Save As window displays with the file type .tif as the 
default.   

 Select the desired file type and storage location and click Save. 

 

6.3 Layouts  

6.3.1 Creating a Layout 

The Inspection View contains panels that let you review the barcode inspection results. These panels 
constitute your layout and can be displayed or hidden as required. Layout customization is ideal for multi-
monitor configurations, as panels can be placed on separate displays. To view the different layout panels 

that can be loaded, click Menu  > Layout.  

To display/ hide the panels:    

 Uncheck the panel name in the Layout drop-down menu or click the X in the top-right corner of 
the panel once it has been loaded to hide it.  

 Check the panel name to display it. 

To move a given panel: 

 Click its title bar, hold down, and shift it to one of the empty areas in the margins of your screen. 

To save your layout so that it reappears as is upon closing and re-opening the Application:  
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 Click Save Layout. 

To reset your layout to the default: 

 Click Reset Layout. 

 

6.3.2 Barcodes Found Panel 

To navigate to a barcode, click on the barcode in the Barcodes found panel in the Inspection View. The 
Barcode Details panel displays its parameters and the accompanying grades/ values. The barcode itself 
gets highlighted in the Inspection View. 

 

6.3.3 Barcode Details Panel 

When inspecting UPC or EAN barcodes, the Application determines whether a decoded value matches 
the Human Readable Value (through Optical Character Recognition; OCR). A match displays in green. A 
non- rtion meanwhile serves to list each of the selected 

information on how each parameter is graded, see Appendix 12.6.4 Grading Parameters. 

 

 

Barcode Details Panel  
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Barcode Parameters 
 

1D/ COMPOSITE BARCODE PARAMETERS 

Type Barcode type detected 

Grade 
Overall grade for the barcode; See the table below for a list of barcode 
grades 

Decodability 
Ease of barcode identification; The Application assigns a grade from A-F 
(100-0%) 

Magnification 
Percentage (+/- 10%) that a barcode has been magnified based on a 
starting point of 100%; Based on width to accommodate truncated barcodes 
and can vary from 80% to 200% except for Interleaved 2 to 5-type codes 

Symbol Contrast 
Difference in contrast between the darkest and the lightest parts of a 
barcode; The system assigns a grade from A-F (100-0%) 

Min Edge Contrast 
Minimum contrast between a space and its adjacent bars; The Application 
assigns a pass-or-fail grade (A or F) (100-0%) 

Modulation 
Ratio between symbol contrast and minimum edge contrast; The Application 
assigns a grade from A-F (100-0%) 

Defects 
Amount of discrepancies in the reflectance of a barcode; The Application 
assigns a grade from A to F (100-0%) 

Decode 
Determination of whether the barcode was generated correctly, with 
sufficient spacing between bars; The system assigns a pass-or-fail grade (A 
or F; 4 or 0) 

Min Reflectance 
Minimum reflectance value (darkest part of the barcode); The Application 
assigns a pass-or-fail grade (A or F) 

Max Reflectance 
Maximum reflectance value (the lightest part of the barcode); The 
Application assigns a rating from 100-0 

BWR 
Measure of the decrease in bar width needed to compensate for print gain; 
The Application assigns a measurement in mm 

Decoded Value Decoded value of the selected barcode 

Quiet Zone 
Blank margins bordering a barcode; The Application assigns a pass-or-fail 
grade (A or F; Left% and Right %) 

Data Structure 
Type of information that is embedded in the barcode; The Application 
analyzes applicable barcodes as either having valid (A) or invalid (F) data 
structures (GS1 data matrix and QR codes only) 

Narrow Bar 
Width of the narrow bars comprising the barcode in mm; Higher DPI values 
yield results that are more precise; The Application assigns a grade from A-
F 

Wide Bar 
Width of the wide bars comprising the barcode in mm; Higher DPI values 
yield results that are more precise; The Application assigns a pass-or-fail 
grade (A or F) 

Wide to Narrow Ratio 
Ratio that determines narrow and wide bar widths (NB: WB); The 
Application assigns a pass-or-fail grade (A or F) 

Gap 
Amount of space between the last black bar of one character and the first of 
another in mm; The Application assigns a pass-or-fail grade (A or F) 
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2D BARCODE PARAMETERS 

Type Barcode type detected 

Grade Overall grade for the barcode; See the table below for descriptions 

Symbol Contrast 
Difference in contrast between the darkest and the lightest parts of a 
barcode; The Application assigns a grade from A-F (100-0%) 

Modulation 
Ratio between symbol contrast and minimum edge contrast; The Application 
assigns a grade from A-F 

Decode 
Determination of whether the barcode was generated correctly, with 
sufficient spacing between bars; The Application assigns a pass-or-fail 
grade (A or F; 4 or 0) 

Axial Non-Uniformity 
Difference in length of the two axes of the barcode; The Application assigns 
a grade from A-F (0-100%) 

Grid Non-Uniformity 
Vector deviation of the barcode from an ideal position; The Application 
assigns a grade from A-F (0-100%) 

Fixed Pattern Damage Damage done to the pattern; The Application assigns a grade from A-F  

Unused Error 
Correction 

Amount of unused error correction embedded in the barcode; The 
Application assigns a grade from A-F 

Decoded Value Decoded value of the selected barcode 

BWR Horizontal 
Measure of the decrease in horizontal bar width needed to compensate for 
print gain; The Application assigns a measurement in mm 

BWR Vertical 
Measure of the decrease in vertical bar width needed to compensate for 
print gain; The Application assigns a measurement in mm 

Data Structure 
Type of information that is embedded in the barcode; The Application 

structures (GS1 data matrix and QR codes only) 

Cell Size 
Height and width of a cell comprising the data matrix (QR code); The 
Application assigns a measurement in mm  

Quiet Zone 
Blank margins bordering a barcode; The Application assigns a pass-or-fail 
grade (A or F; Left% and Right %) 

 
Barcode Grades 

GRADE COLOR DESCRIPTION 

A  
Overall grade of 3.5 or higher; The barcode should scan easily the first 
time with most barcode scanning equipment 

B  
Overall grade of 2.5 - 3.5; The barcode may scan easily the first time and 
there is a high probability of success if a second scan is performed 

C  Overall grade of 1.5 - 2.5; The minimum most barcodes should achieve 

D  Acceptable only if the barcode is printed on fiberboard 

F  Failing grade 

N/A  Verification grade of the barcode symbol is not supported 
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6.3.4 Inspections Panel 

The Inspection View contains the Inspections panel, which lists completed inspections. For example, 
you may run multiple inspections prior to generating the report. The Application lets you rename the 
inspections and/ or exclude them from the report. 

 

 

Inspections Panel 
 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel. 
 Click Rename.  
 Enter the desired name and click OK. 
 The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel. 
 Click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 

 

 

 
 The Inspection is not included in the next generated report. 

 

6.3.5 Overview Panel 

The Overview panel displays the image or inspection currently being viewed in the Inspection View. The 
selected barcode is located at the intersection of two red lines. 

To zoom in or out of the Sample image in the Overview panel:  

 Slide the button in the middle of the bar accordingly. 
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Inspections and Overview Panels  
(as They Appear when Inspecting 2D Barcodes, Without Barcode Scan Grid) 

 

6.3.6 Master Panel 

Toggling the Master Panel on/ off in the Layout drop-down menu shifts the file from appearing in the 
Sample panel (regardless of whether it is a master or sample being inspected) to it taking up the entire 
Inspection View. The latter is the default position.  

Overview 
Panel 

Inspections 
Panel 

Inspection Being 
Viewed in 

Overview Panel 
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7 Braille Inspection 

Braille Inspection Mode lets you inspect and translate single-carton Braile regions on separate master 
or sample files. The Application supports digital documents and scanned copies of files containing Braille 
of either plateau, dome, or bell dot types. Both frontside and backside scans are in turn supported, with 
Braille height information displayed following inspections of the former. 

NOTE: High-gloss samples may require an additional finish for the Application to properly support scans 
of them. 

There are four default actions (inspection types) available: 
 Translate Master inspects a loaded master file, providing a translation of its Braille and a list of 

measured parameters.  
 Inspect Braille Sample inspects a scanned sample file (frontside), providing a translation of its 

Braille and a list of measured parameters. Braille height information does display when a scanned 
sample is inspected. 

 Compare PDF to Scan (Backside) compares Braille regions detected on the scanned Sample 
(backside) against detected Braille regions on the loaded Master.  

 Compare PDF to Scan (Frontside) compares Braille regions detected on the scanned Sample 
(frontside) against detected Braille regions on the loaded Master. Braille height information does 
display in this scenario. 

The system marks individual Braille dots as missing or extra (Compare), while letting the user modify the 
translation by adding/ removing dots (Translate/ Inspect). See later steps in this section for more 
information. 
 

 

BRAILLE STANDARDS AND GUIDELINES 

 Master file must be original artwork in PDF, BMP, or TIFF format 

 Braille dots must be on top-most layer 

 Braille dots must be solid-filled 

 Braille dots must be a unique color 

 Braille dot spacing should follow Marburg Medium Standard 

 

7.1 Step-by-Step 

This section describes the steps to follow when running a Braille inspection. 

1. Load Master Files for Braille Translation (Skip to No. 2 for Sample Inspection) 

To inspect a file in the Master panel: 

 Click File Menu  > Load Master or click in the Master panel to select the file to load.  
 The Master image loads in the Master panel. 
 If the file is a PDF: 

- The integrated PDF Viewer displays (see Section 3.6 PDF Viewer).  
- Prepare the Master image using the PDF Viewer tools, if required.  

 If a file has multiple pages, ensure the one with the Braille regions displays prior to the inspection. 

2. Scan Sample Files for Braille Inspection (Skip to No. 3 for Comparison) 
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To inspect a file in the Sample panel: 

 Ensure Show Scanner Interface in the Preferences window is unchecked. For more information, 
see Section 3.14 Preferences. 

 Click Load from Scanner  > Select Source.   
 Select the applicable scanner from the Scanner Selection window and click Select.  

NOTE: Only scans made with the GlobalVision F2 are supported. Restart the Application for the 
Calibrate Scanner (Braille) option to appear at the bottom of the same menu. It is recommended 
to select Calibrate Scanner before making your first scan and whenever the device has been 
calibrated independently of the system. 

 Place the front side of the sample on the scanner. 

 Click Load from Scanner  > Scan Sample. 
 The Sample image loads in the Sample panel. 

3. Load/ Scan Files for Braille Compare (Skip to No. 4 if Files Already Loaded/ Scanned) 

To compare Braille in the Sample file against the Master file:  

 Click File Menu  > Load Master or click in the Master panel to select the file to be loaded.  
 The Master image loads in the Master panel. 
 If the file is a PDF: 

- The integrated PDF Viewer displays (see Section 3.6 PDF Viewer). 
- Prepare the Master image using the PDF Viewer tools, if required.  
- If the file has multiple pages, right-click on the Master page featuring the Braille regions in the 

Show Pages panel (see Section 3.5.8 Show Pages) and select Set as Digital Braille. 

 

 

Show Pages Panel 
 

 Ensure Show Scanner Interface in the Preferences window is unchecked. For more information, 
see Section 3.14 Preferences. 

 Click Load from Scanner  > Select Source.   
 Select the applicable scanner from the Scanner Selection window and click Select.  

NOTE: Only scans made with the GlobalVision F2 are supported. Restart the Application for the 
Calibrate Scanner option to appear at the bottom of the same menu. It is recommended to select 
Calibrate Scanner before making your first scan and whenever the device has been calibrated 
independently of the system. 

 Compare PDF to Scan (Backside) action) or frontside (for 
the Compare PDF to Scan (Frontside) action) on the scanner. 

 Click Load from Scanner  > Scan Sample to scan the Sample.   
 The Sample image loads in the Sample panel. 

4. Ensure the Braille Inspection Mode Icon  Is Selected 
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5. Select an Action 

 

Action Drop-Down Menu 
To translate a master file: 

 Click Action > Translate Master. 

To inspect a (scanned) sample file: 

 Click Action > Inspect Braille Sample. 

To compare Braille regions on a digital master to their counterparts on the backside of a Braille scan: 

 Click Action > Compare PDF to Scan (Backside). 

To compare Braille regions on a digital master to their counterparts on the frontside of a Braille scan: 

 Click Action > Compare PDF to Scan (Frontside). 

The settings for each action can be browsed by clicking Action > Settings. For default parameters, see 
Appendix 12.2 Braille Inspection Actions. Individual settings may be modified by users with administrative 
privileges, while additional actions can also be created. For more information see the Administration 
Guide. 

6. Select Language 

 Click the Profile drop-down menu to access . 
 Select the language that best suits your inspection needs from the drop-down menu. 

NOTE: See Section 12.4 Supported Braille Languages in the Appendix. 

7. Ensure the Proper Inspection Area Is Selected  

 Use master/ sample tools to crop, rotate the image, etc. See Sections 3.3 to 3.6 for more 
information. 

8. Run the Inspection 

 Click  for the results to display in the Inspection View. 

9. View Differences 

 Use the track wheel to zoom in or out of the image. 
 Hold the left mouse button and move it around to pan the image. 
 To review multiple pages, navigate through them at the bottom left of the Inspection View. 

10. Review the Differences 

 Click on the Braille region to be inspected in the Braille Regions found panel. It gets highlighted 
and displayed in the Inspection View. 
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Braille Inspection View 
 

 
 

 Dots follow the below legend: 

 

 

11. Modify the Dots (if Necessary) 

To add a Braille dot:    

 Select the Braille region in the Braille panel. 
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 CTRL-left-
modified in the Braille Details panel, highlighted in red. For more information on the Braille 
Details panel and the other available panels in your layout, see Section 7.6 Layouts. 

 

 

 
To remove a Braille dot:    

 CTRL-left-click on the extra dot in the Inspection View. A black "-" displays in the dot and the 
translation gets changed accordingly in the Braille Details panel, highlighted in red.  

 

  
 

To cancel the Braille dot modification:   

 CTRL-left-click on the dot. The added "+" or "-" is removed from the dot and the translation gets 
changed accordingly in the Braille Details panel with the highlight removed.     

Dot Added 
Modified 

Translation 

Dot 
Removed 

Modified 
Translation 
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12. Include Inspections in the Report 

The Application lets you rename inspections and/ or exclude them from the report after having conducted 
several. This option is available under the Inspections panel. 

NOTE: For more information on layouts and the panels available to you, see Section 7.6 Layouts. 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel. 

 

 
Inspections Panel 

 
 Click Rename.  
 Enter the desired name and click OK. 
 The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel and click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 
 The Inspection is not included in the next generated report. 

13. Generate the Report 

 Click the Report  icon. 
 See Section 4.5 Generating Reports for step-by-step instructions. 

14. Clear Inspection Results and Run a New Inspection  

To retain inspection results and run a new inspection:  

 Click Back . The Main View displays the Master/ Sample image(s). 
 To load new files to be inspected, follow the steps above. 

 To run a new inspection with the same files, click . 
 Once the inspection is completed, both it and the previous inspection get listed in the 

Inspections panel in your Inspection View. 

To clear inspection results and run a new inspection:  

 Click Reset . A message displays, asking if you want to continue. 

 

 

 
 Click Yes to clear inspection results and documents. The Main View displays. 
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7.2 Braille Translation Toolbar 

The Braille Translation toolbar appears above the Inspection View once a Braille translation (Translate 
Master) has been run and contains the following tools: 

 

 
Braille Inspection Toolbar 

 

7.2.1 Rotate 

To rotate the Master/ Sample image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 

 

7.2.2 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the inspected file:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 

 

  

Color Inspector Window 
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7.2.3 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the crosshairs that appear and the left button of your mouse 

 Or scroll upward with the track wheel. 

To reduce the magnification:    

 Place the cursor in the Inspection View. 
 Scroll downward with the track wheel. 

To pan: 

 Left-click in the Inspection View. Hold and move the mouse around the panel.   

 

7.2.4 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 

7.2.5 Save View 

To save an image to a file: 

 Click Save View  on the toolbar. The Save As window displays with the file type .tif as the 
default.   

 Select the desired file type and storage location and click Save. 

 

7.3 Braille Inspection Toolbar 

The Braille Inspection toolbar appears above the Inspection View panel once a sample has been 
inspected (Inspect Braille Sample) has been run. It contains the following tools: 

 

 

Braille Inspection Toolbar 

 

7.3.1 Image to Display 

The Image to Display  drop-down list lets the user toggle between different images in the Inspection 
View Sample panel. The default is the Sample image. 
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Image to Display Drop-Down Menu 
 

7.3.1.1 Show Braille Surface Image 

To display only the Braille surface image, which filters out the similarities between the multiple scans of 
the sample that the GlobalVision F2 automatically makes, to accentuate the Braille: 

 Click the Image to Display  icon. 
 Select Braille Surface from the drop-down list. 

 

 

Show Braille Surface Image 
 

7.3.1.2 Show Braille Threshold Image 

To display only the Braille Threshold image, which brightens everything above the set Braille threshold (in 
the selected action) and darkens everything below (further accentuating the Braille):  

 Click the Image to Display  icon. 
 Select Braille Threshold from the drop-down list. 

 

 
Show Braille Threshold Image 

7.3.2 Rotate 

To rotate the Master/ Sample image: 
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 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 

7.3.3 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the inspected file:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 

 

  

Color Inspector Window 
 

7.3.4 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the crosshairs that appear and the left button of your mouse 

 Or scroll upward with the track wheel. 

To reduce the magnification:    

 Place the cursor in the Inspection View. 
 Scroll downward with the track wheel. 

To pan: 

 Left-click in the Inspection View. Hold and move the mouse around the panel.   

7.3.5 Reset View 

To restore the image to its original size:   
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 Click Reset View .  

 

7.3.6 Save View 

To save an image to a file: 

 Click Save View  on the toolbar. The Save As window displays with the file type .tif as the 
default.   

 Select the desired file type and storage location and click Save. 

 

7.4 Braille Compare Master Toolbar 

The Braille Compare Master toolbar appears above the Inspection View Master panel once a Braille 
comparison (Compare PDF to Scan) has been run. It contains the following tools: 

 

 

Braille Compare Master Toolbar 

 

7.4.1 Rotate 

To rotate the Master image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 

 

7.4.2 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the Master file:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 
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Color Inspector Window 
 

7.4.3 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the crosshairs that appear and the left button of your mouse 

 Or scroll upward with the track wheel.  

To reduce the magnification:    

 Place the cursor in the Master panel. 
 Scroll downward with the track wheel. 

To pan: 

 Left-click in the Master panel. Hold and move the mouse around the panel.   

 

7.4.4 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 

7.4.5 Save View 

To save an image to a file: 

 Click Save View  on the toolbar. The Save As window displays with the file type .tif as the 
default.   

 Select the desired file type and storage location and click Save. 
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7.5 Braille Compare Sample Toolbar 

The Braille Compare Sample toolbar appears above the Inspection View sample panel once a sample 
has been inspected (Compare PDF to Scan) has been run. It contains the following tools: 

 

 

Braille Inspection Toolbar 

 

7.5.1 Image to Display 

The Image to Display  drop-down list lets the user toggle between different images in the Inspection 
View Sample panel. The default is the Sample image. 

NOTE: Image to Display only appears as an icon on the Sample toolbar after Compare PDF to Scan 
(Frontside) inspections. 

 

 

Image to Display Drop-Down Menu 
 

7.5.1.1 Show Braille Surface Image 

To display only the Braille surface image, which filters out the similarities between the multiple scans of 
the sample the GlobalVision F2 makes, to accentuate the Braille: 

 Click the Image to Display  icon. 
 Select Braille Surface from the drop-down list. 

 

  

Show Braille Surface Image 
 

7.5.1.2 Show Braille Threshold Image 

To display only the Braille Threshold image, which brightens everything above the set Braille threshold (in 
the selected action) and darkens everything below (further accentuating the Braille):  

 Click the Image to Display  icon. 
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 Select Braille Threshold from the drop-down list. 

 

 
Show Braille Threshold Image 

 

7.5.2 Rotate 

To rotate the Master/ Sample image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 

7.5.3 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the inspected file:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 

  

7.5.4 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the crosshairs that appear and the left button of your mouse 

 Or scroll upward with the track wheel. 

To reduce the magnification:    

 Place the cursor in the Inspection View. 
 Scroll downward with the track wheel. 

To pan: 

 Left-click in the Inspection View. Hold and move the mouse around the panel.   
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7.5.5 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 

7.5.6 Save View 

To save an image to a file: 

 Click Save View  on the toolbar. The Save As window appears with .tif as the default type.   
 Select the desired file type and storage location and click Save. 

 

7.6 Layouts  

7.6.1 Creating a Layout 

The Inspection View contains panels that let you review the Braille inspection results. These panels 
constitute your layout and can be displayed or hidden as required. Layout customization is ideal for multi-
monitor configurations, as panels can be placed on separate displays. To view the different layout panels 

that can be loaded, click Menu  > Layout. 

To display/ hide the panels:     

 Uncheck the panel name in the Layout drop-down menu or click the X in the top right corner of 
the panel once it has been loaded to hide it.  

 Check the panel name to display it. 

To move a given panel: 

 Click its title bar, hold down, and shift it to one of the empty areas in the margins of your screen. 

To save your layout so that it re-appears as is upon closing and re-opening the Application:  

 Click Save Layout. 

To reset your layout to the default: 

 Click Reset Layout. 

 

7.6.2 Braille Regions Found Panel 

To navigate to a Braille region, click on it in the Braille panel. The Braille Details panel displays its 
translation and different parameters. The region itself gets highlighted in the Inspection View. 
 

 

Braille Panel 
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7.6.3 Braille Details Panel 

Braille Details panel for further review, with any differences 
between the Master and Sample files (during Braille Compare PDF to Scan inspections) highlighted. If 
one of the Braille Parameters appears in red, it has failed the ISO Standard 17351:2013 for dot diameter 
and spacing. 

 

 

Braille Details Panel 
 

The following table describes the individual parameters found in the Braille Details panel: 
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Braille Details 
Braille Region Region selected 
Language Language of translation 
Action Selected action of inspection 

Translation 

Translation of Braille in the selected language; When the Master 
and Sample files are being compared, separate Master/ Sample 
Translation fields display 
NOTE: Unrecognized Braille characters are represented by an 
underscor. 

Dots Number of dots 
Characters Number of characters 
Lines Number of lines detected 

Height Information (inspections w/ frontside scans only) 
Dot Type Type of dots detected (dome, bell, plateau) 
% Acceptable Percentage of detected dots above the set threshold (%) 

Mean Height Average height of detected dots (mm) 

Min/Max Height Minimum and maximum height of detected dots (mm) 
Standard Deviation Standard deviation in height of detected dots (mm) 

Braille Parameters 
Dot H Spacing Average horizontal spacing between dots (mm) 
Dot V Spacing Average vertical spacing between dots (mm) 

Character Spacing Average spacing between characters (mm) 

Word Spacing Average spacing between words (mm) 
Line Spacing Average spacing between lines (mm) 

 

7.6.4 Inspections Panel 

The Inspection View contains the Inspections panel, which lists completed inspections. For example, 
you may run multiple inspections prior to generating the report. The Application lets you rename the 
inspections and/ or exclude them from the report. 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel and click Rename.  
 Enter the desired name and click OK. The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel and click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 
 The Inspection is not included in the next generated report. 

 

7.6.5 Overview Panel 

The Overview panel displays the image or inspection currently being viewed in the Inspection View. The 
Braille region currently selected is indicated by the intersection of the two red lines. 

To zoom in or out of the image in the Overview panel:  

 Slide the button in the middle of the bar accordingly. 

 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

124 of 214  12 Jun 2020 

  

Inspections and Overview Panels 

7.6.6 Master Panel 

Toggling the Master Panel on/ off in the Layout drop-down menu has two effects. If you are comparing 
two files, the default is on. If it is toggled off when two files are being compared, instead of the Master and 
Sample appearing side by side, the inspected Sample appears across the entire Inspection View. 

If you are inspecting a master or sample alone, it appears in its Off position by default. Toggling the panel 
on/ off shifts the file from taking up the entire Inspection View to appearing in the Sample panel 
(regardless of whether it is a master or sample being inspected).   

Inspection Viewed 
in Overview Panel 

Inspections 
Panel 

Overview 
Panel 
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8 Text Inspection 

Text Inspection Mode lets you compare either left-to-right, right-to-left, or Asian copy in master and 
sample files whether they are digital or scanned in to the system (using OCR; See Section 3.3.5 Optical 
Character Recognition (OCR)). The Master and Sample can be two different file types laid out differently 
or with similar layouts (revisions).  

 

8.1 Step-by-Step 

This section describes the steps to follow when running a text inspection. 

1. Load Files for Text Inspection 

 Click File Menu  > Load Master or click in the Master panel to select the file to load.  
 The Master image loads in the Master panel. 
 If the file is a PDF: 

- The integrated PDF Viewer displays (see Section 3.6 PDF Viewer).  
- Prepare the Master image using the PDF Viewer tools, if required.  

 Click File Menu  > Load Sample or click in the Sample panel to start repeating the process to 
load sample files. 

2. Load Scanned Files (Skip Over if Electronic Files Loaded) 

 Click Load from Scanner  > Select Source.   
 Select the applicable GlobalVision scanner from the Scanner Selection window and click Select.  

 

 

Scanner Selection Window 
 

 Click Load from Scanner  > Scan Master to scan the Master document. Once scanned, the 
image loads in the Master panel.   

 Click Load from Scanner  > Scan Sample to scan the Sample document. Once scanned, 
the image loads in the Sample panel.   

2. Ensure the Text Inspection Mode Icon  Is Selected 

 Compare (All Pages) should be selected in the Action drop-down menu. 
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3. Select Profile 

 Click the Profile drop-down menu to access . 

 

 
Profile Drop-Down Menu 

 
The following default profiles are installed with the system: 

PROFILE FILE TYPES (MASTER AND SAMPLE) 

Different Layout (Cartons 
and Labels) 

Two electronic files with different layouts, like a Word doc and one 
featuring laid-out carton/ labels 

Different Layout (Inserts 
and Booklets) 

Two electronic files with different layouts, like a Word doc and one 
featuring a laid-out booklet/ insert 

QRD Two electronic files including a QRD template and a laid-out sample 

Same Layout (Revisions) Two electronic files sharing the same layout to be inspected for revision 
purposes (minor changes expected)  

4. Ensure the Proper Inspection Area Is Selected 

Use master/ sample tools to crop, rotate the image, etc. See Sections 3.3 to 3.6, including Sections 
3.3.5 and 3.4.5 Optical Character Recognition (OCR) in case of (a) scanned file(s). 

5. Run the Inspection 

 Click . The files are inspected and the differences display in the Inspection View. 
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Inspection View  

6. View the Results 

To view the inspected file: 

 Use the track wheel to zoom in or out. 
 Hold the left mouse button and move it around to pan the image. 
 To review multiple pages, navigate through them using the Page Navigation drop-down list at 

the bottom left of the Inspection View. 

 

 
Page Navigation 

 

7. Review and Proof the Differences 

To select a difference: 

 Click on the difference in the Difference List.  

 

 

Difference List 
 

 It gets highlighted in the Inspection View and displays in the Change Grid below the two panels. 
The characters in yellow in the Change Grid represent the differences between the Master and 
Sample panels. 
NOTE: Scroll over a character in the Change Grid to display its Unicode value. 
 

  
Change Grid 

Difference List 

Difference Highlightedin Inspection View 
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Difference #7 Selected 
 

 

Change Grid 
 

To assign a level to a difference: 

 Select the difference in the Difference List. Click the Level drop-down box and select the level. 
NOTE: Hot keys (F1  F5) may be applied to assign levels. Select the difference and click the 

 
 

KEY FUNCTION 

F1 Reporting level - Critical 

F2 Reporting level - Major 

F3 Reporting level - Minor 

F4 Reporting level - Ignore 

F5 Reporting level  None 

 

   

Level Drop-Down List 
 
To assign a level to multiple differences: 

 Hold down CTRL while selecting the differences, click the Level column, and select the level. 
NOTE: On a Mac operating system, to assign a level to multiple differences, hold down the 
COMMAND and SHIFT keys while selecting the differences, click the Level column, and select 
the level. 

To remove a level assignment:  

 Click the Level column and select None. The level no longer displays in the Difference List.     

To assign comment to a difference: 

 Select the difference in the Difference List. Click the Comment column and select one of the 
predefined comments that appear. The selected comment displays. Descriptors (or system 
comments) appear as the default for Change, Size, Font Type, Bold, Italic, Hyphen, Underline, 
Color, Line Break Space, and Sub/Super-type differences.  

Level Drop-
Down List 
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NOTE: Select System Comments in the drop-down to reset the default comment for that specific 
difference. 

To assign a comment to multiple differences: 

 Hold down the CTRL key while selecting the differences, click the Comment column, and select 
the comment. 
NOTE: On a Mac operating system, to assign a comment to multiple differences, hold down the 
COMMAND and SHIFT keys while selecting the differences, click the Comment column, and 
select the comment. 

To assign a customized comment to a difference: 

 Select the difference in the Difference List, click the Comment column, select Freeform, and type 
in the Comments text box in the Difference window that appears. Click OK for it to take effect. 

 

 

Difference Window 
To delete a comment from a difference:  

 Click in the Comment column in the Difference List and select None. 

To exclude a difference: 

 Select the difference in the Difference List and click F12.  
NOTE: An administrator can configure the Application to force the inclusion of all differences, in 
which case clicking F12 does not have an effect. 

8. Include Inspections in Report 

The Application lets you rename inspections and/ or exclude them from the report. This option is available 
under the Inspections panel. 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel. 
 Click Rename.  
 Enter the desired name and click OK. 
 The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel. 
 Click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 
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 The inspection is not included in the next generated report. 
NOTE: For more information on layouts and the panels available to you, see Section 8.4 Layouts. 

9. Generate the Report 

 Click the Report  icon. 
 See Section 4.5 Generating Reports for step-by-step instructions. 

10. Retain Inspection Results and Run a New Inspection  

 Click Back . The Main View displays with the Master and Sample images loaded.   
 To load new files, follow the steps above. 

 Click . The files are inspected and the differences display in the Inspection View. Each 
subsequent retained inspection gets listed in the Inspections panel. 

11. Clear Inspection Results and Run a New Inspection  

 Click Reset . The following message displays, asking if you want to continue: 

 

 

 

 Click Yes to clear inspections and documents. The Main View displays with the profile selected.   
 

8.2 Text Inspection Master Toolbar 

The Text Inspection Master toolbar appears above the Inspection View Master panel once a text 
inspection has been run. It contains the following tools: 

 

 

Text Inspection Master Toolbar 

 

8.2.1 Rotate 

To rotate the Master image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 

 

8.2.2 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the Master file:  
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 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 
 

8.2.3 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area with the crosshairs by left-clicking 

 Or scroll upward with the track wheel. 

To reduce the magnification:    

 Place the cursor in the Master panel. 
 Scroll downward with the track wheel. 

To pan: 

 Left-click in the Master panel. Hold and move the mouse around the panel.   

 

8.2.4 Reset View 

To restore the image to its original size:   

 Click Reset View .  

8.2.5 Save View 

To save an image to a file: 

 Click Save View  on the bar. The Save As window displays with .tif as the default file type.   
 Select the desired file type and storage location and click Save. 

 

8.3 Text Inspection Sample Toolbar 

The Text Inspection Sample toolbar appears above the Inspection View Master panel once a text 
inspection has been run and contains the following tools: 

 

 

Text Inspection Sample Toolbar 
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8.3.1 Resync Tool 

The Resync Tool  icon may be clicked to remove an undesired difference that is an identical match 
between the Master and Sample from the inspection results.  

To resync a difference: 

 Click the Underline Text  icon underneath the Master panel and click and drag the 
crosshairs to select the difference in question. The text gets underlined in blue. 
- Alternatively, right-click on the difference in the Difference List and choose Select on 

master in the menu that pops up. The text in question gets underlined in blue. 

 

 

 
NOTE: If there is a match on the Sample, it shows up in the Resync panel that appears. 
Clicking a match zooms in on that selection on the Sample to be highlighted. 

 

  
 

 Repeat either process for the Sample panel to highlight the same text. 

 Click the Resync Text  icon. 
 The difference is removed from the Difference List and the amount of differences detected are 

re-numbered. 
NOTE: If the differences are not identical, the difference type gets reclassified as Change and 
does not get removed; A resynched difference can also not be undone. The inspection must be 
rerun to get it back. 

To clear a selection: 

 Right-click on the text underlined in blue. 
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 Select either Clear, to clear the underline from the word, or Clear All, to clear all underlines, in 
the menu that pops up. 
 

8.3.2 Rotate 

To rotate the Master image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 

8.3.3 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the Sample file:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 

 

  

Color Inspector Window 
 

8.3.4 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area using the crosshairs that appear and the left button of your mouse 

 Or scroll upward with the track wheel. 

To reduce the magnification:    

 Place the cursor in the Sample panel. 
 Scroll downward with the track wheel. 

To pan: 
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 Left-click in the Sample panel. Hold and move the mouse around the panel.   

 

8.3.5 Reset View 

To restore the image to its original size:   

 Click Reset View .  

8.3.6 Save View 

To save an image to a file: 

 Click Save View  on bar. The Save As window displays with the file type .tif as the default.   
 Select the desired file type and storage location and click Save. 

 

8.4 Layouts  

8.4.1 Creating a Layout 

The Inspection View contains panels that let you review the text inspection results. These panels 
constitute your layout and can be displayed or hidden as required. Layout customization is ideal for multi-
monitor configurations, as panels can be placed on separate displays. To view the different layout panels 

that can be loaded, click Menu  > Layout. 
 

 

Layout Drop-Down Menu (Text Inspection) 
 

To display/ hide the panels:     

 Uncheck the panel name in the Layout drop-down menu or click the X in the top-right corner of 
the panel once it has been loaded to hide it.  

 Check the panel name to display it. 

To move a given panel: 

 Click its title bar, hold down, and shift it to one of the empty areas in the margins of your screen. 

To save your layout so that it re-appears as is upon closing and re-opening the Application:  

 Click Save Layout. 

To reset your layout to the default: 
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 Click Reset Layout. 
 

8.4.2 Difference List 

The Difference List displays the differences between the Master and Sample files for easy reviewing and 

proofing. The column headings include the Filter Differences  icon, ID, Page, Type, Master (the 
difference as it appears in the Master), Sample (the difference as it appears in the Sample), Comment, 
and Level. With exception to the Filter Differences icon, click any heading to sort the list based on the 
contents of that column. By default, the list is sorted by the Difference ID. 
 

 

Difference List 
To select a difference: 

 Click it in the Difference List. 
 It gets highlighted in the Inspection View Master and Sample panels. 

 

   

Inspection View 
 

To filter the differences, so only specific types appear: 

 Click the Filter Differences  icon.  
 The Filter window appears. 

 

Difference 
List 
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Filter Window 
 

 Ensure the difference types desired to appear in the Difference List are checked by either: 
 Checking/ unchecking them individually, 
 Clicking Select/deselect all, which toggles all difference types on or off, or 
 Clicking Defaults, which resets the selections. 

 Click Filter to return to the filtered Difference List and see the desired difference types or click 
Cancel to disregard the selections and close the window. 
NOTE: Differences excluded from the Difference List via the Filter function still appear in the 
generated report. 

To assign a level to the difference:  

 Select a level by clicking in the Level column in the Difference List and making the selection 
from the drop-down list that appears. The color-coded level displays in the Difference List to the 
right of the difference.    

 

 

Level Column in Difference List 
 

To assign a comment to a difference:  

 Select a comment by clicking in the Comment column or type in a custom one (by selecting 
Freeform).  

 

 

Comment Column in Difference List 

To exclude the difference from the report: 

 Select the difference in the Difference List and click F12.  
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 The difference gets crossed out in the Difference List and the next difference gets selected. To 
cancel the exclude, select the difference again and click F11 to include it.   
NOTE: An administrator can configure the Application to force the inclusion of all differences, in 
which case clicking F12 does not have an effect. 

To navigate to the next difference: 

 Press the F11 key, 
- Or click on the desired difference in the Difference List, 
- Or press the DOWN ARROW  key. In each case, the difference is included in the report. 

To navigate to the previous difference: 

 Press the UP ARROW  key.  

 

8.4.3 Image Details Panel 

The Image Details panel displays image differences during text inspections. Switching between 
displayed differences is as simple as clicking on a new image difference in the Difference List. To assign 
comments and levels to an image difference, follow the same processes outlined for other difference 
types. 
 

 

Image Details Panel 
 
NOTE: image differences only display when the Images difference type and the Include Images 
comparison option are checked on in the selected profile. None of the default Text Inspection profiles 
have either option checked. Only administrators and managers can create new profiles with these options 
turned on. For more information, consult the Administration Guide. 
 

8.4.4 Inspections Panel 

The Inspection View contains the Inspections panel, which lists completed inspections. For example, 
you may run multiple inspections prior to generating the report. The Application lets you rename the 
inspections and/ or exclude them from the report. 
 

 

Inspections Panel 
To rename the inspection: 

 Right-click on the inspection name in the Inspections panel and click Rename.  

Difference 
List 

Image 
Difference in 
Image Detail 

Panel 
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 Enter the desired name and click OK. The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel and click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 

 

 

 
 The inspection is not included in the next generated report. 

 

8.4.5 Master Panel 

Unchecking Master Panel in the Layout drop-down menu hides it from view. The Sample panel takes up 
the entire Inspection View area as a result. To make the Master re-appear, simply check it again. It is 
checked by default.  
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9 Spelling Inspection 

Spelling Inspection Mode checks the spelling of a loaded file or scanned document (using OCR; See 
Section 3.3.5 Optical Character Recognition (OCR)). The Application verifies the text against any one of 
37 different featured languages to help ensure the quality of the copy on both packaging components and 
collateral. Custom, company-specific terms can be added to any dictionary by administrators, while all 
loaded files are automatically run against an English medical dictionary for increased inspection accuracy. 

 

9.1 Step-by-Step 

This section describes the steps to follow when running a spelling inspection. 

1. Load Files for Spelling Inspection 

To inspect spelling in the Master panel: 

 Click File Menu  > Load Master or click in the Master panel to launch the load-file window.  
-  

 The Master image loads in the Master panel. 
 If the file is a PDF:  

- The integrated PDF Viewer displays (see Section 3.6 PDF Viewer). 
- Prepare the Master image using the PDF Viewer tools, if required.  

 Click  for the results to display in the Inspection View.   
To inspect spelling in the Sample panel: 

 Click File Menu  > Load Sample or double-click in the Sample panel and follow the same 
steps as above. 

3. Load Scanned Files (Skip Over if Electronic Files Loaded) 

 Click Load from Scanner  > Select Source.   
 Select the applicable GlobalVision scanner from the Scanner Selection window and click Select.  

 

 

Scanner Selection Window 
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 Click Load from Scanner  > Scan Master to scan the Master document. Once scanned, the 
image loads in the Master panel.   

 Click Load from Scanner  > Scan Sample to scan the Sample document. Once scanned, 
the image loads in the Sample panel.   

3. Ensure the Spelling Inspection Mode Icon  Is Selected 

4. Select an Action 

 

Action Drop-Down Menu 
 

To inspect the file in the Master panel for spelling: 

 Click Action > Inspect Master (All Pages). 

To inspect the file in the Sample panel for spelling: 

 Click Action > Inspect Sample (All Pages). 
5. Select a Language 

 Click the Profile drop-down menu to access . 

 

 
Profile Drop-Down Menu 

 
 Select the language that best suits your inspection needs from the drop-down menu. 

NOTE: See Section 12.5 Supported Dictionaries (Spelling Inspection) in the Appendix. 

6. Ensure the Proper Inspection Area Is Selected 

 Use master/ sample tools to crop, rotate the image, etc. See Sections 3.3 to 3.6 for more 
information, including Section 3.3.5 or 3.4.5 Optical Character Recognition (OCR)  in case the file 
is a scanned-in hard copy. 

7. Run the Inspection 

 Click . The files are inspected and the differences display in the Inspection View. 
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Inspection View  
 

8. View the Results 

To view the inspected file: 

 Use the track wheel to zoom in or out. 
 Hold the left mouse button and move it around to pan the image. 
 To review multiple pages, navigate through them using the Page Navigation drop-down menu at 

the bottom left of the Inspection View. 

9. Review and Proof the Differences 

To select a difference: 

 Click on the difference in the Difference List.  
 It gets highlighted in the Inspection View. 

To assign a level to a difference: 

 Select the difference in the Difference List. Click the Level column and select the level in the 
drop-down list that appears. The color-coded level displays in the Difference List to the right of 
the difference.    
NOTE: Hot keys (F1  F5) may be applied to assign levels. Select the difference and click the 

 
 

KEY FUNCTION 

F1 Reporting level - Critical 

F2 Reporting level - Major 

F3 Reporting level - Minor 

F4 Reporting level - Ignore 

F5 Reporting level  None 
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Levels Assigned Using Difference List 
 

To assign a level to multiple differences: 

 Hold down the CTRL key while selecting the differences, click the Level column, and select the 
level. 
NOTE: On a Mac operating system, to assign a level to multiple differences, hold down the 
COMMAND and SHIFT keys while selecting the differences, click the Level column, and select 
the level. 

To remove a level assignment:  

 Click the Level column and select None. The level no longer displays in the Difference List.     

To assign comment to a difference: 

 Select the difference in the Difference List. Click the Comment column and select one of the 
predefined comments that appear. The selected comment displays.   

To assign a comment to multiple differences: 

 Hold down the CTRL key while selecting the differences, click the Comment column, and select 
the comment. 
NOTE: On a Mac operating system, to assign a comment to multiple differences, hold down the 
COMMAND and SHIFT keys while selecting the differences, click the Comment column, and 
select the comment. 

To assign a customized comment to a difference: 

 Select the difference in the Difference List, click the Comment column, select Freeform, and type 
in the Comments text box in the Difference window that appears. Click OK for it to take effect. 

 

 

Difference Window 
To delete a comment from a difference:  

Difference List 
Level Drop-
Down List 
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 Click in the Comment column in the Difference List and select None. Click elsewhere for it to 
take effect. 

To assign a suggested replacement for a difference from the selected dictionary: 

 Right-click on a difference and select the desired word that displays in the menu that pops up. It 
appears under the Comment field in that row. 

 

 

 
To add a detected spelling mistake to the selected dictionary (administrators and managers only): 

 Right-click on a difference and select Add to current dictionary. 
 Click OK to the confirmation message that appears. 

 

 

 
NOTE: All instances of that same spelling mistake no longer appear as differences once it has 
been added and the inspection is re-run. 

To exclude a difference: 

 Select the difference in the Difference List and click F12. The difference gets crossed out. 

NOTE: An administrator can configure the Application to force the inclusion of all differences, in 
which case clicking F12 does not have an effect. 

10. Include Inspections in Report 

The Application lets you rename inspections and/ or exclude them from the report. This option is available 
under the Inspections panel. 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel. 
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Inspections Panel 

 

 Click Rename.  
 Enter the desired name and click OK. 
 The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel. 
 Click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 

 

 

 
 The inspection is not included in the next generated report. 

NOTE: For more information on layouts and the panels available to you, see Section 9.3 Layouts. 

11. Generate the Report 

 Click the Report  icon. 
 See Section 4.5 Generating Reports for step-by-step instructions. 

12. Retain Inspection Results and Run a New Inspection  

 Click Back . The Main View displays with the Master and Sample images loaded.   
 To load new files, follow the steps above. 

 Click . The files are inspected, and the differences display in the Inspection View. Each 
subsequent retained inspection gets listed in the Inspections panel. 

13. Clear Inspection Results and Run a New Inspection  

 Click Reset . The following message displays, asking if you want to continue: 
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 Click Yes to clear inspection results and documents. The Main View displays with the profile on 
the title bar.   
 

9.2 Spelling Inspection Toolbar 

The Spelling Inspection toolbar appears above the Inspection View Master panel once a spelling 
inspection has been run. It contains the following tools: 
 

 

Spelling Inspection Toolbar 

9.2.1 Rotate 

To rotate the Master image: 

 Click Rotate . 
 Select Rotate 90 CW or Rotate 90 CCW. 

 

9.2.2 Color Inspector 

To display the RGB, CMYK, and LAB color-space information for a selected area in the inspected file:  

 Click the Color Inspector .  
 Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB 

color-space values of the color at the point selected. 
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window, 
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected. 
For more information, see Chapter 10 Color Inspection. 
 

  

Color Inspector Window 
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9.2.3 Marquee Zoom 

To select an area in the image to magnify:  

 Click Marquee Zoom .  
 Select the area with the crosshairs that appear and the left mouse button 

 Or scroll upward with the track wheel.  

To reduce the magnification:    

 Place the cursor in the Master panel. 
 Scroll downward with the track wheel. 

To pan: 

 Left-click in the Master panel. Hold and move the mouse around the panel.   

 

9.2.4 Reset View 

To restore the image to its original size:   

 Click Reset View .  

 

9.2.5 Save View 

To save an image to a file: 

 Click the Save View  icon. The Save As window appears with .tif as the default file type.   
 Select the desired file type and storage location and click Save. 

 

9.3 Layouts  

9.3.1 Creating a Layout 

The Inspection View contains panels that let you review the spelling inspection results. These panels 
constitute your layout and can be displayed or hidden as required. Layout customization is ideal for multi-
monitor configurations, as panels can be placed on separate displays. To view the different layout panels 

that can be loaded, click Menu  > Layout. 

To display/ hide the panels:     

 Uncheck the panel in the Layout drop-down menu or click the X in its top-right corner to hide it.  
 Check the panel name to display it. 

To move a given panel: 

 Click its title bar, hold down, and shift it to an empty area in the margins of your screen. 

To save your layout so that it re-appears as is upon closing and re-opening the Application:  

 Click Save Layout. 
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To reset your layout to the default: 

 Click Reset Layout. 

 

9.3.2 Difference List 

The Difference List displays the differences between the Master and Sample files for easy reviewing and 
proofing. The column headings include the ID, Page, Type, Word, Comment, and Level. Click any 
heading to sort the list based on the contents of that column. By default, the list is sorted by the 
(Difference) ID. 
 

 

Difference List 
To select a difference: 

 Click it in the Difference List. 
 It gets highlighted in the Inspection View Master and Sample panels. 

 

   

Inspection View 
 

To assign a level to the difference:  

 Select a level by clicking in the Level column in the Difference List. The color-coded level 
displays in the Difference List to the right of the difference.    

 

Difference 
List 
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Level Drop-Down List 
 

To assign a comment to a difference:  

 Select a comment by clicking in the Comment column type in a custom one (by selecting 
Freeform). 

 

 

Comment Drop-Down List 
 

To exclude the difference from the report: 

 Select the difference in the Difference List and click F12.  
 The difference gets crossed out in the Difference List and the next difference then gets selected. 

To cancel the exclusion, select the difference again and click F11 to include it.   
NOTE: An administrator can configure the Application to force the inclusion of all differences, in 
which case clicking F12 does not have an effect. 

To navigate to the next difference: 

 Press the F11 key, 
- Or click on the desired difference in the Difference List, 
- Or press the DOWN ARROW  key. In each case, the difference is included in the report. 

To navigate to the previous difference: 

 Press the UP ARROW  key.  

 

9.3.3 Inspections Panel 

The Inspection View contains the Inspections panel, which lists completed inspections. For example, 
you may run multiple inspections prior to generating the report. The Application lets you rename the 
inspections and/ or exclude them from the report. 
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To rename the inspection: 

 Right-click on the inspection name in the Inspections panel and click Rename.  
 Enter the desired name and click OK. The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel and click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 

 

 

 
 The Inspection is not included in the next generated report. 

 

9.3.4 Master Panel 

Toggling the Master Panel on/ off in the Layout drop-down menu shifts the file from appearing in the 
Sample panel (regardless of whether it is a master or sample being inspected) to it taking up the entire 
Inspection View. The latter is the default position (off).  
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10 Color Inspection 

Color Inspection Mode  measures the color-space information of selected points on a master or 
sample or compares the color-space information between corresponding points on the two files. Points 
that fall outside of a configurable E (Delta-E 2000) tolerance level are detected as differences that need 
more attention, for the purposes of improving or verifying color accuracy for printers and their clients. 

NOTE: The Color Inspection Mode  icon is only accessible if it has been enabled as an add-on by 
an administrator. 

 

10.1 Step-by-Step 

This section describes the steps to follow when running a color inspection. 

1. Load Electronic Files (Skip to No. 2 to Load Scanned Files) 

 Click File Menu  > Load Master or click in the Master panel to select the file to be loaded.  
NOTE: Only PDF and TIFF files with embedded ICC profiles are supported by Color Inspection. 

 The Master image loads in the Master panel. 
 If the file is a PDF: 

- The integrated PDF Viewer displays (see Section 3.6 PDF Viewer).  
- Prepare the Master image using the PDF Viewer tools, if required.  

 Click File Menu  > Load Sample or click in the Sample panel to start repeating the process to 
load sample files. 

2. Load Scanned Files (Skip Over if Electronic Files Loaded) 

 Ensure Show Scanner Interface is checked on in the Preferences window. For more 
information, see Section 3.14 Preferences. 

 -approved scanner in such a 
way that the output is in a landscape layout. 

 Click Load from Scanner  > Select Source.   
 Select the applicable GlobalVision scanner (approved for Color Inspection) from the Scanner 

Selection window and click Select.  

 

 

Scanner Selection Window 
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 Click Load from Scanner  > Scan Master to scan the Master document. Once scanned, the 
image loads in the Master panel.   

 Click Load from Scanner  > Scan Sample to scan the Sample document. Once scanned, 
the image loads in the Sample panel.   

3. Ensure the Color Inspection Mode Icon  Is Selected. 

4. Select an Action 

  

 
 
 
 

Action Drop-Down Menu 
 

To compare points selected on a single master page to the same points on a single sample page or press 
sheet: 

 Set Action > Single Page.  
NOTE: When conducting a single-page color inspection comparing a master to a sample with 
repeats, the shape must be selected using the tools on the toolbars/ PDF Viewer. See Sections 
3.3 to 3.6 for more information. 

To compare the same points selected on individual full pages/ press sheets without looking for repeats 
to speed up the inspection process: 

 Set Action > One to One. 

To compare individual points selected on the Master with individual points selected on the Sample: 

 Set Action > Point to Point. 
NOTE: Multi-page files are not supported in Color Inspection Mode. 

5. Select Profile (Skip Over if None Exist or Are Needed) 

 Click the Profile drop-down menu to access the list of available profiles. 
NOTE: None is the default profile. Users of any type (standard users, managers, or 
administrators) can easily create profiles, which consist of collections of points on a master (and 
sample, in the case of Point to Point inspections) to compare, just prior to running a color 
inspection. For more information, see Step 8 Create a Profile (Optional). 

6. Select Colors to Measure (Skip to No. 6 to Select Colors to Inspect) 

 Click on the Color Inspector  icon to launch the Color Inspector window. 
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Color Inspector Window 
 

 Select the applicable Pantone color book from the drop-down list of the same name. 
NOTE: To search the selected Pantone book for reference purposes, enter in a value in the Search 
for a Pantone prompt directly below the Color Book drop-down list. The closest Pantone values 
display in the field directly below. 

 Select the sample size (1x1 pixel, 2x2, 5x5) using the drop-down list of the same name. 
 When moving the cursor over the Master, click on a color to display its LAB, CMYK, and RGB 

values (along with the closest Pantone colors, which display directly underneath the Search for a 
Pantone prompt). 

 Alternatively, click on the Add points  icon and then on points on the Master, each of which 
get listed under the Color Points heading, which appears. 
NOTE: In the case of a PDF file, the Color Inspector automatically detects Pantone colors 
specified in the separations. Otherwise the closest Pantone matches display. In the event no 
Pantone match to a selected point is found, click on one of the closest matches (or manually 
search for a Pantone and then click on it) to substitute it in under the Color Points heading. 

 
right, beside the selected E level and sample size. 

 Click on the Quick Report  icon to launch the Report Options window and start the 
process of generating a report that includes all the LAB, CMYK, RGB, and Pantone information, 
bypassing the inspection (comparison) process. See Section 4.5 Generating Reports for more 
information. 

7. Select Colors to Inspect (Single Page, One to One, or Point to Point) 

 Click on the Color Inspector  icon to launch the Color Inspector window. 
 Select the applicable Pantone book from the drop-down list of the same name. 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

153 of 214  12 Jun 2020 

NOTE: To search the selected Pantone book for reference purposes, enter in a value in the prompt 
directly below the Color Book drop-down list. The closest Pantone values display in the field of the 
same name directly below. 

 Select the sample size (1x1 pixel, 2x2, 5x5) using the drop-down list of the same name. 
 Enter the desired E tolerance in the box of the same name. 

A. Single Page or One to One 

 Click on the Add points  icon and then on different points on the Master to inspect and see if 
the corresponding points on the Sample image(s) respect the pre-configured 
selected points get listed under the Color Points heading that appears, while the individual LAB, 
CMYK, RGB, and Pantone values display above. 

 In the case of a PDF file, the Color Inspector automatically detects Pantone colors specified 
in the separations. Otherwise the closest Pantone matches will display. In the event no 
Pantone match to a selected point is found, click on one of the closest matches (or manually 
search for a Pantone and then click on it) to substitute it in under the Color Points heading. 

 
its far right, beside the selected E level and sample size. 

 

  

Color Inspector Window with Color Points Heading Displayed 
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B. Point to Point 

 Click on the Add points  icon and then on different points on the Master and Sample to 
compare to one another. The points can be added in any sequence, either one in the Master and 
then one in the Sample (one at a time) or all in the Master followed by all in the Sample, as long 
as the total numbers match. The selected points get listed under the Color Points heading that 
appears, while the individual LAB, CMYK, RGB and Pantone values display above. 

 In the case of a PDF file, the Color Inspector automatically detects Pantone colors specified 
in the separations. Otherwise the closest Pantone matches display. In the event no Pantone 
match to a selected point is found, click on one of the closest matches (or manually search 
for a Pantone and then click on it) to substitute it in under the Color Points heading. 

 
its far right, beside the selected E level and sample size. 

8. Create a Profile (Optional) 

 Select Manage from the Profile drop-down list. The Color Profiles window displays. 

 

 

Color Profiles Window 
 

 Click Add. A prompt appears, requesting a name. 
 Enter the name of the profile and click OK. 
 Select the profile from the Profile drop-down list for the previously selected color points to take 

effect prior to any subsequent inspection (for repeat jobs with the same Master, for example). 
NOTE: If a Point to Point profile is selected, the Application automatically switches to the 
appropriate action if it had been set to Single Page or One to One. 

9. Run the Inspection 

 Click . The images are inspected and the differences display in the Inspection View 
Sample panel. 

10. View the Results 

To view the inspected file: 

 Use the track wheel to zoom in or out. 
 Hold the left mouse button and move it around to pan the image. 

To view a repeat: 
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 Click on the desired repeat that appears in the Repeats found panel. It appears in the Inspection 
View Sample panel. 

 

 

11. Review and Proof the Differences 

To select a difference: 

 Click on the difference in the Difference List.  

 

 

Difference List 
 

 It gets highlighted in the Inspection View. 

There are two primary ways to assign a level to a difference: 

 Select the difference in the Difference List. Click in the Level column beside the difference in the 
same panel to load the Level drop-down list and select the level. The color-coded level displays 
to the right of the difference. 

 Alternatively, click the Level drop-down list in the Difference Details panel and select the level. 
The color-coded level displays to the right of the difference in the Difference List. 
NOTE: Hot keys (F1  F5) may also be applied to assign levels. Select the difference and click 

 

Repeats 
Found 
Panel  

Difference 
List for 

Repeat #1 

Difference Details 
Panel for 

Difference #1 of 
Repeat #1 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

156 of 214  12 Jun 2020 

 

KEY FUNCTION 

F1 Reporting level - Critical 

F2 Reporting level - Major 

F3 Reporting level - Minor 

F4 Reporting level - Ignore 

F5 Reporting level  None 

 

   

Level Drop-Down List in Difference Details Panel 
 

To assign a level to multiple differences: 

 Hold down the CTRL key while selecting the differences, click the Level drop-down list, and 
select the level. 
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NOTE: On a Mac operating system, to assign a level to multiple differences, hold down the 
COMMAND and SHIFT keys while selecting the differences, click the Level drop-down box, and 
select the level. 

To remove a level assignment:  

 Click the Level drop-down list and select None. The level no longer displays in the Difference 
List.     

To assign comment to a difference: 

 Select the difference in the Difference List. Click the Comments drop-down list and select one 
of the predefined comments that appear. The selected comment displays whenever the 
difference is re-selected.  

 

  

Comments Drop-Down List in Difference Details Panel 
 

To assign a comment to multiple differences: 

 Hold down the CTRL key while selecting the differences, click the Comments drop-down list, and 
select the comment. 
NOTE: On a Mac operating system, to assign a comment to multiple differences, hold down the 
COMMAND and SHIFT keys while selecting the differences, click the Comments drop-down box, 
and select the comment. 

To assign a customized comment to a difference: 
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 Select the difference in the Difference List, click in the Comments text box, and type in the 
comment. 

To delete a comment from a difference:  

 Click in the Comments drop-down box in the Difference List and select the blank entry.  

To exclude a difference: 

 Select the difference in the Difference List and click F12.  

NOTE: An administrator can configure the Application to force the inclusion of all differences, in 
which case clicking F12 does not have an effect. 

12. Include Inspections in Report 

The Application lets you rename inspections and/ or exclude them from the report. This option is available 
under the Inspections panel. 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel. 
 Click Rename.  
 Enter the desired name and click OK. 
 The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel. 
 Click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel and does not appear in the next 

generated report. 
NOTE: For more information on layouts and the panels available to you, see Section 10.2 
Layouts. 

13. Generate the Report 

 Click the Report  icon. 
 See Section 4.5 Generating Reports for step-by-step instructions. 

14. Retain Inspection Results and Run a New Inspection  

 Click Back . The Main View displays with the Master and Sample images loaded.   
 To load new files, follow the steps above. 

 Click . The files are inspected, and the differences display in the Inspection View. Each 
subsequent retained inspection gets listed in the Inspections panel. 

15. Clear Inspection Results and Run a New Inspection  

 Click Reset . A message displays, asking if you want to continue. 
 Click Yes to clear inspection results and documents.  
 The Main View displays with the profile on the title bar.   
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10.2 Layouts  

10.2.1 Creating a Layout 

The Inspection View contains panels that let you review the color inspection results. These panels 
constitute your layout and can be displayed or hidden as required. Layout customization is ideal for multi-
monitor configurations, as panels can be placed on separate displays. To view the different layout panels 

that can be loaded, click Menu  > Layout. 
 

 

Layout Drop-Down Menu (Color Inspection) 
 

To display/ hide the panels:     

 Uncheck the panel name in the Layout drop-down menu or click the X in the top-right corner of 
the panel once it has been loaded to hide it.  

 Check the panel name to display it. 

To move a given panel: 

 Click its title bar, hold down, and shift it to one of the empty areas in the margins of your screen. 

To save your layout so that it re-appears as is upon closing and re-opening the Application:  

 Click Save Layout. 

To reset your layout to the default: 

 Click Reset Layout. 

 

10.2.2 Overview Panel 

The Overview panel displays the original Sample image. The difference that is selected is located at the 
intersection of the two red lines. To zoom in or out of the Sample image in the Overview panel:  

 Slide the button in the middle of the bar accordingly. 
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Overview Panel 
 

10.2.3 Repeats Found Panel 

The Repeats found panels lists the number of repeats of the Master image that were found in the 
Sample file after the inspection has been run.  

To navigate between repeats: 

 Click the desired number on the list. The selected repeat appears in the Sample panel. 

 

 

Repeats Found Panel 
 

10.2.4 Difference List and Details Panels 

The Difference List displays the differences between the Master and Sample images for easy reviewing 
and proofing. The Difference Details panel lets you assign comments and levels to selected differences 
and include or exclude them from your report. 
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Difference List and Difference Details Panel 
 
To select a difference: 

 Click it in the Difference List. It gets highlighted and the E, closest Pantone matches, LAB, 
CMYK, and RGB values for the same point on the Master and Sample display in the Difference 
Details panel. The corresponding difference gets highlighted in the Inspection View Sample panel. 
NOTE: To view a list of the closest Pantone matches for the same point on the Master and Sample, 

click the  icon beside the E value. The Closest Pantone Matches window displays. 
 

 

Closest Pantone Matches Window 
 

  

Difference 
List  

 
 

Difference 
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To assign a level to the difference:  

 Select a level in the Level drop-down list in either the Difference Details panel or directly beside 
the difference in the Difference List.  

 The color-coded level displays in the Difference List to the right of the difference.    

 

 

Level Drop-Down List 
 

To assign a comment to a difference:  

 Select a comment in the Comments drop-down list or type in a custom comment.  
 A sticky-note icon displays in the Difference List to the right of the difference, signifying the 

presence of a comment.   

 

 

Comments Drop-Down Box 
 

To exclude the difference from the report, assuming Force inclusion of all differences has not been 
checked by an administrator: 

 Click Exclude.  
 The difference gets crossed out in the Difference List and the next difference gets selected. To 

cancel the exclude, select the difference again and click Include (F11).   

To navigate to the next difference: 

 Click Include, 
- Or press the F11 key,  
- Or click on the desired difference in the Difference List, 
- Or press the DOWN ARROW  key. 

  In each case, the difference is included in the report. 

To navigate to the previous difference: 

 Press the UP ARROW  key.  
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10.2.5 Inspections Panel 

The Inspection View contains the Inspections panel, which lists completed inspections. For example, 
you may run multiple inspections prior to generating the report. The Application lets you rename the 
inspections and/ or exclude them from the report. 

To rename the inspection: 

 Right-click on the inspection name in the Inspections panel and click Rename.  
 Enter the desired name and click OK. The new name displays in the Inspections panel. 

To exclude the inspection from the report:  

 Right-click on the inspection name in the Inspections panel and click Exclude from report.   
 The inspection name gets crossed out in the Inspections panel. 
 The Inspection is not included in the next generated report. 

 

10.2.6 Master Panel 

Unchecking Master Panel in the Layout drop-down menu hides it from view. The Sample panel takes up 
the entire Inspection View area as a result. To make the Master re-appear, simply check it on. 
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11 Frequently Asked Questions 

11.1 Passwords 

How do I change my password? 

 Click Menu  > Change Password. The Password window displays.  

 

 

Password Window 
 

 In the Old Password text box, enter your current password (or the temporary password that you 
received with your email or from your administrator, if your account has just been created, for 
example).    

 Enter your new password in the New Password text box.  
 Enter your new password again in the Confirm Password text box.  
 Click Accept OK.         

 
What happens if I forget my password? 

 Click Forgot Password in the Login window. 

 

 

Login Window 

 
 In the Reset Password window that appears, enter your email address. 
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Reset Password Window 

 
 If a user account is associated with the email address provided, a new password is sent to you. 
 Log in using the temporary password and follow the prompts to create a new password. 

 

11.2 Profiles 

What is the difference between a Digital profile and a Proof profile? 

A Digital profile is used to inspect original artwork created by a graphics department against revised 
editions. Before the artwork is sent to be printed, it needs to be reviewed, approved, and signed off. 
During these reviews, changes in the artwork may be requeste
misspelled, a wrong barcode is used, the color is not right, etc. The Digital profile does not use image 
correction logic such as distortion, rotation, and skew. 

A Proof profile is used for the inspection of original artwork created by a graphics department against a 

proof against the printed hard copy. Once the printer creates a proof, it is sent back to the customer who 
provided the original artwork to obtain approval before printing. The Proof profile uses distortion, rotation, 
and skew to compensate for changes in the image. 

 
What is the difference between the Same Layouts (Revisions) and the Different Layouts profiles? 

labels and another for booklets and inserts. Cartons and Labels is used to compare two files with 
different layouts, typically an internally approved master Word doc to the same copy on a laid-out PDF. 
The difference is cartons and labels generally have less copy overall and more blocks of fragmented text. 
Inserts and Booklets is used to compare two files with larger blocks of text. 

In its list of profile parameters, Cartons and Labels uses the template of the same name. Inserts and 
Booklets uses none. Both profiles have their Correction level set to High though, which is the biggest 
difference between the two and the Same Layout (Revisions) profile, also for text inspections. As Same 
Layout (Revisions) is used to compare files of the same type and layout (generally for revision 
purposes), the Correction level is set to Low. Meanwhile, most difference types are checked to catch 
even the slightest changes.  
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11.3 Inspection Results (Graphics) 

11.3.1 Cropping 

What is the minimum size of an area that I can crop? 

The minimum area that you can crop is 100 X 100 pixels.   
 

11.3.2 Repeats 

Why are my repeats not found? 

The repeats may not have the same orientation as the Master. Click the Support Rotated Repeats  
icon.  
 
I enabled Support Rotated Repeats, but my repeats are still not found. What do I do? 

Ask your administrator to change one or more of the following profile parameters: 

 Adjust Find repeating content Similarity.  
 Decrease Find repeating shapes Similarity.  

 

11.3.3 Differences 

Why are so many differences found? 

Specks of dust can be detected as differences. As part of your GMP, ensure that the scanning surface is 
free of dust prior to scanning your sample. You may also consider adjusting the profile parameters. 
 
I want to ignore registration differences. How can I do that? 

Ask your administrator to change one or more of the following profile parameters: 

 Increase the Minimum detection size (pixels). 
 Increase the Maximum difference shift (pixels). 

 

11.4 Inspection Results (Barcode) 

Should I get the same grade results for different DPIs (i.e., 300 DPI vs. 600 DPI)? 

You should not expect to get the same grade results when the resolution changes due to image 
rasterization. The most sensitive grade component in this case is decodability, which measures bar/ 
space ratios against the standard. Changing the DPI resolution may affect decodability. 

As an example: At 600 DPI, wide barcode bars may be 10 pixels and narrow bars 5 pixels, resulting in a 
wide-to-narrow bar ratio of 2. At 300 DPI, wide barcode bars may be 5 pixels and narrow bars 2 or 3 
pixels, resulting in a different wide-to-narrow-bar ratio.  

For the most part, the decodability grade remains in the same range. However, it could be better or 
worse, especially when the narrowest bar is very small (one or two pixels).  

In general, higher DPI values produce more accurate grade results, but require additional processing and 
may prove to be slower.  
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11.5 Inspection Results (Text) 

How does Resync Text work? 

Resync Text  removes an undesired difference or false positive that is an identical match between 
the Master and Sample from the inspection results. A difference is first selected in both the Master and 

Sample panels, by either using the Underline Text  tool or by right-clicking on the difference in the 
Difference List. Once Resync Text is clicked, the list re-adjusts, this time without the selected difference. 

If non-identical matches are resynced, the difference stays on the Difference List, but gets reclassified 
as a Change-type difference.  

 

11.6 System Limitations 

What is the maximum file size that I can load? 

 
 

11.7  General Messages 

Cannot contact the Login Management Server at Host... 

This means connectivity to the Login Management server has been lost. Try launching the Application 
again. If the problem persists, contact your administrator to verify the connectivity. 
 
The desired DPI for the current profile is set to <DPI value>. Set DPI to <DPI value>?  

This means the selected DPI value in Menu  > Resolution does not match the Desired DPI value in 
the selected profile.  

 Click Yes to change the DPI value in Menu  > Resolution to match the Desired DPI value in 
the selected profile.   

 Click No to keep the DPI value in Menu  > Resolution.  
 Click Cancel to cancel the loading of the file. 

 

Please select a scanner to use. (Print Inspection only) 

This means you have selected Scan Master or Scan Sample before selecting a scanner to use. Click 

Load from Scanner  > Select Source and choose the appropriate device. 
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The inspection requires more physical memory than is available. You need to ensure that your system 
meets or exceeds the recommended amount of memory to run the Application. In cases where the 
required memory slightly exceeds the available memory, virtual memory can be used.  

If you want to continue with disk swapping: 

 Close all programs that are not being used.   
 Click Yes. The inspection continues but takes longer to complete.  

If you do not want to continue with disk swapping: 

 Click No to cancel the inspection.  
 

11.8 Braille Inspection Messages 

When the Application fails to detect a suitable Braille region (Compare), the following message 
will display with possible issues to be resolved: 

Failed to detect a suitable Braille region. Please verify that the proper standards and guidelines are 
followed. 
Master File: 
Braille dots follow proper standards and guidelines. 

- File is original artwork. 
- Braille dots are on the top most layer. 
- Braille dots are solid filled dots. 
- Braille dots are a unique color. 
- Braille dots spacing should follow Marburg Medium standards. 

Sample File: 
- Embossed compare requires a backside scan of the sample to compare against a master PDF. 
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12 Appendix 

12.1 Profiles 

Different inspection algorithms are used depending on the selected profile, as determined by the type of 
files inspected. In addition, each profile has parameters that alter the way the inspection algorithm 
perceives and reports differences. So, it is important the correct profile be selected for the best results.  

The Application is installed with the default profiles listed in the tables below as well as default parameter 
values. Administrators and managers can add, rename, and delete profiles and modify individual 
parameter values. For more information, consult the Administration Guide.   

 

12.1.1 Digital (Graphics Inspection) 

A Digital profile is used for the inspection of electronic original artwork created by a graphics department 
against their revised editions. Before the artwork is sent to a printer to be printed, it needs to be reviewed, 
approved, and signed off. During these reviews, changes to the artwork may be requested (Revision 01, 

table lists the parameters and default values of the Digital profile: 

  

PARAMETER VALUE DESCRIPTION 

General 

Difference grouping (pixels) 22 The radius for grouping differences together (0 
to 999) 

Desired DPI 300 The optimum DPI for the profile (32 to 1200) 

Text 

Low contrast Checked Enable the inspection and detection of text 
areas that have low-contrasting colors 

Minimum detection size (pixels) 1 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 115 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

0 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

0 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 
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High contrast Checked Enable the inspection and detection of text 
areas that have high-contrasting colors 

Minimum detection size (pixels) 2 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

5 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 120 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

0 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

0 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

 Artwork  

Low contrast Checked Enables the detection and inspection of artwork 
that contains low-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 10 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

2 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 120 Determine the sensitivity to detect differences 
(1 to 254)  

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

0 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

0 Divides the Master and Sample into smaller 
boxes to reealign the images and compensate 
for the shift (0 to 5) 

High contrast Checked Enables the detection and inspection of artwork 
that contains high-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 2 Ignore differences detected below this value (0 
to 9999999) 
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Maximum difference shift 
(pixels) 

5 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 140 Determine the sensitivity to detect differences 
(1 to 254)  

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

0 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

0 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

Color 

Enhanced color detection Unchecked Enable detection and inspection of color 
differences for digital files 

Minimum detection size (pixels) 1000 Ignore differences detected below this value (0 
to 9999999) 

Sensitivity 217 Determine the sensitivity to detect differences 
(0 to 225) 

NOTE: Must consider the difference grouping 
value  

Repeat Detection 

Find repeating shapes 35 The shape similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 

Find repeating content 85 The content similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 

Advanced 

Ignore edges (pixels) 0 Used in conjunction with Shape Extraction; 
Increases the mask area along the outer die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(-125 to 125) 

Mask creases (pixels) 0 Used in conjunction with Shape Extraction; 
Increases the mask area along the inner die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(0 to 125) 

Correct distortion, rotation and 
skew 

Unchecked Automatically compensates for the angular mis-
alignment between the Master and Sample 
images 

Image padding Unchecked Adds padding around the sample image to aid 
in shape/ repeat detection of scans 
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Use bitmap dpi Unchecked 
to what is listed in the file properties 

 

12.1.2 Len (Graphics Inspection) 

A Len profile is used to inspect and compare Run Length Encoding bitmap files and catch plating errors 
prior to the start of print jobs. The following table lists the parameters and default values of the Len 
profile:  

 

PARAMETER VALUE DESCRIPTION 

General 

Difference grouping (pixels) 50 The radius for grouping differences together (0 
to 999) 

Desired DPI 300 The optimum DPI for the profile (32 to 1200) 

Text 

Low contrast Unchecked Enable the inspection and detection of text 
areas that have low-contrasting colors 

Minimum detection size (pixels) 1 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 115 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

High contrast Unchecked Enable the inspection and detection of text 
areas that have high-contrasting colors 

Minimum detection size (pixels) 1 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

5 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 120 Determine the sensitivity to detect differences 
(1 to 254)  

NOTE: Must consider the difference grouping 
value  

 Artwork  

Low contrast Unchecked Enables the detection and inspection of artwork 
that contains low-contrasting colors 
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NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 1 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 254 Determine the sensitivity to detect differences 
(1 to 254)  

NOTE: Must consider the difference grouping 
value  

High contrast Checked Enables the detection and inspection of artwork 
that contains high-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 0 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 230 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

0 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

0 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

Color 

Enhanced color detection Unchecked Enable detection and inspection of color 
differences for digital files 

Minimum detection size (pixels) 1030 Ignore differences detected below this value (0 
to 9999999) 

Sensitivity 217 Determine the sensitivity to detect differences 
(0 to 225) 

NOTE: Must consider the difference grouping 
value  

Repeat Detection 

Find repeating shapes 15 The shape similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 
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Find repeating content 85 The content similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 

Advanced 

Ignore edges (pixels) 5 Used in conjunction with Shape Extraction; 
Increases the mask area along the outer die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(-125 to 125) 

Mask creases (pixels) 0 Used in conjunction with Shape Extraction; 
Increases the mask area along the inner die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(0 to 125) 

Correct distortion, rotation and 
skew 

Unchecked Automatically compensates for the angular mis-
alignment between the Master and Sample 
images 

Image padding Unchecked Adds padding around the sample image to aid 
in shape/ repeat detection of scans 

Use bitmap dpi Unchecked 
to what is listed in the file properties 

 

12.1.3 Proof (Graphics Inspection) 

A Proof profile is used for the inspection of electronic original artwork created by a graphics department 

proof against the printed hard copy. Once the printer creates a proof, it is sent back to the customer who 
provided the original artwork to obtain approval before printing. A Proof profile uses distortion, rotation, 
and skew to compensate for changes in the image. The following table lists the parameters and default 
values of the Proof profile: 

 

PARAMETER VALUE DESCRIPTION 

General 

Difference grouping (pixels) 50 The radius for grouping differences together (0 
to 999) 

Desired DPI 300 The optimum DPI for the profile (32 to 1200) 

Text 

Low contrast Checked Enable the inspection and detection of text 
areas that have low-contrasting colors 

Minimum detection size (pixels) 1 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 
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Sensitivity 25 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

1 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

0 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

High contrast Checked Enable the inspection and detection of text 
areas that have high-contrasting colors 

Minimum detection size (pixels) 1 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 160 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

5 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

5 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

 Artwork  

Low contrast Checked Enables the detection and inspection of artwork 
that contains low-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 10 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 40 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

2 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

176 of 214  12 Jun 2020 

Correct text kerning and image 
shift correction level (under 
Advanced) 

2 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

High contrast Checked Enables the detection and inspection of artwork 
that contains high-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 10 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 40 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

2 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

2 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

Color 

Enhanced color detection Checked Enable detection and inspection of color 
differences for digital files 

Minimum detection size (pixels) 1000 Ignore differences detected below this value (0 
to 9999999) 

Sensitivity 120 Determine the sensitivity to detect differences 
(0 to 225)  

NOTE: Must consider the difference grouping 
value  

Repeat Detection 

Find repeating shapes 35 The shape similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 

Find repeating content 85 The content similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 

Advanced 

Ignore edges (pixels) 0 Used in conjunction with Shape Extraction; 
Increases the mask area along the outer die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(-125 to 125) 
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Mask creases (pixels) 0 Used in conjunction with Shape Extraction; 
Increases the mask area along the inner die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(0 to 125) 

Correct distortion, rotation and 
skew 

Checked Automatically compensates for the angular mis-
alignment between the Master and Sample 
images 

Image padding Unchecked Adds padding around the sample image to aid 
in shape/ repeat detection of scans 

Use bitmap dpi Unchecked 
to what is listed in the file properties 

 

12.1.4 Digital to Scan (Print Inspection) 

A Digital to Scan profile is used to compare electronic original artwork against a scanned copy. The 
following table lists the default values of the Digital to Scan profile, which features parameters applicable 
to print inspections:  

 

PARAMETER VALUE DESCRIPTION 

General 

Difference grouping (pixels) 50 The radius for grouping differences together (0 
to 999) 

Desired DPI 300 The optimum DPI for the profile (32 to 1200) 

Text 

Low contrast Checked Enable the inspection and detection of text 
areas that have low-contrasting colors  

Minimum detection size (pixels) 1 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 85 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

2 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

3 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 
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High contrast Checked Enable the inspection and detection of text 
areas that have high-contrasting colors 

Minimum detection size (pixels) 1 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

5 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 130 Determine the sensitivity to detect differences 
(1 to 254)  

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

2 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

3 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

 Artwork  

Low contrast Checked Enables the detection and inspection of artwork 
that contains low-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 10 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 40 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

2 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

2 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

High contrast Checked Enables the detection and inspection of artwork 
that contains high-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 10 Ignore differences detected below this value (0 
to 9999999) 
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Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 40 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

2 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

2 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

Color 

Enhanced color detection Unchecked Enable detection and inspection of color 
differences for digital files 

Minimum detection size (pixels) 1000 Ignore differences detected below this value (0 
to 9999999) 

Sensitivity 120 Determine the sensitivity to detect differences 
(0 to 225)  

NOTE: Must consider the difference grouping 
value  

Repeat Detection 

Find repeating shapes 35 The shape similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 

Find repeating content 85 The content similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 

Advanced 

Ignore edges (pixels) 10 Used in conjunction with Shape Extraction; 
Increases the mask area along the outer die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(-125 to 125) 

Mask creases (pixels) 3 Used in conjunction with Shape Extraction; 
Increases the mask area along the inner die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(0 to 125) 

Correct distortion, rotation and 
skew 

Checked Automatically compensates for the angular 
misalignment between the Master and Sample 
images 

Image padding Unchecked Adds padding around the sample image to aid 
in shape/ repeat detection of scans 
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Use bitmap dpi Unchecked 
to what is listed in the file properties 

 

12.1.5 Scan-to-Scan (Print Inspection) 

A Scan-to-Scan profile is used for the inspection of electronic original artwork against a scanned copy. It 
is also used for the inspection of a scanned master against a scanned sample. The following table lists its 
parameters and default values: 

 

PARAMETER VALUE DESCRIPTION 

General 

Difference grouping (pixels) 30 The radius for grouping differences together (0 
to 999) 

Desired DPI 300 The optimum DPI for the profile (32 to 1200) 

Text 

Low contrast Unchecked Enable the inspection and detection of text 
areas that have low-contrasting colors 

Minimum detection size (pixels) 2 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

40 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 70 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

High contrast Unchecked Enable the inspection and detection of text 
areas that have high-contrasting colors 

Minimum detection size (pixels) 2 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

40 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 130 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

 Artwork  

Low contrast Checked Enables the detection and inspection of artwork 
that contains low-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 2 Ignore differences detected below this value (0 
to 9999999) 
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Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 70 Determine the sensitivity to detect differences 
(1 to 254) 

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

1 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

3 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

High contrast Checked Enables the detection and inspection of artwork 
that contains high-contrasting colors 

NOTE: If text processing is not enabled, the 
whole area is inspected 

Minimum detection size (pixels) 2 Ignore differences detected below this value (0 
to 9999999) 

Maximum difference shift 
(pixels) 

0 Maximum allowable tolerance before an item is 
classified as a difference (0 to 9999999) 

Sensitivity 130 Determine the sensitivity to detect differences 
(1 to 254)  

NOTE: Must consider the difference grouping 
value  

Reduce image noise and 
imperfections correction level 
(under Advanced) 

1 Reduces noise within an image to produce a 
less pixilated image (0 to 20) 

NOTE: A higher image-noise-reduction value 
may inhibit difference detection  

Correct text kerning and image 
shift correction level (under 
Advanced) 

3 Divides the Master and Sample into smaller 
boxes to re-align the images and compensate 
for the shift (0 to 5) 

Color 

Enhanced color detection Unchecked Enable detection and inspection of color 
differences for digital files 

Minimum detection size (pixels) 100 Ignore differences detected below this value (0 
to 9999999) 

Sensitivity 215 Determine the sensitivity to detect differences 
(0 to 225) 

NOTE: Must consider the difference grouping 
value  

Repeat Detection 
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Find repeating shapes 35 The shape similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (5 to 99) 

Find repeating content 95 The content similarity between repeats, with 
higher values indicating stricter search 
parameters in finding exact matches (0 to 99) 

Advanced 

Ignore edges (pixels) 0 Used in conjunction with Shape Extraction; 
Increases the mask area along the outer die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(-125 to 125) 

Mask creases (pixels) 0 Used in conjunction with Shape Extraction; 
Increases the mask area along the inner die 
lines of the Master to eliminate crease 
differences from being detected on the sample 
(0 to 125) 

Correct distortion, rotation, and 
skew 

Checked Automatically compensates for the angular mis-
alignment between the Master and Sample 
images 

Image padding Unchecked Adds padding around the sample image to aid 
in shape/ repeat detection of scans 

Use bitmap dpi Unchecked 
to what is listed in the file properties 

 

12.1.6 Default (Barcode Inspection) 

Barcode Inspection Mode examines an image for barcodes, decodes barcodes, and detects the 
barcode grade. The following table lists the parameters and default values of the Default profile: 

 

PARAMETER VALUE DESCRIPTION 

General 

Enable red light simulation Checked Enable/ disable red light simulation when 
converting RGB images 

Digimarc Barcode Disabled 
(enabled by 
administrators as 
possible add-on) 

Enable the inspection of Digimarc-enhanced 
packaging, featuring embedded barcode 
information 

Smooth filter None Enable/ disable smoothing input image with 
Gaussian filter (None, 1x, 2x, 3x, 4x, 5x, 6x) 
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Median filter None Enable/ disable filtering input image with Median 
filter to remove noise (None, 1x, 2x, 3x, 4x, 5x, 
6x) 

Open filter None Enable/ disable filtering input image with Open 
filter to remove small light noise (None, 1x, 2x, 
3x, 4x, 5x, 6x) 

Close filter None Enable/ disable filtering input image with Close 
filter to remove small dark noise (None, 1x, 2x, 
3x, 4x, 5x, 6x) 

Resolution (Measurements) 300 Resolution used to compute measurements; 
Higher values lead to more accurate results, but 
slower computation speed (300, 400, 600, 800, 
1200, 1800, 2400) 

GS1 output data format HRI Set how the output of GS1 barcodes is 
displayed (Human Readable Interpretation, 
Raw, Scanner) 

Grade output format Letters Set how barcodes and their parameters are 
graded (Letters, Numbers) 

Linear 

Process Checked Enable/ disable detection of 1D barcodes 

Scan gap horizontal (pixel 
columns) 

2 Horizontal scan gap between columns in a 
linear barcode; The higher the value, the faster 
and less accurate the detection (0 to 32) 

Scan gap vertical (pixel rows) 2 Vertical scan between rows in a linear barcode; 
The higher the value, the faster and less 
accurate the detection (0 to 32) 

Minimum score 5 Quality of 1D barcode recognition; If too low, 
false positives may be detected; If too high, 
some barcodes may be missed (0 to 100) 

Min. Pharma. W (pixels) 20 Minimum width in a Laetus Pharma code 
symbol to be readable (4 to 600) 

Min. Pharma. H (pixels) 20 Minimum height in a Laetus Pharma code 
symbol to be readable (4 to 200) 

Min. Pharma. Bars 4 Minimum number of bars in a Laetus Pharma 
code symbol to be readable (2 to 16) 
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Min. vicinity hor. (pixels) 64 Minimum horizontal distance to merge two 
similar barcodes (1 to 1000) 

Min. vicinity ver. (pixels) 76 Minimum vertical distance to merge two similar 
barcodes (1 to 1000) 

Edge Threshold 40 Minimum transition value between a bar and a 
space; Low values for high-contrasted 
transitions and high values for low-contrasted 
transitions (1 to 100) 

Max. Pharma. W (pixels) 600 Maximum width in a Laetus Pharma code 
symbol to be readable (70 to 1000) 

Max. Pharma. H (pixels) 200 Maximum height in a Laetus Pharma code 
symbol to be readable (40 to 1000) 

ISO/IEC 2016 Standard Unchecked Enable/ disable linear barcode grading using 
ISO/IEC 15416:2016 standard (uncheck for 
2000 standard) 

Ignore quiet zone Unchecked Enable/ disable verification of quiet zones for 
barcodes that require them 

Support rotation Unchecked Enable detection of rotated barcodes with non-
90-degree angles 

Support Negative Barcodes Unchecked Enable detection of inverted barcodes 

Ignore checksum Unchecked Enable/ disable checksum verification for UPC/ 
EAN barcodes  

Include in Grading: Data 
Structure 

Unchecked Include Data Structure in the grading 

Include in Grading: Quiet Zone Unchecked Include Quiet Zone in the grading 

Include in Grading: Narrow Bar Unchecked Include Narrow Bar in the grading 

Include in Grading: Wide to 
Narrow Ratio 

Unchecked Include Wide-to-Narrow Ratio in the grading 

Fail Grading if BWR out of the 
specified range 

Unchecked Fail the grading if Bar Width Reduction is out of 
specified range (adjustable with minimum BWR 
set at -0.10 and maximum BWR set at 0.10 by 
default) 

Nominal Measurements for 
USPS 4-State 

Checked Compute nominal measurements for USPS 4-
State barcodes by taking the average size of 
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bars for grading purposes instead of the 
smallest 

Linear Types 

UPC Checked 

EAN Checked 

Interleaved Checked 

GS1 Databar Checked 

Codabar Checked 

Code 11 Checked 

Code 32 Unchecked 

Code 39 Checked 

Code 93 Checked 

Code 128/ GS1 128 Checked 

MSI Checked 

Telepen Checked 

Laetus Pharma code Checked 

USPS 4-State Checked 

Data Matrix 

Process Checked Enable/ disable detection of data matrix 
barcodes 

Max. expected symbols 3 Maximum number of data matrix barcodes that 
can be detected in an inspection; The higher the 
value, the slower the detection (1 to 100) 

Scan gap (pixel columns) 8 Horizontal scan gap when detecting data matrix 
barcodes; The higher the value, the faster and 
less accurate the detection (0 to 32) 

Locator effort level 1 Detection algorithm complexity level; The higher 
the value, the slower and more accurate the 
detection (1 to 10) 
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Edge threshold 10 Minimum transition value between a light and a 
dark module; Low values for low-contrasted 
transitions and high values for high-contrasted 
transitions (1 to 100) 

Min. module size (pixels) 4 Minimum data matrix cell size (1 to 100) 

Max. symbol size (pixels) 600 Maximum data matrix size (1 to 2000) 

Max. skew angle (degrees) 15 Maximum data matrix skew angle (0 to 90) 

Grade NON ISO parameters Unchecked Enable the grading of non-ISO parameters 

Support Mirrored Barcodes Checked Enable detection of mirrored barcodes 

QR 

Process Checked Enable/ disable detection of QR and micro QR 
barcodes 

Scan gap hor. (pixel columns) 2 Horizontal scan gap when detecting QR and 
micro QR barcodes; The higher the value, the 
faster and less accurate the detection (0 to 32) 

Scan gap ver. (pixel rows) 2 Vertical scan gap when detecting QR and micro 
QR barcodes; The higher the value, the faster 
and less accurate the detection (0 to 32) 

Minimum score 5 Quality of QR and micro QR barcode 
recognition; If too low, false positives may be 
detected; If too high, some barcodes may be 
missed (0 to 100) 

Edge threshold 40 Minimum transition value between a light and a 
dark module; Low values for high-contrasted 
transitions and high values for low-contrasted 
transitions (1 to 100) 

Grade NON ISO parameters Unchecked Enable the grading of non-ISO parameters 

Support Mirrored Barcodes Checked Enable detection of mirrored barcodes 

 

12.1.7 Rotated (Barcode Inspection) 

The Rotated profile supports the verification of rotated barcodes. The only difference between the 
Default and Rotated profiles is how the Support Rotation parameter is toggled. It is set to checked here: 

 

PARAMETER VALUE DESCRIPTION 
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General 

Enable red light simulation Checked Enable/ disable red light simulation when 
converting RGB images 

Digimarc Barcode Disabled 
(enabled by 
administrators as 
possible add-on) 

Enable the inspection of Digimarc-enhanced 
packaging, featuring embedded barcode 
information 

Smooth filter None Enable/ disable smoothing input image with 
Gaussian filter (None, 1x, 2x, 3x, 4x, 5x, 6x) 

Median filter None Enable/ disable filtering input image with Median 
filter to remove noise (None, 1x, 2x, 3x, 4x, 5x, 
6x) 

Open filter None Enable/ disable filtering input image with Open 
filter to remove small light noise (None, 1x, 2x, 
3x, 4x, 5x, 6x) 

Close filter None Enable/ disable filtering input image with Close 
filter to remove small dark noise (None, 1x, 2x, 
3x, 4x, 5x, 6x) 

Resolution (Measurements) 300 Resolution used to compute measurements; 
Higher values lead to more accurate results, but 
slower computation speed (300, 400, 600, 800, 
1200, 1800, 2400) 

GS1 output data format HRI Set how the output of GS1 barcodes is 
displayed (Human Readable Interpretation, 
Raw, Scanner) 

Grade output format Letters Set how barcodes and their parameters are 
graded (Letters, Numbers) 

Linear 

Process Checked Enable/ disable detection of 1D barcodes 

Scan gap hor. (pixel columns) 2 Horizontal scan gap between columns in a 
linear barcode; The higher the value, the faster 
and less accurate the detection (0 to 32) 

Scan gap ver. (pixel rows) 2 Vertical scan between rows in a linear barcode; 
The higher the value, the faster and less 
accurate the detection (0 to 32) 

Minimum score 5 Quality of 1D barcode recognition; If too low, 
false positives may be detected; If too high, 
some barcodes may be missed (0 to 100) 

Min. Pharma. W (pixels) 20 Minimum width in a Laetus Pharma code 
symbol to be readable (4 to 600) 
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Min. Pharma. H (pixels) 20 Minimum height in a Laetus Pharma code 
symbol to be readable (4 to 200) 

Min. Pharma. Bars 4 Minimum number of bars in a Laetus Pharma 
code symbol to be readable (2 to 16) 

Min. vicinity hor. (pixels) 64 Minimum horizontal distance to merge two 
similar barcodes (1 to 1000) 

Min. vicinity ver. (pixels) 76 Minimum vertical distance to merge two similar 
barcodes (1 to 1000) 

Edge Threshold 40 Minimum transition value between a bar and a 
space; Low values for high-contrasted 
transitions and high values for low-contrasted 
transitions (1 to 100) 

Max. Pharma. W (pixels) 600 Maximum width in a Laetus Pharma code 
symbol to be readable (70 to 1000) 

Max. Pharma. H (pixels) 200 Maximum height in a Laetus Pharma code 
symbol to be readable (40 to 1000) 

ISO/IEC 2016 Standard Unchecked Enable/ disable linear barcode grading using 
ISO/IEC 15416:2016 standard (uncheck for 
2000 standard) 

Ignore quiet zone Unchecked Enable/ disable verification of quiet zones for 
barcodes that require them 

Support rotation Checked Enable detection of rotated barcodes with non-
90-degree angles 

Support Negative Barcodes Unchecked Enable detection of inverted barcodes 

Ignore checksum Unchecked Enable/ disable checksum verification for 
UPC/EAN barcodes  

Include in Grading: Data 
Structure 

Unchecked Include Data Structure in the grading 

Include in Grading: Quiet Zone Unchecked Include Quiet Zone in the grading 

Include in Grading: Narrow Bar Unchecked Include Narrow Bar in the grading 

Include in Grading: Wide to 
Narrow Ratio 

Unchecked Include Wide-to-Narrow Ratio in the grading 

Fail Grading if BWR out of the 
specified range 

Unchecked Fail the grading if Bar Width Reduction is out of 
specified range (adjustable with minimum BWR 
set at -0.10 and maximum BWR set at 0.10 by 
default) 

Nominal Measurements for 
USPS 4-State 

Checked Compute nominal measurements for USPS 4-
State barcodes by taking the average size of 
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bars for grading purposes instead of the 
smallest 

Linear Types 

UPC Checked 

EAN Checked 

Interleaved Checked 

GS1 Databar Checked 

Codabar Checked 

Code 11 Checked 

Code 32 Unchecked 

Code 39 Checked 

Code 93 Checked 

Code 128/ GS1 128 Checked 

MSI Checked 

Telepen Checked 

Laetus Pharma code Checked 

USPS 4-State Checked 

Data Matrix 

Process Checked Enable/ disable detection of data matrix 
barcodes 

Max. expected symbols 3 Maximum number of data matrix barcodes that 
can be detected in an inspection; The higher the 
value, the slower the detection (1 to 100) 

Scan gap (pixel columns) 8 Horizontal scan gap when detecting data matrix 
barcodes; The higher the value, the faster and 
less accurate the detection (0 to 32) 

Locator effort level 1 Detection algorithm complexity level; The higher 
the value, the slower and more accurate the 
detection (1 to 10) 

Edge threshold 10 Minimum transition value between a light and a 
dark module; Low values for low-contrasted 
transitions and high values for high-contrasted 
transitions (1 to 100) 

Min. module size (pixels) 4 Minimum data matrix cell size (1 to 100) 
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Max. symbol size (pixels) 600 Maximum data matrix size (1 to 2000) 

Max. skew angle (degrees) 15 Maximum data matrix skew angle (0 to 90) 

Grade NON ISO parameters Unchecked Enable the grading of non-ISO parameters 

Support Mirrored Barcodes Checked Enable detection of mirrored barcodes 

QR 

Process Checked Enable/ disable detection of QR and micro QR 
barcodes 

Scan gap hor. (pixel columns) 2 Horizontal scan gap when detecting QR and 
micro QR barcodes; The higher the value, the 
faster and less accurate the detection (0 to 32) 

Scan gap ver. (pixel rows) 2 Vertical scan gap when detecting QR and micro 
QR barcodes; The higher the value, the faster 
and less accurate the detection (0 to 32) 

Minimum score 5 Quality of QR and micro QR barcode 
recognition; If too low, false positives may be 
detected; If too high, some barcodes may be 
missed (0 to 100) 

Edge threshold 40 Minimum transition value between a light and a 
dark module; Low values for high-contrasted 
transitions and high values for low-contrasted 
transitions (1 to 100) 

Grade NON ISO parameters Unchecked Enable the grading of non-ISO parameters 

Support Mirrored Barcodes Checked Enable detection of mirrored barcodes 

 

12.1.8 Different Layout (Cartons and Labels) (Text Inspection) 
Similar to the Inserts and Booklets profile, Cartons and Labels is used to compare two files with 
different layouts, typically an internally approved master Word doc to the same copy on a laid-out PDF. 
The difference is cartons and labels generally have less copy overall and more blocks of fragmented text. 
Table and Line Processing is unchecked as a result, with a slight variation to the types of differences 
detected. Relative to the Same Layouts (Revisions) profile, there are some key differences. Here, the 
Correction Level is set to High. The following table lists th  

 

PARAMETER VALUE DESCRIPTION 

Difference Types 

Insertion Checked Show insertion differences (inserted text) 

Deletion Checked Show deletion differences (deleted text) 

Change Checked Show change differences (matching text strings 
changed without regard to any one specific 
difference type) 
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Color Unchecked Show color differences (text with different color) 

Space Checked Show space differences (inserted space vs. no 
space) 

Hyphen Checked Show hyphen differences (hyphenated vs. non-
hyphenated text) 

Italic Checked Show italic differences (italic vs. non-italic text) 

Bold Checked Show bold differences (bold vs. non-bold text) 

Underline Unchecked Show underline differences (underlined vs. non-
underlined text) 

Subscript/Superscript Checked Show sub and superscript differences (sub/ 
superscripted vs. non-sub/ superscripted text) 

Line Break Space Unchecked Show end-of-line spaces as differences (line-
break space inserted between characters vs. 
no-line-break space) 

Images Unchecked Show differences between images (with Include 
Images under Advanced enabled) 

Location Checked Show text location differences (moved text) 

Case Checked Show case differences (upper-case/ lower-case 
changes) 

Font Type Unchecked Show changes in the font as differences (text 
with different font name) 

Size Unchecked Show differences in character sizes if they are 
greater than the specified value (configurable 
under Advanced) 

Min Font Point Size Unchecked Show instances when the font falls below the 
minimum font point size (configurable under 
Advanced) as differences 

Languages 

Process text as Left to Right Checked Sets the text directionality. Enable for any left-
to-right languages such as French, English, 
Italian, etc. 

Process text as Right to Left Unchecked Sets the text directionality. Enable for any right-
to-left languages such as Arabic, Hebrew, Farsi, 
etc. 

Process text as Asian Unchecked Enable Asian language processing to prevent 
words split by very small spaces from being 
detected as more than one 
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Correction Level 

Low Unchecked Select for files that have good reading order or 
for revisions 

Medium Unchecked Select for files with repetitive text 

High Checked Select when inspecting cartons, artwork files, 
leaflets, or files with many columns or tables; 
Avoid for files with repetitive text 

Templates 

None Unchecked No template inspection 

Carton/label Checked Enable for automatic QRD template inspection 

Custom Unchecked Select a custom template from a scroll-down list 
that appears upon Custom being checked 

Advanced 

Off (Table and Line Processing) Checked Select to not process tables and lines when 
inspecting (for faster inspections) 

Process Lines (Table and Line 
Processing) 

Unchecked Select to process lines (and not tables) when 
inspecting 

Process Lines and Tables 
(Table and Line Processing) 

Unchecked Select to process lines and tables when 
inspecting 

Automatically remove headers 
and footers from Word files 
(Document Processing) 

Checked Select to remove headers and footers from files 
(to prevent errors being detected during 
inspections for different pages numbers, for 
example) 

Automatically remove QRD 
headers (Document 
Processing) 

Unchecked Select to eliminate the need to manually cross 
out QRD headers before running an inspection 
(to prevent them from being detected as 
differences) 

Automatically remove highlights 
from Word files (Document 
Processing) 

Checked Select to remove highlights from Word files to 
improve inspection results 

Automatically remove hidden 
lines from PDF file (Document 
Processing) 

Checked Select to remove hidden lines that tend to exist 
in PDF files to improve inspection results 

Correct Font Display Issues 
(Document Processing) 

Unchecked Select to correct display issues with corrupted 
fonts 

Group Font Differences 
(Comparison Options) 

Unchecked Select to group Color, Bold, Italic, Underline, 
Font Type, Size, and/ or Subscript/Superscript 
differences as one if clustered together 

Ignore Case during Inspection 
(Comparison Options) 

Unchecked Select for a case-insensitive inspection when 
matching words 

Ignore Space Next to Hyphen 
(Comparison Options) 

Unchecked Ignore the space next to hyphens when 
classifying differences 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

193 of 214  12 Jun 2020 

Include Images (Comparison 
Options) 

Unchecked Enable to compare images appearing in loaded 
files during the inspection 

Detect Soft Hyphens 
(Comparison Options) 

Unchecked Show hyphens appearing at the end of a line to 
divide words as differences 

Ignore Tab Leaders 
(Comparison Options) 

Unchecked Enable to ignore visual representations of 
spaces between tabs 

Font Size Tolerance 
(Comparison Options) 

1.00 Adjust the change in font size that is detected 
as a difference (re: Size difference type; 0.00 to 
99.00) 

Min Font Point Size 
(Comparison Options) 

0.10 Adjust the font size set as the minimum (re: Min 
Font Point Size difference type; 0.00 to 99.00) 

 

12.1.9 Different Layout (Inserts and Booklets) (Text Inspection) 
 
Similar to the Cartons and Labels profile, Inserts and Booklets is used to compare two files with 
different layouts, typically an internally approved master Word doc to the same copy on a laid-out PDF. 
The difference is inserts and booklets generally have larger blocks of text to inspect. Table and Line 
Processing is checked as a result, with a slight variation to the types of differences detected. Relative to 
the Same Layouts (Revisions) profile, there are some key differences. Here, the Correction Level is 
set to High  

 

PARAMETER VALUE DESCRIPTION 

Difference Types 

Insertion Checked Show insertion differences (inserted text) 

Deletion Checked Show deletion differences (deleted text) 

Change Checked Show change differences (matching text strings 
changed without regard to any one specific 
difference type) 

Color Unchecked Show color differences (text with different color) 

Space Checked Show space differences (inserted space vs. no 
space) 

Hyphen Checked Show hyphen differences (hyphenated vs. non-
hyphenated text) 

Italic Checked Show italic differences (italic vs. non-italic text) 

Bold Checked Show bold differences (bold vs. non-bold text) 

Underline Checked Show underline differences (underlined vs. non-
underlined text) 
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Subscript/Superscript Checked Show sub and superscript differences (sub/ 
superscripted vs. non-sub/ superscripted text) 

Line Break Space Unchecked Show end-of-line spaces as differences (line-
break space inserted between characters vs. 
no-line-break space) 

Images Unchecked Show differences between images (with Include 
Images under Advanced enabled) 

Location Unchecked Show text location differences (moved text) 

Case Checked Show case differences (upper-case/ lower-case 
changes) 

Font Type Unchecked Show changes in the font as differences (text 
with different font name) 

Size Unchecked Show differences in character sizes if they are 
greater than the specified value (configurable 
under Advanced) 

Min Font Point Size Unchecked Show instances when the font falls below the 
minimum font point size (configurable under 
Advanced) as differences 

Languages 

Process text as Left to Right Checked Sets the text directionality. Enable for any left-
to-right languages such as French, English, 
Italian, etc. 

Process text as Right to Left Unchecked Sets the text directionality. Enable for any right-
to-left languages such as Arabic, Hebrew, Farsi, 
etc. 

Process text as Asian Unchecked Enable Asian language processing to prevent 
words split by very small spaces from being 
detected as more than one 

Correction Level 

Low Unchecked Select for files that have good reading order or 
for revisions 

Medium Unchecked Select for files with repetitive text 

High Checked Select when inspecting cartons, artwork files, 
leaflets, or files with many columns or tables; 
Avoid for files with repetitive text 

Templates 

None Checked No template inspection 

Carton/label Unchecked Enable for automatic QRD template inspection 
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Custom Unchecked Select a custom template from a scroll-down list 
that appears upon Custom being checked 

Advanced 

Off (Table and Line Processing) Unchecked Select to not process tables and lines when 
inspecting (for faster inspections) 

Process Lines (Table and Line 
Processing) 

Unchecked Select to process lines (and not tables) when 
inspecting 

Process Lines and Tables 
(Table and Line Processing) 

Checked Select to process lines and tables when 
inspecting 

Automatically remove headers 
and footers from Word files 
(Document Processing) 

Checked Select to remove headers and footers from files 
(to prevent errors being detected during 
inspections for different pages numbers, for 
example) 

Automatically remove QRD 
headers (Document 
Processing) 

Unchecked Select to eliminate the need to manually cross 
out QRD headers before running an inspection 
(to prevent them from being detected as 
differences) 

Automatically remove highlights 
from Word files (Document 
Processing) 

Checked Select to remove highlights from Word files to 
improve inspection results 

Automatically remove hidden 
lines from PDF file (Document 
Processing) 

Checked Select to remove hidden lines that tend to exist 
in PDF files to improve inspection results 

Correct Font Display Issues 
(Document Processing) 

Unchecked Select to correct display issues with corrupted 
fonts 

Group Font Differences 
(Comparison Options) 

Unchecked Select to group Color, Bold, Italic, Underline, 
Font Type, Size, and/ or Subscript/Superscript 
differences as one if clustered together 

Ignore Case during Inspection 
(Comparison Options) 

Unchecked Select for a case-insensitive inspection when 
matching words 

Ignore Space Next to Hyphen 
(Comparison Options) 

Unchecked Ignore the space next to hyphens when 
classifying differences 

Include Images (Comparison 
Options) 

Unchecked Enable to compare images appearing in loaded 
files during the inspection 

Detect Soft Hyphens 
(Comparison Options) 

Unchecked Show hyphens appearing at the end of a line to 
divide words as differences 

Ignore Tab Leaders 
(Comparison Options) 

Unchecked Enable to ignore visual representations of 
spaces between tabs 

Font Size Tolerance 
(Comparison Options) 

1.00 Adjust the change in font size that is detected 
as a difference (re: Size difference type; 0.00 to 
99.00) 

Min Font Point Size 
(Comparison Options) 

0.10 Adjust the font size set as the minimum (re: Min 
Font Point Size difference type; 0.00 to 99.00) 
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12.1.10 QRD (Text Inspection) 

QRD (Quality Review of Documents) templates separate information to appear on product packaging 
through the presence of different headers. They fall under a variety of categories from individual product 
characteristics to the desired layout that is used when creating the packaging itself. The QRD profile 
distinguishes itself by automatically removing those headers from the Master when comparing it to the 

fault values: 

 

PARAMETER VALUE DESCRIPTION 

Difference Types 

Insertion Checked Show insertion differences (inserted text) 

Deletion Checked Show deletion differences (deleted text) 

Change Checked Show change differences (matching text strings 
changed without regard to any one specific 
difference type) 

Color Unchecked Show color differences (text with different color) 

Space Checked Show space differences (inserted space vs. no 
space) 

Hyphen Checked Show hyphen differences (hyphenated vs. non-
hyphenated text) 

Italic Unchecked Show italic differences (italic vs. non-italic text) 

Bold Unchecked Show bold differences (bold vs. non-bold text) 

Underline Unchecked Show underline differences (underlined vs. non-
underlined text) 

Subscript/Superscript Unchecked Show sub and superscript differences (sub/ 
superscripted vs. non-sub/ superscripted text) 

Line Break Space Unchecked Show end-of-line spaces as differences (line-
break space inserted between characters vs. 
no-line-break space) 

Images Unchecked Show differences between images (with Include 
Images under Advanced enabled) 

Location Checked Show text location differences (moved text) 

Case Checked Show case differences (upper-case/ lower-case 
changes) 

Font Type Unchecked Show changes in the font as differences (text 
with different font name) 
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Size Unchecked Show differences in character sizes if they are 
greater than the specified value (configurable 
under Advanced) 

Min Font Point Size Unchecked Show instances when the font falls below the 
minimum font point size (configurable under 
Advanced) as differences 

Languages 

Process text as Left to Right Checked Sets the text directionality. Enable for any left-
to-right languages such as French, English, 
Italian, etc. 

Process text as Right to Left Unchecked Sets the text directionality. Enable for any right-
to-left languages such as Arabic, Hebrew, Farsi, 
etc. 

Process text as Asian Unchecked Enable Asian language processing to prevent 
words split by very small spaces from being 
detected as more than one 

Correction Level 

Low Unchecked Select for files that have good reading order or 
for revisions 

Medium Unchecked Select for files with repetitive text 

High Checked Select when inspecting cartons, artwork files, 
leaflets, or files with many columns or tables; 
Avoid for files with repetitive text 

Templates 

None Unchecked No template inspection 

Carton/label Checked Enable for automatic QRD template inspection 

Custom Unchecked Select a custom template from a scroll-down list 
that appears upon Custom being checked 

Advanced 

Off (Table and Line Processing) Checked Select to not process tables and lines when 
inspecting (for faster inspections) 

Process Lines (Table and Line 
Processing) 

Unchecked Select to process lines (and not tables) when 
inspecting 

Process Lines and Tables 
(Table and Line Processing) 

Unchecked Select to process lines and tables when 
inspecting 

Automatically remove headers 
and footers from Word files 
(Document Processing) 

Checked Select to remove headers and footers from files 
(to prevent errors being detected during 
inspections for different pages numbers, for 
example) 

Automatically remove QRD 
headers (Document 
Processing) 

Checked Select to eliminate the need to manually cross 
out QRD headers before running an inspection 
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(to prevent them from being detected as 
differences) 

Automatically remove highlights 
from Word files (Document 
Processing) 

Checked Select to remove highlights from Word files to 
improve inspection results 

Automatically remove hidden 
lines from PDF file (Document 
Processing) 

Checked Select to remove hidden lines that tend to exist 
in PDF files to improve inspection results 

Correct Font Display Issues 
(Document Processing) 

Unchecked Select to correct display issues with corrupted 
fonts 

Group Font Differences 
(Comparison Options) 

Unchecked Select to group Color, Bold, Italic, Underline, 
Font Type, Size, and/ or Subscript/Superscript 
differences as one if clustered together 

Ignore Case during Inspection 
(Comparison Options) 

Unchecked Select for a case-insensitive inspection when 
matching words 

Ignore Space Next to Hyphen 
(Comparison Options) 

Unchecked Ignore the space next to hyphens when 
classifying differences 

Include Images (Comparison 
Options) 

Unchecked Enable to compare images appearing in loaded 
files during the inspection 

Detect Soft Hyphens 
(Comparison Options) 

Unchecked Show hyphens appearing at the end of a line to 
divide words as differences 

Ignore Tab Leaders 
(Comparison Options) 

Unchecked Enable to ignore visual representations of 
spaces between tabs 

Font Size Tolerance 
(Comparison Options) 

1.00 Adjust the change in font size that is detected 
as a difference (re: Size difference type; 0.00 to 
99.00) 

Min Font Point Size 
(Comparison Options) 

0.10 Adjust the font size set as the minimum (re: Min 
Font Point Size difference type; 0.00 to 99.00) 

 

12.1.11 Same Layout (Revisions) (Text Inspection) 

As this profile is typically used to compare similar files of the same type and layout (generally for revision 
purposes), the Correction level is set to Low. Meanwhile, most difference types are checked to catch 
even the slightest changes. The following ta  

 

PARAMETER VALUE DESCRIPTION 

Difference Types 

Insertion Checked Show insertion differences (inserted text) 

Deletion Checked Show deletion differences (deleted text) 

Change Checked Show change differences (matching text strings 
changed without regard to any one specific 
difference type) 
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Color Checked Show color differences (text with different color) 

Space Checked Show space differences (inserted space vs. no 
space) 

Hyphen Checked Show hyphen differences (hyphenated vs. non-
hyphenated text) 

Italic Checked Show italic differences (italic vs. non-italic text) 

Bold Checked Show bold differences (bold vs. non-bold text) 

Underline Checked Show underline differences (underlined vs. non-
underlined text) 

Subscript/Superscript Checked Show sub and superscript differences (sub/ 
superscripted vs. non-sub/ superscripted text) 

Line Break Space Checked Show end-of-line spaces as differences (line-
break space inserted between characters vs. 
no-line-break space) 

Images Unchecked Show differences between images (with Include 
Images under Advanced enabled) 

Location Checked Show text location differences (moved text) 

Case Checked Show case differences (upper-case/ lower-case 
changes) 

Font Type Checked Show changes in the font as differences (text 
with different font name) 

Size Checked Show differences in character sizes if they are 
greater than the specified value (configurable 
under Advanced) 

Min Font Point Size Unchecked Show instances when the font falls below the 
minimum font point size (configurable under 
Advanced) as differences 

Languages 

Process text as Left to Right Checked Sets the text directionality. Enable for any left-
to-right languages such as French, English, 
Italian, etc. 

Process text as Right to Left Unchecked Sets the text directionality. Enable for any right-
to-left languages such as Arabic, Hebrew, Farsi, 
etc. 

Process text as Asian Unchecked Enable Asian language processing to prevent 
words split by very small spaces from being 
detected as more than one 
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Correction Level 

Low Checked Select for files that have good reading order or 
for revisions 

Medium Unchecked Select for files with repetitive text 

High Unchecked Select when inspecting cartons, artwork files, 
leaflets, or files with many columns or tables; 
Avoid for files with repetitive text 

Templates 

None Checked No template inspection 

Carton/label Unchecked Enable for automatic QRD template inspection 

Custom Unchecked Select a custom template from a scroll-down list 
that appears upon Custom being checked 

Advanced 

Off (Table and Line Processing) Unchecked Select to not process tables and lines when 
inspecting (for faster inspections) 

Process Lines (Table and Line 
Processing) 

Checked Select to process lines (and not tables) when 
inspecting 

Process Lines and Tables 
(Table and Line Processing) 

Unchecked Select to process lines and tables when 
inspecting 

Automatically remove headers 
and footers from Word files 
(Document Processing) 

Checked Select to remove headers and footers from files 
(to prevent errors being detected during 
inspections for different pages numbers, for 
example) 

Automatically remove QRD 
headers (Document 
Processing) 

Unchecked Select to eliminate the need to manually cross 
out QRD headers before running an inspection 
(to prevent them from being detected as 
differences) 

Automatically remove highlights 
from Word files (Document 
Processing) 

Checked Select to remove highlights from Word files to 
improve inspection results 

Automatically remove hidden 
lines from PDF file (Document 
Processing) 

Checked Select to remove hidden lines that tend to exist 
in PDF files to improve inspection results 

Correct Font Display Issues 
(Document Processing) 

Unchecked Select to correct display issues with corrupted 
fonts 

Group Font Differences 
(Comparison Options) 

Unchecked Select to group Color, Bold, Italic, Underline, 
Font Type, Size, and/ or Subscript/Superscript 
differences as one if clustered together 

Ignore Case during Inspection 
(Comparison Options) 

Unchecked Select for a case-insensitive inspection when 
matching words 

Ignore Space Next to Hyphen 
(Comparison Options) 

Unchecked Ignore the space next to hyphens when 
classifying differences 
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Include Images (Comparison 
Options) 

Unchecked Enable to compare images appearing in loaded 
files during the inspection 

Detect Soft Hyphens 
(Comparison Options) 

Unchecked Show hyphens appearing at the end of a line to 
divide words as differences 

Ignore Tab Leaders 
(Comparison Options) 

Unchecked Enable to ignore visual representations of 
spaces between tabs 

Font Size Tolerance 
(Comparison Options) 

1.00 Adjust the change in font size that is detected 
as a difference (re: Size difference type; 0.00 to 
99.00) 

Min Font Point Size 
(Comparison Options) 

0.10 Adjust the font size set as the minimum (re: Min 
Font Point Size difference type; 0.00 to 99.00) 

 

12.2 Braille Inspection Actions 

Actions dictate the type of inspection that is run, which may vary. For example, sometimes only single 
files need to be inspected instead of compared against another. Actions can be easily selected by all 
users via the Action drop-down list at the top of the user interface, but only Braille Inspection actions can 

-down list. Only users with administrative privileges can add, 
rename, and delete actions as well as modify their respective individual parameter values. 
 

12.2.1 Translate Master 

This action translates the Braille on a digital master file. 

 

PARAMETER VALUE DESCRIPTION 

Braille Height Criteria (mm) 

Acceptable Height 0.12 Set the target height for Braille dots (0.01 to 
0.50) 

Select Frontside Braille Dot Type 

Select Frontside Braille Dot 
Type 

Plateau Select the Braille dot type that will be scanned 
(Plateau, Bell, Dome) 

Show braille margin spacing (mm) 

Show braille margin spacing Checked/ 8.00 Toggle dotted outline around detected Braille 
regions to appear when scrolled over (5.00 to 
10.00) 

 

12.2.2 Inspect Braille Sample 

This action translates the frontside Braille on a scanned sample, yielding Braille height information. 

 

PARAMETER VALUE DESCRIPTION 
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Braille Height Criteria (mm) 

Acceptable Height 0.12 Set the target height for Braille dots (0.01 to 
0.50) 

Select Frontside Braille Dot Type 

Select Frontside Braille Dot 
Type 

Dome Select the Braille dot type that will be scanned 
(Plateau, Bell, Dome) 

Show braille margin spacing (mm) 

Show braille margin spacing Checked/ 8.00 Toggle dotted outline around detected Braille 
regions to appear when scrolled over (5.00 to 
10.00) 

 

12.2.3 Compare PDF to Scan (Backside) 

This action compares the Braille on a digital master to the backside Braille on a scanned sample. 

 

PARAMETER VALUE DESCRIPTION 

Braille Height Criteria (mm) 

Acceptable Height 0.12 Set the target height for Braille dots (0.01 to 
0.50) 

Select Frontside Braille Dot Type 

Select Frontside Braille Dot 
Type 

Plateau Select the Braille dot type that will be scanned 
(Plateau, Bell, Dome) 

Show braille margin spacing (mm) 

Show braille margin spacing Checked/ 8.00 Toggle dotted outline around detected Braille 
regions to appear when scrolled over (5.00 to 
10.00) 

 

12.2.4 Compare PDF to Scan (Frontside) 

This action compares the Braille on a digital master to the frontside Braille on a scanned sample, yielding 
Braille height information. 

 

PARAMETER VALUE DESCRIPTION 

Braille Height Criteria (mm) 

Acceptable Height 0.12 Set the target height for Braille dots (0.01 to 
0.50) 

Select Frontside Braille Dot Type 

Select Frontside Braille Dot 
Type 

Plateau Select the Braille dot type that will be scanned 
(Plateau, Bell, Dome) 
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Show braille margin spacing (mm) 

Show Braille margin spacing Checked/ 8.00 Toggle dotted outline around detected Braille 
regions to appear when scrolled over (5.00 to 
10.00) 

 

12.3 Workflows 

Workflows consist of individual groups of preset parameters that help run multiple inspections (via the 
Inspect Multiple button) more efficiently in concert with the New Job function. The Application is 
installed with the default workflows listed in the tables below, each consisting of default parameter values. 
Administrators and managers can add, rename, and delete workflows and modify individual parameter 
values. For more information, consult the Administration Guide.   

 

12.3.1 Carton (Press Sheet) 

This carton workflow can be used to compare a PDF press sheet to a scanned press sheet. 

 

PARAMETER VALUE DESCRIPTION 

Inspection Resolution 

Inspection Resolution 300 
The resolution of a master or sample file to be 
loaded 

Scanner & Image Adjustments 

Scanner Default Set the source when scanning master or sample 
files 

Grayscale Unchecked Scan files in grayscale 

Brightness 0 The brightness value of the scanned file (-100 to 
100) 

Contrast 0 The contrast value of the scanned file (-100 to 
100) 

Gamma 2.50 The gamma correction value of the scanned file 
(0.00 to 5.00) 

Advanced 

Support Rotated Repeats Unchecked Enable detection of rotated or nested sample 
images 

Actions & Profiles 

Graphics Checked Pixel-by-pixel comparison between the Master 
and Sample file(s); Action is set to One to One 
and Profile is set to Digital to Scan 

Barcodes Unchecked Inspection of files containing barcodes, which 
are detected and graded (by default, Action is 
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set to Inspect Master and Profile is set to 
Default) 

Braille Unchecked Inspection of separate master or sample files for 
Braille translation or comparison between the 
two; Digital documents and backside and 
frontside scans are supported (by default, 
Action is set to Translate Master and Profile is 
set to English) 

Text Unchecked Compare the live text in two documents of the 
same or a different file type for discrepancies 
(by default, Action is set to Compare (All Pages) 
and Profile is set to Same Layout (Revisions) 

Spell Unchecked Inspect the Master or Sample using the 
dictionary of your choice (by default, Action is 
set to Inspect Sample and Profile is set to 
English (Canadian)) 

 

12.3.2 Carton 

This carton workflow can be used to compare a 1-up PDF artwork file to a scanned 1-up or press sheet. 

 

PARAMETER VALUE DESCRIPTION 

Inspection Resolution 

Inspection Resolution 300 
The resolution of a master or sample file to be 
loaded 

Scanner & Image Adjustments 

Scanner Default Set the source when scanning master or sample 
files 

Grayscale Unchecked Scan files in grayscale 

Brightness 0 The brightness value of the scanned file (-100 to 
100) 

Contrast 0 The contrast value of the scanned file (-100 to 
100) 

Gamma 2.50 The gamma correction value of the scanned file 
(0.00 to 5.00) 

Advanced 

Support Rotated Repeats Unchecked Enable detection of rotated or nested sample 
images 

Actions & Profiles 

Graphics Checked Pixel-by-pixel comparison between the Master 
and Sample file(s); Action is set to Single Page 
and Profile is set to Digital to Scan 

Barcodes Unchecked Inspection of files containing barcodes, which 
are detected and graded (by default, Action is 
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set to Inspect Master and Profile is set to 
Default) 

Braille Unchecked Inspection of separate master or sample files for 
Braille translation or comparison between the 
two; Digital documents and backside and 
frontside scans are supported (by default, 
Action is set to Translate Master and Profile is 
set to English) 

Text Unchecked Compare the live text in two documents of the 
same or a different file type for discrepancies 
(by default, Action is set to Compare (All Pages) 
and Profile is set to Same Layout (Revisions) 

Spell Unchecked Inspect the Master or Sample using the 
dictionary of your choice (by default, Action is 
set to Inspect Sample and Profile is set to 
English (Canadian)) 

 

12.3.3 Insert 

Use the insert workflow to compare a full PDF insert to an insert press sheet. 

 

PARAMETER VALUE DESCRIPTION 

Inspection Resolution 

Inspection Resolution 300 
The resolution of a master or sample file to be 
loaded 

Scanner & Image Adjustments 

Scanner Default Set the source when scanning master or sample 
files 

Grayscale Unchecked Scan files in grayscale 

Brightness 0 The brightness value of the scanned file (-100 to 
100) 

Contrast 0 The contrast value of the scanned file (-100 to 
100) 

Gamma 2.50 The gamma correction value of the scanned file 
(0.00 to 5.00) 

Advanced 

Support Rotated Repeats Unchecked Enable detection of rotated or nested sample 
images 

Actions & Profiles 

Graphics Checked Pixel-by-pixel comparison between the Master 
and Sample file(s); Action is set to One to One 
and Profile is set to Digital to Scan 

Barcodes Unchecked Inspection of files containing barcodes, which 
are detected and graded (by default, Action is 
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set to Inspect Master and Profile is set to 
Default) 

Braille Unchecked Inspection of separate master or sample files for 
Braille translation or comparison between the 
two; Digital documents and backside and 
frontside scans are supported (by default, 
Action is set to Translate Master and Profile is 
set to English) 

Text Unchecked Compare the live text in two documents of the 
same or a different file type for discrepancies 
(by default, Action is set to Compare (All Pages) 
and Profile is set to Same Layout (Revisions) 

Spell Unchecked Inspect the Master or Sample using the 
dictionary of your choice (by default, Action is 
set to Inspect Sample and Profile is set to 
English (Canadian)) 

 

12.3.4 Label (Web) 

This label workflow can be used to compare a PDF of a label (web) to a scanned print. 

 

PARAMETER VALUE DESCRIPTION 

Inspection Resolution 

Inspection Resolution 400 
The resolution of a master or sample file to be 
loaded 

Scanner & Image Adjustments 

Scanner Default Set the source when scanning master or sample 
files 

Grayscale Unchecked Scan files in grayscale 

Brightness 0 The brightness value of the scanned file (-100 to 
100) 

Contrast 0 The contrast value of the scanned file (-100 to 
100) 

Gamma 2.50 The gamma correction value of the scanned file 
(0.00 to 5.00) 

Advanced 

Support Rotated Repeats Unchecked Enable detection of rotated or nested sample 
images 

Actions & Profiles 

Graphics Checked Pixel-by-pixel comparison between the Master 
and Sample file(s); Action is set to One to One 
and Profile is set to Digital to Scan 

Barcodes Unchecked Inspection of files containing barcodes, which 
are detected and graded (by default, Action is 
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set to Inspect Master and Profile is set to 
Default) 

Braille Unchecked Inspection of separate master or sample files for 
Braille translation or comparison between the 
two; Digital documents and backside and 
frontside scans are supported (by default, 
Action is set to Translate Master and Profile is 
set to English) 

Text Unchecked Compare the live text in two documents of the 
same or a different file type for discrepancies 
(by default, Action is set to Compare (All Pages) 
and Profile is set to Same Layout (Revisions) 

Spell Unchecked Inspect the Master or Sample using the 
dictionary of your choice (by default, Action is 
set to Inspect Sample and Profile is set to 
English (Canadian)) 

 

12.3.5 Label 

This label workflow can be used to compare a 1-up PDF artwork file to a scanned label or label (web). 

 

PARAMETER VALUE DESCRIPTION 

Inspection Resolution 

Inspection Resolution 400 
The resolution of a master or sample file to be 
loaded 

Scanner & Image Adjustments 

Scanner Default Set the source when scanning master or sample 
files 

Grayscale Unchecked Scan files in grayscale 

Brightness 0 The brightness value of the scanned file (-100 to 
100) 

Contrast 0 The contrast value of the scanned file (-100 to 
100) 

Gamma 2.50 The gamma correction value of the scanned file 
(0.00 to 5.00) 

Advanced 

Support Rotated Repeats Unchecked Enable detection of rotated or nested sample 
images 

Actions & Profiles 

Graphics Checked Pixel-by-pixel comparison between the Master 
and Sample file(s). Action is set to Single Page 
and Profile is set to Digital to Scan 

Barcodes Unchecked Inspection of files containing barcodes, which 
are detected and graded (by default, Action is 
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set to Inspect Master and Profile is set to 
Default) 

Braille Unchecked Inspection of separate master or sample files for 
Braille translation or comparison between the 
two; Digital documents and backside and 
frontside scans are supported (by default, 
Action is set to Translate Master and Profile is 
set to English) 

Text Unchecked Compare the live text in two documents of the 
same or a different file type for discrepancies 
(by default, Action is set to Compare (All Pages) 
and Profile is set to Same Layout (Revisions) 

Spell Unchecked Inspect the Master or Sample using the 
dictionary of your choice (by default, Action is 
set to Inspect Sample and Profile is set to 
English (Canadian)) 

 

12.4 Supported Braille Languages 

Braille Inspection Mode. 

 

Albanian Estonian Icelandic Russian 

Basque (Spain) 
European Braille 

Code (EBU) 
Irish (Gaelic) Serbian 

Belarusian Faroese (Demark) Italian Slovakian 

Bulgarian Finnish Kazakh Slovene 

Catalan (Spain) French (Antoine) Latvian Spanish 

Croatian French (Traditional) Lithuanian Swedish 

Czech Galician (Spain) Maltese Turkish 

Danish German Norwegian Ukrainian 

Dutch  Greek Polish 
Unified English 
Braille (UEB) 

English Greenlandic Portuguese Uzbek 

English (UK) Hungarian Romanian  

    

12.5 Supported Dictionaries (Spelling Inspection) 

Spelling Inspection Mode. 

All Spelling profiles have the following options (Checked by Default). 
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 Ignore UPPER CASE words. 
 Ignore words that contain numbers. 

 

 

Bulgarian German 
Portuguese 
(Portugal) 

Catalan Greek Romanian 

Croatian Hungarian Russian 

Czech Irish Serbian (Cyrillic) 

Danish Italian Serbian (Latin) 

Dutch Latvian Slovak 

English (Canadian) Lithuanian Slovenian 

English (UK) Maltese Spanish (Mexican) 

English (USA) Medical Dictionary Spanish (Spain) 

Estonian Norwegian (Bokmal) Swedish 

French 
Norwegian 
(Nynorsk) 

Turkish 

German (Austrian) Polish Ukrainian 

German 
(Switzerland) 

Portuguese (Brazil)  

 

12.6 Supported Barcodes 

The following tables list the 
scheme for verified parameters (when applicable). 

12.6.1 One-Dimensional (1D) Barcodes 

SYMBOLOGY DECODING GRADING 

Codabar Supported Supported 
Code 11 Supported Not Supported 
Code 32 Supported Supported 
Code 39 Supported Supported 
Code 93 Supported Supported 
Code 128 / GS1-128 Supported Supported 
Interleave 2 of 5 Supported Supported 
MSI Supported Supported 
Laetus Pharmacode * Supported Supported 
GS1 Databar 
Omnidirectional 

Supported Supported 
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GS1 Databar 
Truncated 

Supported Supported 

GS1 Databar Stacked Supported Supported 
GS1 Databar Limited  Supported Supported 
GS1 Databar 
Expanded 

Supported Supported 

GS1 Databar 
Expanded Stacked  

Supported Supported 

GS1 Databar Stacked 
Omnidirectional 

Supported Supported 

GS1 Databar 
Omnidirectional 
Composite Code A 

Supported Supported 

GS1 Databar 
Truncated Composite 
Code A 

Supported Supported 

GS1 Databar 
Expanded Composite 
Code A 

Supported Supported 

GS1 Databar Limited 
Composite Code A 

Supported Supported 

GS1 Databar Stacked 
Composite Code A 

Supported Supported 

GS1 Databar Stacked 
Omnidirectional 
Composite Code A 

Supported Supported 

GS1 Databar 
Expanded Stacked 
Composite Code A 

Supported Supported 

Telepen Supported Not Supported 
EAN 13 Supported Supported 
EAN 8 Supported Supported 
EAN 5 Supported Not Supported 
EAN 2 Supported Not Supported 
UPC-A Supported Supported 
UPC-E Supported Supported 
ITF-14 Supported Supported 
ITF-16 Supported Supported 
USPS Supported Supported 

Pharmacode barcodes, the Enable red light simulation parameter must be toggled off in the selected 
Barcode Inspection profile. 
**Magnification for supported barcodes can vary from 80% to 200% with exception to Interleave 2 of 5.  

 

12.6.2 Two-Dimensional (2D) Barcodes 

SYMBOLOGY DECODING GRADING 

DataMatrix Supported Supported 

GS1 DataMatrix Supported Supported 
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QR Supported Supported 

GS1 QR Supported Supported 

Micro QR Supported Supported 

 

12.6.3 Digital Watermark Barcode 

 

SYMBOLOGY DECODING GRADING 

Digimarc N/A N/A 

 

12.6.4 Grading Parameters 

GRADING PARAMETER RATIO GRADING TABLE 

Decodability N/A A >= 62% 

B >= 50% 

C >= 37% 

D >= 25% 

F < 25% 

Symbol Contrast Rmax-Rmin A >= 70% 

B >= 55% 

C >= 40% 

D >= 20% 

F < 20% 

Min Edge Contrast Rsmin-Rbmax A >= 15% 

F < 15% 

Modulation Ecmin/ SC A >= 70% 

B >= 60% 

C >= 50% 

D >= 40% 

F < 40% 

Defects ERNmax/ SC A <= 15% 

B <= 20% 

C <= 25% 

D <= 30% 

F > 30% 

Decode N/A A (4) or F (0) 

Min Reflectance Rmin/ Rmax A <= 0.5 X Max Reflectance 

F > 0.5 X Max Reflectance 

Quiet Zone N/A A = Clean 

F = Artifacts detected 
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Narrow Bar  Varies depending on barcode type 

Wide Bar Varies depending on barcode type 

Wide to Narrow Ratio NB: WB 1:3 <= A >= 1:2 

1:3 > F < 1:2 

 

Gap Varies depending on barcode type 

Axial Non-Uniformity abs(XAVG  YAVG) 
/((XAVG  YAVG)/2) 

A <= 6% 

B <= 8% 

C <= 10% 

D <= 12% 

F > 12% 

Grid Non-Uniformity Largest vector 
deviation /X-dimension 

A <= 38% 

B <= 50% 

C <= 63% 

D <= 75% 

F > 75% 

Fixed Pattern Damage Lowest grade of:  

 Finder pattern, 
 Quiet zone,  
 Clock pattern,  
 Solid area, or  
 Overall fixed pattern 

Overall Fixed Pattern 
(average of symbols): 

A = 4.0 

B >= 3.5 

C >= 3.0 

D >= 2.5 

F < 2.5 

Unused Error Correction 1,0  ((e+2t) /ECAP) A >= 62% 

B >= 50% 

C >=37% 

D >= 25% 

F < 25% 

12.7 Shortcut Keys 

 

 

KEY FUNCTION 

Mouse track wheel Main View:   

 Scroll up to magnify the image 
 Scroll down to reduce the magnification of the image 

NOTE: With a Mac operating system with Scroll Direction: Natural ON: 

 Scroll down to magnify the image 
 Scroll up to reduce the magnification of the image 

With a Mac operating system with Scroll Direction: Natural OFF: 

 Scroll up to magnify the image 



GlobalVision Desktop PC 5.8.1 User Guide 
Rev 015

213 of 214  12 Jun 2020 

 Scroll down to reduce the magnification of the image 

Left mouse button/ 
SPACE + mouse 

Used for panning; Hold down and move within panel to pan 

CTRL + Left drag Marquee Zoom in Master panel 

CTRL + ALT + Left drag Marquee Zoom in Sample panel 

CTRL + M Load master 

CTRL + S Load sample 

CTRL + SHIFT + M Scan master 

CTRL + SHIFT + S Scan sample 

CTRL + A Show live (inspectable) text in Master 

CTRL + B Show live (inspectable) text in Sample 

CTRL + SHIFT + C Toggle on Cross-out Text in Master 

CTRL + SHIFT + D Toggle on Cross-out Text in Sample 

CTRL + SHIFT + U Toggle on Underline Text in Master 

CTRL + SHIFT + V Toggle on Underline Text in Sample 

CTRL + SHIFT + Z Toggle on Create Zones 

CTRL + SHIFT + X Clear all in Master 

CTRL + SHIFT + Y Clear all in Sample 

SHIFT + M/ SHIFT +S 
(Barcode, Braille, 
Spelling Inspection, 
when a master is 
inspected) 

Rotate Master 90º clockwise 

SHIFT + S Rotate Sample 90º clockwise 

CTRL + ENTER Run inspection 

CTRL + SHIFT + 
ENTER 

Run multiple inspections 

F1 Reporting level - Critical 

F2 Reporting level - Major 

F3 Reporting level - Minor 

F4 Reporting level - Ignore 

F5 Reporting level - None 

F11 Include difference 

F12 Exclude difference 

SHIFT + Left drag Group differences 

ALT + Left drag Exclude differences 

SHIFT + ALT + Left 
drag 

Add differences 
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ALT + M Show/ hide Master panel (following an inspection) 

ALT + H Show/ hide difference boxes and numbers 

PAGE UP/ PAGE 
DOWN 

Navigate between repeats 

RIGHT ARROW Next page 

LEFT ARROW Previous page 

CTRL + R Launch Report Options window (to generate report) 

CTRL + P Open/ modify settings in Edit Profile window (administrators) 

SHIFT + R Reset interface 

 


